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1 General

1.1 Accessing Database Setting While in TRACE Mode

Did you know that you can access current database settings while in TRACE mode?

In the latest update of R:BASE eXtreme 9.0 (32/64), the Data Dictionary, [F3] key, now includes an
additional tab to display the current Database Settings, which is very useful when TRACing code.

Here's a comprehensive list of items/features when pressing the [F3] key:

· Databases (Name, Date/Time, Size) 
· Tables (Name, Comment) * 
· Columns (Table/View Name, Name, Comment) * 
· Key/Indexes (ID, Type, Table Name, Reference) * 
· Variables (Name, Data Type, Value) 
· Views (Name, Comment) * 
· Forms (Name, Table, Comment) * 
· Reports (Name, Table, Comment) * 
· Labels (Name, Table, Comment) * 
· Functions (Name, Category, Syntax) 
· Stored Procedures (Name, Comment) * 
· System Tables (Name) * 
· System Columns (Table/View Name, Name, Comment) * 
· Themes (Name) 
· Printers (Name) 
· External Forms (External Form Name, Date/Time, Size) 
· Applications (Application Name, Date/Time, Size) 
· Colors (Color, Name, Integer Value, RGB Value) 
· Control Types (Name, Comment) 
· Database Settings (Parameter, Value, Description) **

* Only visible when connected to database 
** If not connected to database, default R:BASE settings are shown.

Supported Versions: 
· R:BASE eXtreme 9.0 (Build: 9.0.1.10707 or higher)

1.2 Am I using Regular R:BASE or the Enterprise Edition

Having both versions of R:BASE (7.6, 7.6 EE or V-8, V-8 EE) installed, sometimes you wonder what
flavor of R:BASE (Regular or Enterprise Edition) you are using.

From the look and feel, both versions (Regular or Enterprise Edition) are exactly the same. However,
here a few ways to differentiate the regular versus the enterprise editions of R:BASE 7.6 and Turbo V-8
for Windows.

1. Using "Help" > "About R:BASE..."

From the Menu Bar, choose "Help" > "About R:BASE..."

R:BASE 7.6 for Windows 
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R:BASE 7.6 for Windows (Enterprise Edition) 
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R:BASE Turbo V-8 for Windows 
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R:BASE Turbo V-8 for Windows (Enterprise Edition) 
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2. The "Object Inspector" in the Form, Label and Report Designers

In addition to other tool bars, the Enterprise Edition of R:BASE 7.6/Turbo V-8 for Windows also includes
an additional "Object Inspector" tool bar for the Form, Label or Report Designers.

To launch the Object Inspector in each Label, Form and Report Designer (Enterprise Editions):

Form Designer 
1. From the Manu Bar, select "Layout" > "Toolbars"
2. Select Object Inspector

Label Designer 
1. From the Manu Bar, select "View" > "Toolbars"
2. Select "Object Inspector"

Report Designer 
1. From the Manu Bar, select "View" > "Toolbars"
2. Select "Object Inspector"

The detailed Object Inspector lets you view and explore each and every possible property of a selected
control on the form, label or report. The Object Inspector can be docked on the left or you may let it
float anywhere you wish.

R:BASE 7.6 (Enterprise Edition) Object Inspector 
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R:BASE Turbo V-8 (Enterprise Edition) Object Inspector 
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When the form is opened in form designer or un-selecting the control, the actual "Form Properties" are
revealed!

Supported Versions:
· R:BASE 7.6 (Build 7.6.2.31211 or higher) for Windows 
· R:BASE (C/S:I) 7.6 (Build 7.6.2.31211 or higher) for Windows 
· R:BASE Turbo (Build 7.6.2.31211 or higher) for Windows

1.3 Capturing Common Operating System Folders

Does your application require the ability to send output to a User's directory, only the network contains
several different operating systems?

Perhaps the application must add a Favorite to the Internet Explorer menu bar. Or, it is needed that a
specific Font be verified?

Access to the all operating system specific common folders like the My Documents, Windows, and
System folders are easily accessible using the latest GetCommonFolder Plugin that is part of the R:BASE
Plugin Power Pack 9.0/9.1.
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The GetCommonFolder Plugin is used to capture fifty (50) of the most common operating system folders
used frequently by applications, but which may not have the same name or location on any given
system.

Syntax:

PLUGIN GetCommonFolder vFolder|FolderType

Where:

vFolder is the variable to return the text value of a given common operating system folder.

FolderType is the name of the specific common folder type.

Examples:

--The following return the Common Programs folder

PLUGIN GetCommonFolder vValue|COMMON_PROGRAMS
SET VAR vResult = 'COMMON_PROGRAMS : ' + vValue; WRITE .vResult

COMMON_PROGRAMS : C:\ProgramData\Microsoft\Windows\Start Menu\Programs

--The following return the Windows folder

PLUGIN GetCommonFolder vValue|WINDOWS
SET VAR vResult = 'WINDOWS : ' + vValue; WRITE .vResult

WINDOWS : C:\Windows

--The following return the System folder

PLUGIN GetCommonFolder vValue|SYSTEM
SET VAR vResult = 'SYSTEM : ' + vValue; WRITE .vResult

SYSTEM : C:\Windows\system32

--The following return the Program Files folder

PLUGIN GetCommonFolder vValue|PROGRAM_FILES
SET VAR vResult = 'PROGRAM_FILES : ' + vValue; WRITE .vResult

PROGRAM_FILES : C:\Program Files (x86)

In addition to a library of R:BASE Plugins, GetCommonFolder is included with the latest version of the R:
BASE Plugin Power Pack 9.0/9.1.

R:BASE Plugin Power Pack Online Help Manual:
http://www.rbase.com/products/PluginPowerPack91

1.4 Copying Forms, Labels, and Reports

Did you know that you can copy any number of selected Forms, Labels, and Reports from one R:BASE
9.0 database to another R:BASE 9.0 database by simply copying [Ctrl+C] from the source database and
pasting [Ctrl+V] to the destination database while both databases are connected as two separate
sessions of R:BASE 9.0?

You can use the same techniques of copying and pasting between R:BASE eXtreme 9.0 (64) and R:BASE
9.0 (32) sessions as well!

http://www.rbase.com/products/PluginPowerPack91
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In addition, you may copy (unload) any number of selected Tables, Views, Stored Procedures, Forms,
Labels, Report, External Forms, and Command Files from R:BASE 9.0 Database Explorer to any folder or
even your desktop, by simply dragging and dropping the selected item(s).

Hint:
While copying and pasting, make sure that both sessions of R:BASE 9.0 are using the similar modules in
Database Explorer. For example, copying Forms from one Database Explorer to another Database
Explorer you will have to make sure that the Forms section of the destination database is opened before
pasting the forms. Thus, Forms to Forms, Labels to Labels, and Reports to Reports, and so on.

Supported Versions:
· R:BASE eXtreme 9.0 for Windows (Build: 9.0.1.10701 and higher)

1.5 Data Dictionary and Selecting Color Value

Data Dictionary [F3] Key in R:BASE eXtreme 9.1/9.5 (32/64) provides the following valuable information
at your fingertips:

·  Databases 
·  Tables * 
·  Columns * 
·  Key/Indexes * 
·  Variables 
·  Views * 
·  Forms * 
·  Reports * 
·  Labels * 
·  Functions 
·  Stored Procedures * 
·  System Tables * 
·  System Columns * 
·  Form Component IDs ** 
·  Form Actions ** 
·  Report Component IDs *** 
·  Label Component IDs **** 
·  Themes 
·  Printers 
·  External Forms 
·  Applications 
·  Colors 
·  Control Types 
·  Database Settings 
·  Files

* = Connected Database 
** = While in Form Designer 
*** = While in Report Designer 
**** = While in Label Designer

These are very slick and handy options that allow users to capture information about the R:BASE
environment and/or connected database.

These options can be accessed from anywhere in R:BASE by pressing the [F3] key or selecting "Data
Dictionary" option from the Menu Bar under "Tools".

While programming and customizing applications, if you wish to use custom font color, background color,
for CHOOSE, DIALOG, or PAUSE commands you can press the [F3] key, select the color you like and
then either double-click for single item or [OK] button for multi-select items. Using this approach, you
can capture the name of the color listed in the first column.

The Data Dictionary | Color tab includes a list of 190 colors.

Did you know that now you can choose which option you want as the return value?
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Here's how:

Press [F3] Data Dictionary Key and notice the additional option for [Return Value].

You now have four (4) options to pick from.

[ ] Color [ ] Name [ ] Integer Value [ ] RGB Value

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.4.11012 or higher)
 

1.6 Deleting R:BASE SCRATCH (.$$$) Files

There are several ways to implement custom routines to delete the leftover temporary R:BASE scratch
files as application 
startup or application close, such as:

-- Example 
-- Start 
SET VAR vFolderAndFiles TEXT = NULL 
SET VAR vFolderAndFiles = ((CVAL('SCRATCH'))+'\*.$$$') 
SET ERROR MESSAGE 2262 OFF 
SET ERROR MESSAGE 2263 OFF 
SET ERROR MESSAGE 2926 OFF 
DELETE &vFolderAndFiles 
SET ERROR MESSAGE 2926 ON 
SET ERROR MESSAGE 2263 ON 
SET ERROR MESSAGE 2262 ON 
CLEAR VARIABLE vFolderAndFiles 
RETURN 
-- End

However, did you know that you don't need to implement such routines, since the latest update of R:
BASE 7.6, C/S:I 7.6 
and Turbo V-8 for Windows does it all for you?

Supported Versions:
· R:BASE 7.6 (Build 7.6.3.30321 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.3.30321 or higher) for Windows 
· R:BASE Turbo (Build 8.0.17.30321 or higher) for Windows

1.7 Deploying an R:BASE eXtreme 9.x (64) Database

When you are ready to deploy your first R:BASE eXtreme 9.x (64) database and application, you may
want to reset the version and time stamp of all your forms, labels, reports, and stored procedures to
clean start the first deployed version of your application.

Use the following code:
-- TimeStamp_Forms_Labels_Reports_StoredProcedures.RMD 
-- A. Razzak Memon 
-- May 14, 2010 

UPDATE SYS_FORMS3 SET SYS_FORM_VERSION = 1, SYS_FORM_MOD_TS = .#NOW 
UPDATE SYS_LABELS3 SET SYS_LABEL_VERSION = 1, SYS_LABEL_MOD_TS = .#NOW 
UPDATE SYS_REPORTS3 SET SYS_REPORT_VERSION = 1, SYS_REPORT_MOD_TS = .#NOW 
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UPDATE SYS_PROCEDURES SET SYS_PROC_VERSION = 1, SYS_PROC_MOD_TS = .#NOW 
RETURN

Supported Versions: 
· R:BASE eXtreme 9.0 (Build: 9.0.1.10511 or higher )

1.8 Documenting Component IDs in Forms/Labels/Reports

Did you know that you can document all embedded Custom EEPs in Forms, Labels and Reports using the
"Document Custom EEPs" option while in Form, Label or Report Designer?

Form Designer > main Menu Bar > Form > Document Custom EEPs
Label Designer > main Menu Bar > Label  > Document Custom EEPs
Report Designer > main Menu Bar > Report > Document Custom EEPs

Notice the following output options:

· Printer 
· Text File 
· PDF File 
· Clipboard

The complete documentation of embedded Custom EEPs will also include the Component IDs, if defined.

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.3.30509 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.3.30509 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.17.30509 or higher)

1.9 Dynamically Changing Themes in R:BASE Application (.RBA)

Current versions of R:BASE for Windows allow you to design and distribute the stand alone R:BASE
Application (.RBA) files using the "Applications" module of R:BASE Database Explorer.

While in the Application designer, you may elect to use an Application Theme by checking the [ ] Use
Theme option and then selecting your favorite theme from among the list of supported themes. Did you
know that now you can dynamically change the R:BASE Application (.RBA) theme using the following
PROPERTY command?

Example 01: 

-- Start 
-- Application: On After Start Action 

CLEAR VARIABLE vThemeName 
SET VAR vThemeName TEXT = NULL 
IF (CVAL('NetUser')) <> 'Razzak' THEN 
PROPERTY RBA_FORM THEMENAME 'Sports Blue' 
PROPERTY RBA_FORM CAPTION 'Using Sports Blue' 
ELSE 
PROPERTY RBA_FORM THEMENAME 'R:BASE Rocks!' 
PROPERTY RBA_FORM CAPTION 'Using R:BASE Rocks!' 
ENDIF 
RETURN 

-- End

Example 02: 
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-- Start 
-- Application: On After Start Action 

IF (CVAL('DATABASE')) <> 'RRBYW16' OR (CVAL('DATABASE')) IS NULL THEN 
CONNECT RRBYW16 IDENTIFIED BY NONE 
ENDIF 
CLEAR VARIABLE vUserThemeName,vThemeCaption,vDefaultTheme 
SET VAR vUserThemeName TEXT = NULL 
SET VAR vThemeCaption TEXT = NULL 
SET VAR vDefaultTheme TEXT = 'Convergence' 
SELECT UserThemeName, ThemeCaption INTO + 
vUserThemeName INDIC ivUserThemeName, + 
vThemeCaption INDIC ivThemeCaption + 
FROM UserThemes WHERE UserName = (CVAL('NetUser')) 
IF vUserThemeName IS NULL THEN 
SET VAR vUserThemeName = .vDefaultTheme 
SET VAR vThemeCaption = .vDefaultTheme 
ENDIF 
PROPERTY RBA_FORM THEMENAME .vUserThemeName 
PROPERTY RBA_FORM CAPTION .vUserThemeName 
RETURN 
-- End

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.5.31229 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.5.31229 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.19.31229 or higher) 
· R:BASE eXtreme (v9) for Windows (Build: 9.0.1.11229 or higher)

1.10 Dynamically Defining Unique File Names

Here are two examples to create a unique file name in a multi-user and multi-session environments
using R:BASE eXtreme 9.1 (32/64) and R:BASE eXtreme 9.5 (64).

-- Example 01 
-- Using R:BASE eXtreme 9.1 (32/64) 
IF (CVAL('DATABASE')) <> 'RRBYW17' OR (CVAL('DATABASE')) IS NULL THEN 
CONNECT RRBYW17 IDENTIFIED BY NONE 
ENDIF 
-- Verify the existence of PDF Sub-Directory 
SET VAR vChkFile INTEGER = NULL 
SET VAR vChkFile = (CHKFILE('PDF')) 
IF vChkFile <> 1 THEN 
MD PDF 
ENDIF 
CLS 
-- Get Globally Unique ID 
SET VAR vGUID TEXT = NULL 
PLUGIN RGUID vGUID|SYMBOLS OFF 
-- Create Unique PDF File Name 
SET VAR vPDFFileName TEXT = NULL 
SET VAR vPDFFileName = + 
('PDF\'+(CVAL('NetUser'))+'_'+.vGUID+'_CustomerList_'+ + 
(FORMAT(.#DATE,'MMDDYYYY'))+'.pdf') 
PRINT CustomerList + 
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OPTION PDF + 
|FILENAME .vPDFFileName + 
|SHOW_CANCEL_DIALOG ON + 
|TITLE Customer List + 
|SUBJECT Customer List + 
|AUTHOR R:BASE eXtreme 9.1 (64) + 
|KEYWORDS Customer List + 
|OPEN ON 
CLEAR VARIABLES vChkFile,vGUID,vPDFFileName,RBTI_% 
RETURN

-- Example 02 
-- Using R:BASE eXtreme 9.5 (64) 
IF (CVAL('DATABASE')) <> 'RRBYW18' OR (CVAL('DATABASE')) IS NULL THEN 
CONNECT RRBYW18 IDENTIFIED BY NONE 
ENDIF 
-- Verify the existence of PDF Sub-Directory 
SET VAR vChkFile INTEGER = NULL 
SET VAR vChkFile = (CHKFILE('PDF')) 
IF vChkFile <> 1 THEN 
MD PDF 
ENDIF 
CLS 
-- Create Unique PDF File Name 
SET VAR vPDFFileName TEXT = NULL 
SET VAR vPDFFileName = + 
('PDF\'+(CVAL('NetUser'))+'_'+(CVAL('GUID'))+'_CustomerList_'+ + 
(FORMAT(.#DATE,'MMDDYYYY'))+'.pdf') 
PRINT CustomerList + 
OPTION PDF + 
|FILENAME .vPDFFileName + 
|SHOW_CANCEL_DIALOG ON + 
|TITLE Customer List + 
|SUBJECT Customer List + 
|AUTHOR R:BASE eXtreme 9.1 (64) + 
|KEYWORDS Customer List + 
|OPEN ON 
CLEAR VARIABLES vChkFile,vPDFFileName,RBTI_% 
RETURN

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.4.11012 or higher)

1.11 Enabling Object Inspector in R:BASE eXtreme

Did you know that R:BASE eXtreme 9.0 includes the built-in Object Inspector for Form, Label and Report
Designers?

While in Form, Label or Report Designer, you can enable the Object Inspector to explore in-depth
properties of Form, Label, Report, and any selected object.

Here's how to enable the Object Inspectors in R:BASE eXtreme 9.0:

Form Designer > Menu Bar > View > Toolbars > Object Inspector
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Report Designer > Menu Bar > View > Toolbars > Object Inspector

Label Designer > Menu Bar > View > Toolbars > Object Inspector

Once enabled, you may dock the Object Inspector on the left, or float anywhere you find more
convenient!

Supported Versions:
· R:BASE eXtreme 9.0 (Build: 9.0.1.10701 and higher)

1.12 Enabling the Object Inspector in the Enterprise Edition

After installing the latest updates of R:BASE 7.6 or Turbo V-8 (Enterprise Editions), make sure to create
a desktop shortcut with the following properties:

Target: C:\RBTI\RBG76\RBG76EE.EXE 
or 
Target: C:\RBTI\RBG8\RBG8EE.EXE

Then, follow the steps below to enable the Object Inspector for the Form, Label and Report Designers.

1. Start the RBG76EE.EXE or RBG8EE.EXE versions of R:BASE
2. From the main Menu Bar, choose "Help" > "About R:BASE..."
3. Verify that you are using the Enterprise Edition (the words"Enterprise Edition" will be displayed).
4. Click on the "OK" button to close the "About R:BASE" window.
5. Connect to a database
6. Open any form in the Form Designer.
7. Within the Form Designer, select "Layout" > "Toolbars" from the main Menu Bar.
8. Notice the additional Toolbar option of "Object Inspector"
9. Click on the Object Inspector

There should now be a floating Object Inspector toolbar.

10. Adjust the width and height as you wish
11. Double-Click on the Object Inspector caption area to dock the the Object Inspector on left side of

the form designer area.
12. Close the Form Designer.

Now, let's try the Label Designer.

13. Open any label in the Label Designer.
14. Within the Label Designer, select "View" > "Toolbars" from the main Menu Bar.
15. Notice the additional Toolbar option of "Object Inspector".
16. Click on the Object Inspector.

There should now be a floating Object Inspector toolbar.

17. Adjust the width and height as you wish.
18. Double-Click on the Object Inspector caption area to dock the the Object Inspector on left side of

the label designer area.
19. Close the Label Designer.

Now, let's try the Report Designer.

20. Open any report in the Report Designer.
21. Within the Report Designer, select "View" > "Toolbars" from the main Menu Bar.
22. Notice the additional Toolbar option of "Object Inspector".
23. Click on the Object Inspector.

There should now be a floating Object Inspector toolbar.

24. Adjust the width and height as you wish.
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25. Double-Click on the Object Inspector caption area to dock the the Object Inspector on left side of
the label designer area.

26. Close the Report Designer.

Supported Versions:
· R:BASE 7.6 (EE) Build: 7.6.3.30509 or higher 
· R:BASE Turbo V-8 (EE) Build: 7.6.3.30509 or higher 

1.13 Enhanced [F3] Function Key in R:BASE eXtreme 9.1

When using R:BASE eXtreme 9.1, you may use [F3] Function Key to explore the following options:

01. Databases (List of Databases including Name, Date/Time, Size)
02. Tables  (Name, Comment)
03. Columns (Name, Comment)
04. Key/Indexes (ID, Type, Table Name, References)
05. Variables (Name Data Type, Value)
06. Views (Name, Comment)
07. Forms (Name, Table Name, Comment)
08. Reports (Name, Table Name, Comment)
09. Labels (Name, Table Name, Comment)
10. Functions (Name, Category, Syntax)
11. Stored Procedures (Name, Comment)
12. System Tables (Name)
13. System Columns (Name, Comment)
14. Themes (Name)
15. Printers (Name)
16. External Forms (Name, Date/Time, Size)
17. Applications (Name, Date/Time, Size)
18. Colors (Color, Name, Integer Value, RGB Value)
19. Control Types (Name, Comment)
20. Database Settings (Parameter, Value, Description)
21. Files (File Name, Extension, Date/Time, Size), with File Mask

Additionally, while in Form Designer, notice the following additional tabs:

22. Form Component IDs
23. Form Actions

While in Report Designer, notice the following additional tabs:

24. Report Component IDs

While in Label Designer, notice the following additional tabs:

25. Label Component IDs

While in External Form Designer, notice the following additional tabs:

26. External Form Component IDs
27. External Form Actions

After selecting the appropriate tab, you may use double-click to copy and paste the selected item while
in R:BASE/EEP Editor, or [Ctrl+A] to select all items and then click on [OK] button to copy and paste all
items in R:BASE/EEP Editor.

To jump from one tab to another, click on appropriate tab, or use the new Drop-Down [List] button (far
right) and select appropriate tab.
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Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.4.10602  or higher)

1.14 Finding the Exact Name of a Form Control Type

When creating the Dynamic Objects for Forms, using the new CREATEOBJECT command, you have to
know the exact name for the 
Control Type to be created dynamically at runtime.

Syntax:

CREATEOBJECT + 
<ObjectType> <ComponentID> <ParentControl> <Left Top Width Height>

If you are using the "Enterprise Edition" of R:BASE 7.6 for Windows or Turbo V-8 for Windows while in
the Form Designer, *every* property of the selected object including the "Name" and "Object Type" is
listed under the Object Inspector. However, the required Object Type name could be hard to find without
using the Enterprise Edition.

Did you know that you can use the new [Control Types] tab of the Data Dictionary [F3] to highlight and
paste the exact name for the desired Object Type?

In addition to specific tabs that become visible within which module the [F3] key was pressed, you will
always find the [Control Types] tab from any module of R:BASE.

Data Dictionary [F3] General Tabs:

· System Tables 
· System Columns 
· Themes 
· Control Types 
· Tables 
· Columns 
· Variables 
· Views 
· Forms 
· Reports 
· Labels 
· Functions 
· Stored Procedures

Data Dictionary [F3] Form Designer Specific Tabs:

· All General tabs listed above, plus ... 
· Form Component IDs 
· Form Actions

Data Dictionary [F3] Label Designer Specific Tabs:

· All General tabs listed above, plus ... 
· Label Component IDs

Data Dictionary [F3] Report Designer Specific Tabs:

· All General tabs listed above, plus ... 
· Report Component IDs

Supported Versions:
R:BASE 7.6 for Windows (Build 7.6.2.31026 or higher) 
R:BASE 7.6 (C/S:I) for Windows (Build 7.6.2.31026 or higher) 
R:BASE Turbo V-8 for Windows (Build 8.0.16.1026 or higher)
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1.15 Handling Milliseconds in Parameterized Update Statements

When converting MS SQL or Oracle databases to R:BASE Turbo V-8 or R:BASE eXtreme (version 9.0), or
using parameterized update statements, it takes the hours, minutes, and seconds, but drops off the
milliseconds.

By default, the milliseconds are not set in the configuration file of R:BASE and OTERRO. However, if you
wish to deal with milliseconds, you will need to add that option in R:BASE and OTERRO configuration files
accordingly.

Here's how:

In Oterro configuration file (Oterro35.cfg, Oterro40.cfg, or Oterro8.cfg), change the TIME FORMAT (line
48) to HH:MM:SS.SSS and TIME SEQUENCE (line 49) to HHMMSSSSS. Additional ".SSS" are used to
handle milliseconds.

Example:

TIME FORMAT HH:MM:SS.SSS 
TIME SEQUENCE HHMMSSSSS

Based on the R:BASE version, follow the same routine for appropriate R:BASE configuration file(s).

In addition, make sure that the connected R:BASE database settings are also configured accordingly.

1.16 How Healthy is your Database?

Have you ever wondered how healthy your database really is?

Are all defined indexes properly indexed? Are there any duplicate indexes? Are all Primary/Foreign/
Referenced keys valid? Are all defined default column values still valid? Are all defined views still
functional? Is there any inconsistency in performance?

These issues become important concerns when upgrading/migrating from an old (LEGACY) DOS or
Windows version of R:BASE. Technically, there is very little to worry about when your database is
designed and managed using the latest Data Designers (RBDefine), Enhanced CREATE and LOAD
commands of R:BASE that fully enforce all rules and validate everything before the table is created/
saved or the data is loaded. Granted, all things must be considered.

However, if you have upgraded your legacy database and everything seems to be working fine, do
yourself and your lovely clients a big favor! Perform one additional task to validate the integrity of your
database.

Follow the steps below and see if everything is "peachy".

1. Make a backup copy of the database.
2. Copy the entire database (.RB1-.RB4/.RX1-.RX4 files) on your local drive in a separate folder with

at least twice as much available free disk space.
3. Start R:BASE using the latest version/update and switch the current folder to the appropriate

database folder on your local drive.
4. At the R> prompt:

DISCONNECT 
SET MESSAGES ON 
SET ERROR MESSAGES ON 
SET MULTI OFF

-- CONNECT the database with OWNER password, if any 
CONNECT dbname IDENTIFIED BY owner password 

-- CONNECT the database with no passwords 
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CONNECT dbname

5. Check the connected database CHARacter settings, especially the IDQUOTES. At the R> prompt:

CLS 
SHOW CHAR

Notice the setting for IDQUOTES (the last item on list). If this setting is blank/null, make sure to set
the IDQUOTES settings to ` (that is a single reversed quote, on the same key as the ~ tilde). 

SET IDQUOTES=`

6. Now create the unload file with NULL set to -0-. At the R> prompt:

CLS 
SET NULL -0- 
OUTPUT newdb.ALL 
UNLOAD ALL 
OUTPUT SCREEN

This step will create two files (newdb.ALL and newdb.LOB)

7. DISCONNECT, and then rename this database to some other name. At the R> prompt:

DISCONNECT 
RENAME dbname.RB? dbnameBK.RB?

8. Now, let's rebuild the fresh database and see if it passes the integrity check. At the R> prompt:

CLS 
RUN newdb.ALL

Watch the activity and all messages on the screen. Don't fall asleep! You might miss an important
warning. Completion time may vary based on size of the database (number of tables/records/
indexes).

If there were no warnings or error messages, you've got a fresh/healthy database. Give yourself a pat
on the back. 

If there are any warning or -ERROR- message(s), take them seriously. In this case, DISCONNECT the
bad database (built using RUN newdb.ALL). At the R> prompt:

DISCONNECT

Delete the bad database. At the R> prompt:

DELETE dbname.rb? 
DELETE newdb.ALL 
DELETE newdb.LOB

-- Rename the previously saved database (Step 07.)
RENAME dbnameBK.RB? dbname.RB?

-- CONNECT to the database
CONNECT dbname

9. CORRECT all -ERROR-s accordingly and then repeat Step 06.

10. Do not quit or give up until you see a completely fresh database without any warnings or errors. 

Believe me, the time spent on this exercise will save you a lot of hassle and embarrassment, instead of
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chasing something obvious that should have been taken care of a long time ago. Hope that helps!

Additional housekeeping and database maintenance tips are also available on From The Edge: 
http://www.razzak.com/fte/

1.17 Is the Application Compiled or Not?

When designing and distributing R:Compiler applications, your main menu options may include a line
item to access Database Explorer or the R> Prompt (as demonstrated in RRBYW15).

Accessing that particular option would be fine if the end user is using the full version of R:BASE.
However, that option would go nowhere if the end user is using the compiled version of the custom
application.

Did you know that you can assign a unique Component ID to a particular item or button on your
application main menu and then use the following GETPROPERTY and PROPERTY command to manage
access to that option?

-- Start 
-- On After Start EEP 
-- Know if the running application is compiled or not?

CLEAR VARIABLE vCompiled 
SET VAR vCompiled TEXT = NULL 
GETPROPERTY APPLICATION ISCOMPILED vCompiled 
IF vCompiled = 'YES' THEN 
PROPERTY AccessDatabaseExplorer VISIBLE 'FALSE' 
ENDIF 
CLEAR VARIABLE vCompiled 
RETURN 
-- End

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.5.31229 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.5.31229 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.19.31229 or higher) 
· R:BASE eXtreme (v9) for Windows (Build: 9.0.1.11229 or higher)

1.18 Is the Application Runtime or Not?

When designing and distributing Runtime applications, your main menu options may include a line item to
access Database Explorer or the R> Prompt (as demonstrated in RRBYW15). 

Accessing that particular option would be fine if the end user is using the full version of R:BASE.
However, that option would go nowhere if the end user is using the Runtime version of the application.

Did you know that you can assign a unique Component ID to a particular item or button on your
application main menu and then use the following GETPROPERTY and PROPERTY command to manage
access to that option?

-- Start 
-- On After Start EEP 
-- Know if the running application is runtime or not?

CLEAR VARIABLE vRuntime 
SET VAR vRuntime TEXT = NULL 
GETPROPERTY APPLICATION ISRUNTIME vRuntime 
IF vRuntime = 'YES' THEN 
PROPERTY AccessDatabaseExplorer VISIBLE 'FALSE' 
ENDIF 
CLEAR VARIABLE vRuntime 

http://www.razzak.com/fte/


"Tip of the Day" Digest21

Copyright © 1982-2012 R:BASE Technologies, Inc.

RETURN 
-- End

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.5.31229 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.5.31229 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.19.31229 or higher) 
· R:BASE eXtreme (v9) for Windows (Build: 9.0.1.11229 or higher)

1.19 One-Key Preview for Form, Label or Report Designers

For those who love to use hot keys instead of clicking on the [Preview] button or [Ctrl + F9] combination
within the Form, Label, or Report Designers, you can now use the single [F5] key to preview a form,
label or report.

Supported Versions:
· R:BASE 7.6 for Windows (Build 7.6.2.31130 or higher ...) 
· R:BASE 7.6 (C/S:I) for Windows (Build 7.6.2.31130 or higher) 
· R:BASE Turbo V-8 for Windows (Build 8.0.16.1130 or higher)

1.20 Managing Custom Colors

While in Form, Label or Report Designer, defining a background color, when the ordinary color palate
does not give the color you need, you always have the choice to opt for "Custom ..." colors. Selecting
this option provides you with a selection of 48 Basic Colors as well as the option to define or select from
16 "Custom Colors". Once custom colors are defined and added to the list, only the logged in user on
that workstation can access those Custom Colors while in Form, Label or Report Designer.

In an environment of R:BASE Developers and/or Team of R:BASE Contractors and Sub-Contractors,
each developer must define those custom colors manually for R:BASE for Windows, in order to follow the
application standards. In addition, if you define all those custom colors and for some reason you need to
replace a hard drive or re-install R:BASE, you also have to re-define those custom colors when designing
Forms, Labels or Reports.

Did you know that you can export your custom defined colors to a text file and then import them back
into R:BASE when you need them again, or distribute to your own developers or contractors for
consistency purposes?

Here' how:

1. Start R:BASE for Windows
2. Open any Form, Label or Report in designer
3. Select any control and use the Object Property to change background color
4. Select the "Custom ..." from the bottom of the list
5. Define your custom color or Add to existing Custom Colors
6. Click on [OK] button to save Custom Colors
7. Now if you wish to export all defined Custom Colors:

Database Explorer | Settings | Custom Colors
Notice the following options:
Save to file ...
Load from File ...

8. You may also import from a file that was created in Step 7

You can also import your 16 custom colors defined in R:BASE 7.6 or Turbo V-8 for Windows into R:BASE
eXtreme 9.0 without re-defining them again in R:BASE eXtreme 9.0 32 or 64? 

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.4.30623 or higher) 
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· R:BASE C/S:I 7.6 for Windows (Build: 7.6.4.30623 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.18.30623 or higher)
· R:BASE eXtreme 9.0 (Build: 9.0.1.10701 and higher)

1.21 Managing External Themes - R:BASE Themes Unleashed!

Did you know that you can use your own custom-designed or ".msstyles" compatible themes with R:
BASE eXtreme 9.0? 

R:BASE eXtreme 9.0 (32/64) now includes support for external themes. External theme files must have
the ".msstyles" file extension. These themes can be acquired from any online resource or from a custom
theme you created yourself. After a theme is loaded into the R:BASE session, the theme name will be
listed in every available location where themes are specified and will also appear in the Data Dictionary
list.

When using external themes, the theme file must be loaded into R:BASE each time the session is
launched. So, it can be loaded within the environment set up in a startup file.

In order to load a theme into R:BASE, the PROPERTY command must be used. The following PROPERTY
command parameters are to manage external themes in R:BASE eXtreme 9.0:

--Load Theme Example: 

PROPERTY LOAD_THEME 'NewLuna' LunaBlue.msstyles
After this command is issued, the theme "NewLuna" will be available in all locations where a theme
can be specified.

--Release Theme Example: 

PROPERTY RELEASE_THEME NewLuna TRUE
After this command is issued, the theme "NewLuna" will be released.

--Change Theme Example: 

PROPERTY CHANGE_THEME NewLuna LunaXP.msstyles
After this command is issued, the theme NewLuna will use the styles defined in the LunaXP.msstyles
file. This command parameter is provided to alter the theme file, and to avoid changing the specified
"theme name" in every location within the code.

Have fun integrating your own themes in R:BASE eXtreme 9.0!

Supported Versions: 
· R:BASE eXtreme 9.0 (Build: 9.0.1.11126 or higher) 

1.22 Managing Multipage Images

Did you know that you can use the built-in Note/BLOB Field Viewer/Editor to manage multipage VARBIT
images, such as DCX, TIFF and GIF files?

The enhanced Note/BLOB Field Viewer/Editor now includes an additional option to manage Multipage
Images. When Editing or Browsing the data using Data Browser/Editor, or a DB Grid in forms, the
dynamic Note/BLOB Field Viewer/Editor is used if you double click on the NOTE, VARCHAR or VARBIT
columns.

When using the form as BROWSE USING formname, EDIT USING formname, or ENTER USING
formname, the Note/BLOB Field Viewer/Editor is used when double clicking on DB Memo controls for
NOTE data types, the DB Rich Edit controls for VARCHAR data types (RTF data), or DB Image controls
for VARBIT data types (images).

Depending on the form control used, tab appropriate window tab of the Note/BLOB Field Viewer/Editor is
opened to manage the data accordingly. If you wish to manage Multipage images, such as DCX, TIFF or
GIFs, you may select the "Multipage Images" tab of the Note/BLOB Field Viewer/Editor.

You may also use the enhanced RBBEDIT (RBBE) command to manage external files.
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-- Example 01 (To Manage External Plain Text Data)
RBBE filename.txt

-- Example 02 (To Manage External RTF Data)
RBBE filename.rtf

-- Example 03 (To Manage Bitmap Files)
RBBE filename.bmp

-- Example 04 (To Manage Multipage TIFFs)
RBBE filename.TIF

-- Example 05 (To Manage Multipage DCX Files)
RBBE filename.cdx

-- Example 06 (To Manage Multipage GIFs)
RBBE filename.gif

Supported Versions: 
· R:BASE 7.6 (Build 7.6.2.31211 or higher) for Windows 
· R:BASE (C/S:I) 7.6 (Build 7.6.2.31211 or higher) for Windows 
· R:BASE Turbo (Build 7.6.2.31211 or higher) for Windows

1.23 R:BASE eXtreme 9.0 32 or 64?

Designing and deploying version specific applications that include naming conventions for short (18
character) vs. long (128 character) table, view, column, index, SP, form, label, report, and variable
names can be tricky at times to differentiate the deployed versions of R:BASE eXtreme 9.0 (32/64).

This is not relevant nor an issue if you are still using the 18 characters naming conventions even in R:
BASE eXtreme 9.0 (64). I certainly don't use 18 character naming convention in my vertical market as
well as recently deployed government applications running as LAN, WAN, Terminal Server, Web, and
Custom Client/Server (R:CCS) versions of R:BASE eXtreme 9.0 (64).

So, if you decide to step-up your programming techniques and take advantage of 128 Characters
naming convention in R:BASE eXtreme 9.0 (64), while maintaining the similar code for your R:BASE 9.0
(32) applications, you may need a method to differentiate the currently running version of R:BASE so
that you can use the appropriate form names, etc.

Here is a dynamic CVAL function trick that you can use to find the currently running or compiled version
of your R:BASE eXtreme 9.0 (32/64).

-- Example 01: 

IF (SGET(CVAL('VERSION'),2,21)) = '64' THEN 
SET NAMEWIDTH 40 
-- additional R:BASE eXtreme 9.0 (64) specific code here ... 
EDIT USING MyNewMainMenuForPublicUsers 
ELSE 
-- additional R:BASE eXtreme 9.0 (32) specific code here ... 
EDIT USING MainMenuPublicUsrs 
ENDIF
-- Example 02: 
IF (SGET(CVAL('VERSION'),2,21)) = '32' THEN 
-- additional R:BASE eXtreme 9.0 (32) specific code here ... 
EDIT USING MainMenuPublicUsrs 
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ELSE 
SET NAMEWIDTH 40 
-- additional R:BASE eXtreme 9.0 (64) specific code here ... 
EDIT USING MyNewMainMenuForPublicUsers 
ENDIF

This should give you an idea of how to implement such techniques in your own applications.

Supported Versions: 
· R:BASE eXtreme 9.0 (Build: 9.0.1.10511 or higher )

1.24 Tracking Date/Time and Version Information

Did you know that you can track the Date/Time and Version information of Stored Procedures, Forms,
Reports, and  Labels in R:BASE eXtreme 9.0 (64) using the Database Explorer?

In addition to SYS_PROC_VERSION (INTEGER) & SYS_PROC_MOD_TS (DATETIME) for
SYS_PROCEDURES, R:BASE eXtreme 9.0 (64) now includes the following additional columns for
SYS_FORMS3, SYS_LABELS3, and SYS_REPORTS3 to keep track of date/time as well as the revision
number of modified Forms, Labels, and Reports.

Additional SYS_ Columns:

· SYS_FORMS3 (SYS_FORM_MOD_TS, SYS_FORM_VERSION) 
· SYS_LABELS3 (SYS_LABEL_MOD_TS, SYS_LABEL_VERSION) 
· SYS_REPORTS3 (SYS_REPORT_MOD_TS, SYS_REPORT_VERSION)

These columns are updated when saving the form, label or report while in form, label or report designers
accordingly, which are displayed at the Database Explorer. 
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Hint:
While in Form Designer, when running or previewing the form, the form is automatically saved, thus
stamps the date/time as well as increases the version count. If you wish to change this behavior and
only stamp the date/time and increase the version count when you click on the [Save] button in Form
Designer, you may change the Form Designer settings as follows:

Database Explorer | Main Menu | Settings | Form Designer ...
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Supported Versions:
· R:BASE eXtreme 9.0 (64) for Windows (Build: 9.0.1.10701 and higher)

1.25 Update Command History

Did you know that you can update the R> Prompt Command History tool bar when running a form,
printing a report, browsing a table, or when building a clause within the WHERE Builder?

Within any of the above areas, the syntax is executed through a GUI, when using the full version of R:
BASE eXtreme 9.1 (32/64). An added option is now available to update the R> Prompt Command
History, allowing end-users or developers to easily reference the command syntax.

A "Update Command History" check box is visible within the following:
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A green diskette button is visible within the Where Builder: 
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Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.5.11212  or higher)

1.26 Upgrading from R:BASE 7.6/Turbo V-8 for Windows to R:BASE
eXtreme 9.x (64)

If you wish to upgrade from R:BASE 7.6/Turbo V-8 for Windows to R:BASE eXtreme 9.0 (64), use the
following simple steps:

01. Start R:BASE 7.6/Turbo V-8 for Windows
02. At the R> Prompt:

DISCONNECT 
CONNECT dbname 
SET NULL -0- 
OUTPUT dbname.all 
UNLOAD ALL 
OUTPUT SCREEN 
EXIT
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03. Start R:BASE eXtreme 9.0 (64) and switch to the folder with previous database and dbname.all and
dbname.lob files.

04. At the R> Prompt:

SET FEEDBACK ON 
RUN dbname.all

Watch your database being built in R:BASE eXtreme 9.0 (64).

05. Your new RBASE eXtreme 9.0 (64) database will include the following four files.

· dbname.RX1 
· dbname.RX2 
· dbname.RX3 
· dbname.RX4

All your working R:BASE 7.6/Turbo V-8 for Windows applications, command files, and routines should
work accordingly.

After upgrading to R:BASE eXtreme 9.0 (64), you can take advantage of all bug fixes, enhancements,
and most importantly the built-in tools and features, not to mention the completely re-designed interface,
development environment and the enhanced R:BASE Engine!

1.27 Using Expanded Color Template

The Data Dictionary [F3] Key in R:BASE eXtreme 9.1/9.5 (32/64) provides the option to choose a color
from the list of expanded colors.

While programming and customizing applications, if you wish to use custom font color, background color,
for CHOOSE, DIALOG, or PAUSE commands you can press the [F3] key to open the Data Dictionary,
select the color and then either double-click for single item or [OK] button for multi-select items. 

Did you know that now you can select all 188 colors from the "Font" Control Panel while in Form, Label,
or Report Designer?
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Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.5.11111  or higher)

1.28 Using Extended Colors

Did you know that you can use the extended colors defined in R:BASE eXtreme 9.0 that can be accessed
while in Form, Label or Report Designers?

You can also use enhanced Data Dictionary [F3] key to access the complete list of colors along with
Displayed Color, Name, Integer and RGB value.
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Supported Versions:
· R:BASE eXtreme 9.0 for Windows (Build: 9.0.1.10701 and higher)

1.29 Using Custom Themes in R:BASE eXtreme

Did you know that you can integrate your own custom theme in R:BASE eXtreme 9.0?

There are 86 (35 old + 51 new) pre-defined themes available in R:BASE eXtreme 9.0. These themes can
be applied to Internal Forms, External Forms (.rff), Applications (.rba), the Print Preview window,
CHOOSE, DIALOG, PAUSE, PLUGIN (RCalculator), and PRNSETUP dialog windows.

Here is a list of documented themes in R:BASE eXtreme 9.0:

01. Aqua 
02. BeOS 
03. Blade 
04. Blue Monkey 
05. Bugatti 
06. Catalyst 
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07. Celestial 
08. Chrome 
09. Clear Orange 
10. Convergence 
11. Crystal Blue 
12. Dazzle 
13. Elegance 
14. Eternal 
15. Forest Green 
16. Destiny 
17. Gallardo 
18. Homestead 
19. iTunes 
20. KDE 
21. Legends 
22. Luna 
23. Luxor 
24. Metallic 
25. Mind Wood 
26. Mint 
27. Navy 
28. Office 2007 
29. Panther 
30. Plex 
31. Prof Skin 
32. QNX 
33. Radiance 
34. Royale 
35. Sentinel Blue 
36. Sentinel Green 
37. Sentinel Red 
38. Sentinel Purple 
39. Sentinel Silver 
40. Seven 
41. Sniper 
42. Soft Blue 
43. Swing 
44. Venom 
45. Vienna 
46. Vista CG 
47. Vista New 
48. Water Color 
49. Windows Media Player 11 
50. Wood 
51. Yrgen Style

If that is not enough, now you can integrate your own custom theme in R:BASE eXtreme 9.0!

Here's how:

01. Create a separate folder, such as "Styles" under the same folder with your database and application
(s).
02. Copy your own custom designed theme (themename.msstyles) file in "Styles" folder.
03. Use the following PROPERTY command to load your custom designed theme in your application
startup or RBASE.DAT file.

-- Load Theme 

PROPERTY LOAD_THEME 'themename' 'Styles\themename.msstyles' 
-- your additional code here 
RETURN

04. Use the following PROPERTY command to release your custom designed theme from memory, such
as application EXIT routine.

-- Release Theme 
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PROPERTY RELEASE_THEME 'themename' 'TRUE' 
RETURN

05. Use the following PROPERTY command to change custom theme.

-- Change Theme 

PROPERTY CHANGE_THEME 'themename' 'filepathandname' 
RETURN

Example:

PROPERTY CHANGE_THEME NewLuna 'Styles\LunaXP.msstyles' 
RETURN

After this command is issued, the theme NewLuna will use the styles defined in the LunaXP.msstyles
file. This command parameter is provided to alter the theme file, and to avoid changing the specified
"theme name" is every location within the code.

06. In a compiled application, you may embed your custom themes as built-in resource without including
external files.

From the R:Compiler 9.0 interface, choose the "Additional Resources" option, select the "Themes"
tab, and select the "Add Themes ..." or "Load Theme(s) from Library..." buttons.

Notes: 

· All previously defined Forms which are redefined to use Themes should be thoroughly checked prior to
putting into production, as objects and text may look substantially different.

· To review all Themes in a live form, run the "Dynamic R:BASE eXtreme 9.0 Theme Selector" form,
RBG90_ThemeSelctr, within the RRBYW16 sample database (bundled with full installation) of R:BASE
eXtreme 9.0 (32) and (64).

Supported Versions: 
· R:BASE eXtreme 9.0 (Build: 9.0.1.10511 or higher )

1.30 Using the #NOW System Variable

Did you know that in addition to #DATE, #TIME, #PI, SQLCODE, and SQLSTATE, now you also have an
additional #NOW system variable?

Example 01:

SHOW VARIABLES

Among other system variables, such as #DATE, #TIME, #PI, SQLCODE, and SQLSTATE,  #NOW will
also be included when using the SHOW VARIABLES command at the R> prompt.

Example 02:

SET VAR vCurrentDateTime = .#NOW

The resulting variable vCurrentDateTime will return current date time with DATETIME data type.

Example 03:

UPDATE tablename SET datetimecolname = .#NOW WHERE ...

Will update the datetimecolname with DATETIME data type with current date and time value.

Example 04:
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INSERT INTO tablename (Colname1, Colname2, Colname3) + 
VALUES .vColumnValue1, .vColumnValue2, .#NOW

1.31 Using the Magnifying Glass

Did you know that you can use the Magnifying Glass to zoom any object, text, or even Expression
Window when defining a complex expression while in Form, Label, or Report Designer? R:BASE eXtreme
9.0 (32/64) includes an option to use a cool Magnifying Glass on demand.

To display the Magnifying Glass in R:BASE eXtreme 9.0, select "Utilities" > "Magnifying Glass" from the
Menu Bar.

Did you know that you can expand the horizontal and vertical size of the Magnifying Glass by grabbing
the corner or edge of the transparent glass displayed at the center of the screen?

Tips:

· [Ctrl]+[Alt]+M will launch the built-in Magnifying Glass (anywhere) 
· [Esc] or "Right-Click | Close" will close the Magnifying Glass 
· Right-Click will provide the option to zoom (2x, 4x, 8x, 16x)

Supported Versions:
· R:BASE eXtreme 9.0 for Windows (Build: 9.0.1.131028 and higher)
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1.32 Using the Enhanced Data Dictionary [F3] Key

While writing or editing embedded EEPs in Forms, Labels, Reports, or External Form Files (.eff), or even
writing code using the built-in editor, do you sometimes wish that you knew the exact names of all
installed printers, databases in the current folder or names of all available External Form files so that you
can simply copy and paste the values to avoid guess work.

Did you know that you can use the enhanced Data Dictionary [F3] key to find the exact names of
installed printers, databases, and all External Form Files in the current folder?

When you ARE NOT connected to any database, the following options are available when pressing the
[F3] key:

· Databases 
· Variables 
· Functions 
· Themes 
· Control Types 
· Printers 
· External Forms

When you ARE connected to any database, the following options are available when pressing the [F3]
key:

· Databases 
· Tables 
· Columns 
· Variables 
· Views 
· Forms 
· Form Component IDs (while in form designer) 
· Form Actions (while in form designer) 
· Reports 
· Report Component IDs (while in report designer) 
· Labels 
· Label Component IDs (while in label designer) 
· Functions 
· Stored Procedures 
· System Tables 
· System Columns 
· Themes 
· Control Types 
· Printers 
· External Forms

Double clicking on one single item or pressing the [Enter] key on a selected item will copy and paste the
items at the R> Prompt input console or editor.

Click+Ctrl+Click will select multiple items. Then, clicking on the [OK] button or simply pressing the
[Enter] key will copy and paste all selected items at the R> Prompt input console or editor.

[Shift + F6] will select all items. Pressing the [Enter] key will copy and paste all selected items at the R>
Prompt input console 
or editor.

Selecting the desired function from the [Functions] tab and then double clicking on one single item will
copy and paste the syntax 
at the R> Prompt input console or editor.

Supported Versions:
· R:BASE 7.6 (Build 7.6.3.30418 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.3.30418 or higher) for Windows 
· R:BASE Turbo (Build 8.0.17.30418 or higher) for Windows



"Tip of the Day" Digest37

Copyright © 1982-2012 R:BASE Technologies, Inc.

1.33 Using the Enhanced MAPIMail Plugins with Thunderbird

There are several steps required to use the enhanced R:BASE MAPIMail Plugins with Mozilla Thunderbird:

First, you must alter your Windows operating system setting for your default email program as follows:

1. Select the "Start" button, and choose "Settings" > "Control Panel" > "Add/Remove Programs"
2. Click on "Set Program Access and Defaults" button on the left panel.
3. Select the "Custom" radio button.
4. Click on the "down arrow" characters to expand the available options.
5. Select the "Mozilla Thunderbird" radio button under "Choose a default e-mail program". 
6. Click on the "OK" button to save your changes.

Next, you must update the Windows Registry in order to make sure that the MAPI protocol is installed:

1. Select the "Start" button for your Windows operating system, and choose "Run".
2. Enter "REGEDIT" into the field, and the Registry Editor will launch.
3. From the list on the left panel, select the value: HKEY_LOCAL_MACHINE. 
4. Within the tree view, select sub categories "SOFTWARE" > "Microsoft" > "Windows Messaging

SubSystem".
5. On the right panel, verify that the value for "MAPI" does exist and is equal to 1.
6. Close the Registry Editor window.

Now, we will check certain MAPI options within Mozilla Thunderbird

1. Start the Mozilla Thunderbird email client software
2. From the main Menu Bar, select "Tools" > "Options" 
3. Within this dialog window, select the "Advanced" button
4. Under the "General" tab, select the "Config Editor..." button
5. Type "mapi" into the filter to see the parameters that contain the word mapi.
6. Verify that the following parameters exist: 

mapi.blind-send.enabled = true 
mapi.blind-send.warn = false

The first parameter, mapi.blind-send.enabled, will likely already exist with its value set to true.
The second parameter may need to be added. 

1. If either parameter needs added, right click in the white space and select "New" > "
Boolean".

2. Enter the parameter, i.e. "mapi.blind-send.warn", and select the "OK" button.
3. From the true/false options, choose the appropriate value based upon what is listed above

for that parameter.
4. In order to verify your new parameter, click the "Show All" button, and reenter the "mapi"

filter.

Finally, you use the Enhanced MAPIMail Plugins (included with Update 1 of the R:BASE Plugin Power
Pack).

1. Copy the following MAPIMail Plugins into the appropriate R:BASE program directory or compiled
application directory. Here are the file names and the differences between the Plugins.

· MAPIMail.RBL (interactive - appears under Utilities > Plugins within R:BASE) 
· MapiMail2.RBL (automated - opens the MAPIMail dialog window and displays the defined

parameters) 
· MapiMail3.RBL (automated - opens the default email client and displays the defined parameters) 
· MapiMail4.RBL (automated - sends the email message automatically)

2. Using the automated Plugin parameters

Syntax:
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PLUGINS MapiMail2.rbl vMail|<parameters>
PLUGINS MapiMail3.rbl vMail|<parameters>
PLUGINS MapiMail4.rbl vMail|<parameters>

Parameters:

TO: specifies the list of recipients of the message 

CC: specifies the list of carbon copy recipients of the message 

BCC: specifies the list of blind carbon copy recipients of the message 

SUBJECT: specifies the subject string for the message 

BODY: specifies the body content of the message 

ATTACHMENTS: specifies the list of files to be send along with the message 

PROFILE_NAME: specifies a Profile to be used by the Messaging API when the Send
method is called. Typically, this parameter is left blank which instructs
MAPI to use the default profile. 

PASSWORD: specifies the password to be used during the logon process 

SENDDIRECT: specifies the setting for the "Send Directly" check box (TRUE/FALSE) 

RESOLVE_NAMES: specifies the setting to resolve a message recipient's name (as
entered by a user) to an unambiguous address list entry, optionally
prompting the user to choose between possible entries, if necessary.
(TRUE/FALSE)

Where:
vMail is the text variable to return the status, such as 'OK' or the exact -ERROR- message

Notes:
Returned variable name and the exact file name with path must be separated by a "|" pipe symbol.

Supported Versions:
· R:BASE 7.6 (Build 7.6.3.30425 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.3.30425 or higher) for Windows 
· R:BASE Turbo (Build 8.0.17.30425 or higher) for Windows 

1.34 Using SCALEBY Property in R:BASE Application (.RBA)

Did you know that now you can use the SCALEBY property to dynamically adjust your application's main
window or form based on a given screen resolution?

Syntax: 

PROPERTY RBA_FORM SCALEBY 'nnnn'

Use this property to automatically scale an R:BASE Application (.RBA) form and all related controls to a
specified screen pixel width. SCALEBY property modifies the Height and Width properties of the form and
all controls placed on it, but it does not change the Top and Left properties; therefore, the size of the
controls changes, but not the coordinates of the top-left corners of the controls. Thus, it preserves the
position of all controls on the form.

If you have developed an R:BASE Application (.RBA) form that is 800x600 for the majority of users
having a monitor with 800x600 screen resolution to fit the form on the entire available screen, but a few
users of your application have a higher resolution (1024x768) and if you wish your 800x600 form to fill
the entire screen of a monitor with a resolution of 1024x768, you'll need to use the RBA_FORM SCALEBY
property as follows:

Example: 

-- Application: On After Start Action 

PROPERTY RBA_FORM SCALEBY '800' 
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RETURN

This will scale the original form designed as 800x600 to fill the entire screen even if the screen resolution
is higher than 800x600, such as 1400×1050, 1280x800 or 1024x768.

Notes:

· The 'nnnn' value should exactly be the same as the original "form width" in order to scale
proportionally on the monitors with higher resolution.

· Use the SCALEBY property as embedded custom EEP in "On After Start" Action for R:BASE Application
(.RBA) file.

· To take advantage of this feature, make sure that you use the scaled true type fonts for all controls on
that form.

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.5.31229 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.5.31229 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.19.31229 or higher) 
· R:BASE eXtreme 9.0 for Windows (Build: 9.0.1.11229 or higher)

1.35 What Version of Engine DLL, and Files In Use?

Did you know that you can determine the exact version of the R:BASE eXtreme 9.0 Engine DLL, and all
related Windows DLLs that are being used with your currently installed R:BASE eXtreme 9.0? 

Here's how to determine the specific version of Engine DLLs are being used with your R:BASE eXtreme
9.0:

1. Start RBG90 (32 or 64)
2. From the main window, select "Help" > "File Versions..." from the main Menu Bar.

Notice a list of all DLLs, and Plugins if loaded, along with details including Name, Version, Size, Company,
and Path.

You may select to Print the list to the following: 

· Printer 
· Text File 
· PDF File 
· Clipboard

Supported Versions:
· R:BASE eXtreme 9.0 for Windows (Build: 9.0.1.10701 and higher)
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2 Settings

2.1 Assigning Default Component IDs for Form, Label, and Report
Controls

Did you know that while in the Form, Label or Report Designer, placing a new control can also assign a
default Component ID 
to that particular control?

Of course, you can always overwrite the default name assigned, if you wish.

This enhancement is implemented to ameliorate the use of the PROPERTY and GETPROPERTY
commands.

To incorporate this cool feature, you must first enable the check box for "Add Default Component ID"
within your Form, Label, and Report Default Settings.

For the Form Designer, select "Settings" > "Form Designer" from the main Menu Bar. Within the "Form"
tab, notice the "Add Default Component ID" option.

For the Report/Label Designers, select "Settings" > "Report/Label Designer" > "Default Settings" from
the main Menu Bar. Within the "General" tab, notice the "Add Default Component ID" option.

Supported Versions: 
· R:BASE 7.6 for Windows (Build: 7.6.4.30728 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.4.30728 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.18.30728 or higher)

2.2 Automating the Directory for SCRATCH Files

Did you know that you can automate the default directory for the R:BASE/OTERRO Scratch files without
knowing the user's rights to their temporary directory?

SET SCRATCH sets the drive and directory location for temporary files created when sorting data.

SET SCRATCH ON - stores temporary sort files on the database drive and directory.

SET SCRATCH OFF - stores files on the current drive and directory.

SET SCRATCH <path> - provides the path to the location where temporary files are stored.

The latest builds of R:BASE and Oterro include the enhancement to simply type "TMP" for SCRATCH
option in your configuration file.

SET SCRATCH TMP

Updating the SCRATCH setting to TMP in the appropriate configuration files, R:BASE/OTERRO will use the
user's TMP environment settings for SCRATCH files on startup.

Using the latest builds of R:BASE/OTERRO, you need to either update the line for "SCRATCH TMP" to
automatically define the windows temporary environment or use "SCRATCH C:\TEMP", for example, in
R:BASE/OTERRO configuration files. If you define the "SCRATCH C:\TEMP", make sure that you actually
have the C:\TEMP directory. We suggest that you keep all configuration (*.CFG) file in Windows or
WinNT directory.

This option is also helpful when you establish a universal naming convention (UNC) network connection
for R:BASE database as a System DSN defined with UNC, such as "\
\FileServerName\SharedDirectoryName\dbname.rb1". This type of environment requires you to sure
that you have also set the path for R:BASE and OTERRO temporary SCRATCH files.

Use any text editor or R:BASE Editor to edit the configuration file to read SCRATCH settings as follows:
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SCRATCH TMP

Configuration Files:

· RBEngine.CFG (R:BASE 7.1 for Windows) 
· RBEngine75.CFG (R:BASE 7.5 for Windows) 
· RBEngine76.CFG (R:BASE 7.6 for Windows) 
· RBEngine8.CFG (R:BASE Turbo V-8 for Windows) 
· Oterro.CFG (Oterro 3.1 for Windows) 
· Oterro35.CFG (Oterro 3.5 for Windows) 
· Oterro8.CFG (Oterro 8.0 for R:BASE V-8 "Turbo" Database)

This will help eliminate all issues related to the access rights, disk space and so on, when running R:
BASE/OTERRO on enterprise 
servers and when accessing R:BASE database defined as a System DSN using the UNC option.

2.3 Cleaning Scratch (.$$$) Files on Exit

Did you know that you can have R:BASE clean any remnants of temporary (.$$$) scratch files, on exit?
Here's how:

From the R:BASE main Menu Bar, select "Settings" > "Clean Scratch Files on Exit".

Checking this option will clean any remnants of temporary (.$$$) scratch files, on exit.

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.4.30808 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.4.30808 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.18.30808 or higher) 
· R:BASE eXtreme for Windows (Build: 9.0.1.30808 or higher)

2.4 Customizing Default Printer Settings

Did you know that among many default settings, now you can also set the default settings for your
Report Printer, Paper Size and Paper Source?

Here's how:

1. Database Explorer > Settings > Report/Label Designer > Default Settings
2. Click on [Printer] tab and select the default Printer for report
3. Click on [Paper Size] tab to select the default Paper Size
4. Click on [Paper Source] tab to select the default Paper Source

These default settings are for your local workstation and will be effective for designing new reports only.

2.5 Customizing Hints

Displaying hints on your cool custom-designed forms, external forms, or even from the R:BASE
Database Explorer can be very helpful for the end user.

Until now, you had the option to set background color, font, font style, font size, font effects, font color,
and the time (in milliseconds) to display and hide the hint. The entire hint displays in a balloon.

What if your end-users don't like the hint embedded in the balloon? What about adding a balloon hint
with an appropriate icon to display the nature of the hint?

Did you know that you can now customize the hint settings to display hints with or without a balloon
along with the option 
to use the appropriate icon when used with balloon?
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Here's how:

1. Start R:BASE 7.6, C/S:I 7.6 for Turbo V-8 for Windows
2. Customize Hint Settings

Select "Settings" > "Hint Settings..." from the Menu Bar.

Notice the following options for Hint Settings:

· Background Color and Font - specifies the background color and text font, color and style
· Hide Pause (ms) - specifies the time interval for the hint to be displayed on the screen
· Hint Pause (ms) - specifies the time interval for the hint to appear after the cursor first moves

over the control (default 5000)
· Short Pause (ms) - specifies the time interval for the hint to appear after the cursor leaves and

immediately returns to the same control (default 0)
· Show Balloon - specifies whether the hint is encompassed within a balloon (default 500)
· Display Icon - specifies what, if any, icon is included in the hint balloon 

3. If you wish to remove the balloon for hints, simply un-check the option for Show Balloon.
4. If you wish to display the balloon hint with no icon, check the option for "Show Balloon" and select

"None" from the list of available Display Icons
5. If you wish to display the balloon hint with an icon, check the option for "Show Balloon" and select

one of the following icons from the list of available Display Icons.

6. Click the "OK" button to save the Hint Settings.

These hint settings will be saved for this workstation. 

2.6 Customizing WALKMENU Time Interval Settings

Did you know that you can customize the WALKMENU Time Interval Settings to match your typing speed?

R:BASE now includes a Walkmenu Time Interval Setting to control the WALKMENU speed for CHOOSE,
ListBox, ComboBox and Pop-up Menus.



Settings 44

Copyright © 1982-2012 R:BASE Technologies, Inc.

1. Start R:BASE
2. Database Explorer > Main Menu > Settings ...
3. Select Walkmenu Time Interval ... and enter the value (default value is set to 1500 ms.)

The time interval value must be specified in milliseconds.

For example:

1000 for 1 second 
1500 for 1.5 seconds

Using the command file or in an EEP, you may also control the WALKMENU time interval setting by using
the PROPERTY command.

Example:

SET WALKMENU ON 
PROPERTY APPLICATION WALKMENUTIMEINTERVAL nnnn

About WALKMENU:
SET WALKMENU ON allows the user to access list item selections by typing the beginning characters (up
to when a match is made) of their names.

2.7 Disabling TRACE in Forms, Labels and Reports

When you are close to distributing your developed R:BASE applications and are reviewing your work
from a standpoint of securing your code, you may notice that the "SET TRACE ON" setting allows for the
viewing of your command syntax within Form/External Form "On Before Start" EEPs and within Label/
Report "Before Generate..." custom actions. 

Even if the first command in that EEP is "SET TRACE OFF", the form, label or report won't trace after that
command; however, all of the code can be seen by scrolling down before the F10 key is pressed.

Sure, you can password protect your form, but you don't want your users to have to enter a password
every time they use the form just to keep the code safe from an unscrupulous person who happens to
have R:BASE (even the trial version will trace!).

Did you know that you can disable the TRACE or ECHO by using the newly implemented option of
"Disable Trace" while in Form, Label or Report Designers?

Now you can secure your code using the "Disable Trace" option. Here's how:

Forms/External Form File:

1. In Form or External Form Designer, select "Form Properties", and choose the "Miscellaneous" tab.
2. Notice the "Disable Trace" checkbox option.

Labels:

1. In the Label Designer, select "Label" from the main Menu Bar.  
2. Notice the "Disable Trace" option. 

Reports:

1. In the Report Designer, select "Report" from the main Menu Bar.  
2. Notice the "Disable Trace" option. 

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.3.30516 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.3.30516 or higher) 
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· R:BASE Turbo V-8 for Windows (Build: 8.0.17.30516 or higher)

2.8 Display Extended Characters

You can force R:BASE to display extended characters correctly by editing your R:BASE configuration file
(.CFG). Look within the file for the Case and Collating tables. In the CFG file look for CASEP and
COLLATE.

1. Based on the character that is not displayed correctly, like the Õ, capture its ASCII value, 213, from
the Windows Character Map utility.

2. Within the CFG file, under CASEP and COLLATE, you may see:

CASEP 213 79

COLLATE 213 79

3. Change the 79, which is the ASCSI value for the capital letter O, to 213. Then, adjust any other
characters to their correct counterpart for your extended text.

4. Now, you have to PACK the Case and Collating tables at the R> Prompt with the PACK command as
follows:

DISCONNECT 
SET MULTI OFF 
CONN dbname 
PACK ALL WITH USER CASE 
DISCONNECT 
SET MULTI ON 
CONN dbname

The correct values should now display correctly in the tables, forms, and reports.

You may also need to change your R> Prompt "Console Font" setting in order to use your extended
characters in R> Prompt window queries. 

1. From the Main Menu Bar, choose "Settings" > "R> Prompt..."
2. Select the "ASCII" radio button and select the "OK" button

2.9 Duplicating Your Personalized R:BASE Settings

When installing R:BASE eXtreme 9.1 (32/64) on your computer, the default settings are automatically
installed and initiated when you first start R:BASE eXtreme 9.1. Then, you may further customize R:
BASE Settings on your working desktop, including the look and feel, as well as all default settings when
designing a new database, tables, forms, labels, reports, external form files, and applications as follows:

· Startup Options 
· Database Explorer 
· R:BASE Editor 
· R> Prompt 
· Data Browser 
· Data Designer 
· Form Designer 
· Report/Label Designer 
· Application Designer 
· BLOB Editor 
· Hint Settings 
· Walkmenu Time Interval 
· Default Printer Font 
· Custom Colors 
· Registry Settings 
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· Show Main Toolbar 
· Warn When Closing R:BASE Session 
· Show Check Box to Suppress Error Messages 
· Clean Scratch Files on Exit 
· Configuration Settings

These custom settings are saved and are effective when you are the same logged in user on that
particular workstation. Any change in the layout afterwards is also updated immediately, including
Favorite Folders.

If you are in a situation with many workstations, such as office, home, two notebooks for the road,
remote client(s) workstations, etc., you will have to either customize each individual workstation to
match your favorite settings, custom colors, layouts, etc., one at a time, or live with what you have and
customize as you go. This is not a productive R:BASE development environment, wouldn't you agree?

Did you know that you can export your favorite R:BASE eXtreme 9.1 (32/64) settings (not including the
license, of course) from one workstation to another by simply using the new "Registry Settings | Save to
File" option?

Here's how:

01. Database Explorer | Main Menu | Settings ...
02. Select Registry Settings ...
03. Click on Save to File ...
04. Assign the file name and click on the [Save] button to save.  The binary file will be saved as
filename.bin

Keep this binary file handy when re-setting R:BASE eXtreme 9.1 settings on the same computer or
duplicating your personalized settings on other computer(s). Use "Load From File ..." option to load
settings.

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.4.11012 or higher)

2.10 Handling Form/Report/Label Designer -ERROR-Messages

Did you know that you can pre-define all required global variables for Forms, Reports and Labels within
the Form, Report or Label Designer?

To avoid any inconvenience the next time you open the form, report or label with -ERROR- messages
related to missing global variable(s) in expression, a new "On Before Design Action..." has been
implemented for Form, Report and Label Designers to pre-define all required variables with appropriate
data types before opening the form, report or label in designer.

Here's how:

Form Designer | Layout | On Before Design Action...

Report Designer | Report | Actions | On Before Design...

Label Designer | Label | Actions | On Before Design...

2.11 Taking Advantage of the SCRATCH Setting

The SCRATCH setting allows the current R:BASE session to store all temporary sort files on the drive
and directory based on the SCRATCH setting.

Syntax: 

SET SCRATCH <value>
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Supported values: ON, OFF, TMP, or <fullpath>

SET SCRATCH ON will store temporary sort files on the database drive and directory.
SET SCRATCH OFF will store temporary files on the current drive and directory.
SET SCRATCH TMP will store temporary files in Windows' User Environment TMP folder.
SET SCRATCH <fullpath> will provide the path to the location where temporary files could be stored.

By default, the R:BASE/OTERRO configuration files, such as RBEngine.CFG, RBEngine75.CFG,
RBEngine76.CFG, RBEngine8.CFG, OTERRO.CFG, OTERRO35, OTERRO8.CFG, and RBASE76.CFG) include
the keyword TMP for the SCRATCH setting. Using the typical installation option of R:BASE or OTERRO the
appropriate configuration file is installed in the "Windows" folder.

The default keyword (TMP) allows R:BASE or Oterro sessions to use the Windows' User Environment TMP
Variable setting for SCRATCH files on startup. This will also eliminate all issues related to setting the
SCRATCH directory and related files. 

This default setting also enables R:BASE/OTERRO to write scratch files without being concerned about
read, write, and delete permissions on the network/local folders.

To take advantage of this setting, use the option "SCRATCH TMP" in the appropriate R:BASE and
OTERRO configuration files or use the "SET SCRATCH TMP" command in your application startup files.

Did you know that you can use "SET SCRATCH TMP" command at the R> prompt or in your application
startup file?

Using the latest updates of R:BASE 7.6, C/S:I 7.6 and Turbo V-8 for Windows, you can. Previously,
"TMP" option could only be used in the configuration (.CFG) files.

You can also use the enhanced "Configuration Settings" panel to define SCRATCH settings. From the R:
BASE Menu Bar, select "Settings" > "Configuration Settings":

(R:BASE 7.6)

Supported Versions: 
· R:BASE 7.6 (Build 7.6.2.31221 or higher) for Windows 
· R:BASE (C/S:I) 7.6 (Build 7.6.2.31221 or higher) for Windows 
· R:BASE Turbo (Build 7.6.2.31221 or higher) for Windows



Settings 48

Copyright © 1982-2012 R:BASE Technologies, Inc.

2.12 Using Conditional TRACE in a Command File

Did you know that you can use the conditional TRACE in a command file or EEP to just debug a block of
code?

A new conditional SET TRACE ON/OFF option has been implemented to execute TRACE (Interactive
Command File Debugger) inside a command file or EEP to trace a block of code as defined.

Syntax:

SET TRACE ON/OFF (Default is ON)

Example 01: (typical command line option)

TRACE filename.ext 

Example 02: (in a command file)

-- start 
Your code here .... 

SET TRACE ON {this will start the trace within a command file}

Your code here ... 

SET TRACE OFF {this will stop the trace within a command file}

Your remaining code here ... 

-- end

Notes:

· Once you turn OFF the TRACE in an R:BASE session, you will need to turn it back ON. 
· (CVAL('TRACE')) will return the current status of TRACE (Values: ON or OFF)
· SHOW TRACE will display the current status of TRACE (Values: ON or OFF)
· Newly created R:BASE configuration files (.CFG) will include the option for TRACE ON
· If you want no one to TRACE your code, setting the TRACE option to OFF at the beginning

2.13 Using Double-Click to Bring Up the Designers

Did you know that you can double-click on any Table, View, Stored Procedure, Report, Label, Form,
External Form File, Application, or Command File to bring up the appropriate item in the corresponding
designer?

After connecting to a the database and using the Database Explorer, traditionally, you would first
highlight the appropriate Table/View/Stored Procedure/Report/Label/Form/External Form File/
Application/Command File and then right click to access the speed menu or click on the "Design" option
to open the selected item in its designer.

By default, double-click is used to "Open" or "Run" selected item. However, if you wish to simply double-
click on the item to open it within its designer, all you need to do is customize the Database Explorer
settings.

Here' how:

Database Explorer > Main Menu > Settings ...
Click on "Double Click Open Designer" option to Select

These custom settings are specific to the logged in user only. Using these custom settings, you can run
R:BASE Your Way!
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2.14 Using R:BASE Executable Startup Options

R:BASE for Windows supports several Startup Options that you can embed in the desktop shortcut Icon.

Available Options:

· -A 
· "-BLOB <filename>" 
· -C 
· -E 
· "-E <filename>" 
· -L 
· -O

-A  This option tells R:BASE to look in the RBG7.EXE program directory first for the RBENGINE files.
This option is beneficial if you are making only one installation of R:BASE on a network server and
want local workstations to be able to launch the R:BASE 7.x program remotely without the need to
install it on the local workstation.

"-BLOB <filename>"  This option opens the specified file in the R:BASE BLOB Viewer/Editor when
the program is launched. Note that there is a single space between the RBG7.EXE and the BLOB and
file name parameter, and that the -BLOB file name must be enveloped in double-quotes.

-C  This option opens the R> Prompt window when the program is launched.

-E  This option opens the R:BASE Editor when the program is launched.

"-E <filename>"  This option opens the specified file in the R:BASE Editor when the program is
launched. Note that there is a single space between the R:BASE executable and the E file name
parameter, and that the -E and file name must be enveloped in double-quotes.

-L  This option opens the Database Explorer when the program is launched.

-O  This option specifies an alternate R:BASE configuration file (.CFG) file to use for startup
information. 

2.15 Warning When Changing Table Structure

Previous updates of R:BASE eXtreme 9.1 (32/64) for Windows included an enhancement request to warn
the user when accessing and managing the table structure (RBDEFINE), in a multi-user connected
database environment, using the Database Explorer.

Did you know that now you can turn off that -Warning- message, if you are a veteran and know what
you are doing, taking full responsibility for accessing or managing table structure in a multi-user
environment?

Here's how:

01. Start R:BASE eXtreme 9.1

02. Database Explorer | Main Menu | Settings | Data Designer ...

     Notice the option for "Warn When in Multi-User Environment"

03. Un-Check this option to turn off the warning message.
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     The default installation is always set to checked.

Now you can have your cake and eat it too.

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.4.11012 or higher)

2.16 Warning When Closing an R:BASE Session

Have you ever been in a situation with many opened R:BASE sessions on your normal or extended
desktop (because you can), and then mistakenly clicked on the close [x] icon of the R:BASE Database
Explorer, closing the session (as it should), and you wished it would have warned you if you really
wanted to close that session of R:BASE?

Now R:BASE includes a "Setting..." to prompt you if you really want to close an R:BASE session when
clicking on the [x] close window 
icon of the Main Database Explorer. 

Here's how:

1. Start R:BASE 
2. Database Explorer|Main Menu|Settings

Check the Setting for:
[x] Warn When Closing R:BASE Session (the default is set to Off - unchecked)

3. Now close the R:BASE session by clicking on the [x] and close window icon on the Main Database
Explorer window.

Notice the confirmation dialog box?

"Do you really want to close this R:BASE session? [Yes] [No]"
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3 R> Prompt

3.1 Copying/Pasting Multiple Line Code

When copying your complete code with multiple lines and continuation symbols such as "+" at the R>
prompt, it can be tedious to take out all the plus characters and turn the entire code as one line for the
R> prompt to execute properly.

For example, a command looks like the following when typed in RBEdit or the R:BASE Editor 7.6.

CHOOSE vWhereCluase FROM #WHERE IN Customer + 
OPTION THEMENAME R:BASE Rocks! + 
|WHERE_CLAUSE WHERE CustState IS NOT NULL + 
GROUP BY CustState HAVING COUNT(CustState) > 1

If you copy and past the above command, with multiple lines and continuation characters at the R>
prompt, it will be copied 
exactly as is. Then, you would have to eliminate the "+" characters before pressing the [Enter] key to
execute the command.

Did you know that you use the [Shift]+[Ctrl]+[Alt]+[C] keys to copy the entire block, then paste it at the
R> prompt as one single line without the continuation "+" characters?

Using the [Shift]+[Ctrl]+[Alt]+[C] keys eliminates the continuation "+" characters at the end of each line
when pasted.

Supported Versions: 
· R:BASE 7.6 (Build 7.6.2.30102 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.2.30102 or higher) for Windows 
· R:BASE Turbo (Build 8.0.16.30102 or higher) for Windows

3.2 Command History

Pressing [Ctrl+H] keys at the R> Prompt brings up the list of all commands that were executed at the R>
Prompt during that particular session of R:BASE 7.6 or Turbo V-8 for Windows. 

Once the R> Prompt Command History list is displayed in the order of execution, traditionally, you will
have to select the command from the list, click on [Select] button to paste the command at the R>
Prompt and then press [Enter] key to execute that command again at the R> Prompt.

Did you know that you can click on the [Run Selected] button to execute the selected command at the
R> Prompt?

You will also notice that the last executed command is listed at the top of the list.

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.4.30623 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.4.30623 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.18.30623 or higher)

3.3 Documenting and Recycling the Command History

The enhanced Command History panel is a new addition within the R> Prompt window. If it is not
displayed, you can access the Command History panel, using the [Ctrl]+[H] keys, or from within the R>
Prompt Settings.

To execute any command displayed within the Command History panel, you can either double click on a
command, or select the command from the list, which will display the command at the R> Prompt Input
console, and then press the [Enter] key.
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Did you know that you can [Save] the entire command history to a file or copy to the clipboard for
documenting or recycling purposes? You can also [Load] the command history from file.

Notice the following options when you right-click on "Command History" panel.

· Run Selected Command 
· Clear Command History 
· Close Command History Panel 
· Load Command History from File... 
· Save Command History to File... 
· Copy Command History to Clipboard

Supported Versions: 
· R:BASE eXtreme 9.0 (Build: 9.0.1.10511 or higher )

3.4 Hot Keys

Usually, when you type a command at the "Input Console" of the R> prompt and press the [Enter] key,
the "Output Console" displays the output results. The typed command at the input console is then
cleared.

If you wish to retype the same command again, you either have to use the [PageUp], [PageDn] or
[Ctrl+H] keys to view the history of all commands typed at the R> prompt. The history is retained for
the current session of R:BASE. Clicking the mouse on the Output Console and then pressing the
[PageUp] key reveals the entire history of output results. Using the CLS command clears the buffer of all
stored results in Output Console.

Did you know that you can type the command at the input console of the R> prompt and still retain the
typed command by simply holding the [Shift] key and then pressing the [Return] Key?

Holding the [Shift] key and then pressing the [Return] key will retain the typed command in the input
console of the R> prompt.

Supported Versions: 
· R:BASE 7.6 (Build 7.6.2.31221 or higher) for Windows 
· R:BASE (C/S:I) 7.6 (Build 7.6.2.31221 or higher) for Windows 
· R:BASE Turbo (Build 7.6.2.31221 or higher) for Windows
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4 Database Explorer

4.1 Default File Names for Unloading Forms/Labels/Reports

Did you know that when you unload a form, label or report using the Database Explorer, the default file
name includes a suffix "_Form", "_Label", or "_Report" for the form, label, or report?

Using this method, you will never have the problem of forms, labels, or reports with same names wiping
out each other's LOB files.

For example:

When unloading a form named "Customers", the following two files will be created:

· Customers_Form.frm 
· Customers_Form.lob

When unloading a label named "Customers", the following two files will be created:

· Customers_Label.lbl 
· Customers_Label.lob

When unloading a report named "Customers", the following two files will be created:

· Customers_Report.rpt 
· Customers_Report.lob

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.3.30509 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.3.30509 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.17.30509 or higher)

4.2 Exploring the Database Explorer

Here are a few tips related to the Enhanced Database Explorer:

01. Renaming List Items 

· Databases 
· Tables 
· Views 
· Stored Procedures 
· Forms 
· Reports 
· Labels 
· External Forms 
· Applications 
· Command Files

Highlight the item, right-click and select "Rename ...".

You may also use [F2] key to rename selected item, or use click-pause-click to rename the selected
item as well.

02. Stored Procedures - Find in Stored Procedures

From the Database Explorer, select Stored Procedures from the Group Bar menu on the left.

I. Use [Ctrl+F] to launch "Find in Stored Procedures" Window to Find Text. 
II. Double-clicking on the selected item in Search Results will launch R:BASE Editor with highlighted

found text. Use [F8] key to search next match while in the same block of code.
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03. Forms - Find in Custom EEPs

From the Database Explorer, select Forms from the Group Bar menu on the left.

I. Select a single, multiple, or [Ctrl+A] for all forms.
II. Use [Ctrl+F] to launch "Find in Custom EEPs" dialog box to enter text to find.
III.Selecting the form in [Form List] will expand Search Results with itemized list of controls and

embedded Custom EEP.
IV.Double-clicking on the link will launch R:BASE Editor with highlighted found text. Use [F8] key to

search next match while in the same block of code.

Note: 
While editing the Custom EEP, notice the Editor Caption with all details related to the Form Name,
Control Name, Caption, Coordinates, and option that is used for Custom EEP, such as On Click EEP,
etc.

04. Reports - Find in Custom EEPs

From the Database Explorer, select Reports from the Group Bar menu on the left.

I. Select a single, multiple, or [Ctrl+A] for all reports.
II. Use [Ctrl+F] to launch "Find in Custom EEPs" dialog box to enter text to find.
III.Selecting the report in [Report List] will expand Search Results with itemized list of sections/

bands and embedded Custom EEP.
IV.Double-clicking on the link will launch R:BASE Editor with highlighted found text. Use [F8] key to

search next match while in the same block of code.

Note: 
While editing the Custom EEP, notice the Editor Caption with all details related to Report Name,
Action, Band, and option that is used for Custom EEP, such as On Before Generate EEP.

05. Labels - Find in Custom EEPs

From the Database Explorer, select Labels from the Group Bar menu on the left.

I. Select a single, multiple, or [Ctrl+A] for all labels.
II. Use [Ctrl+F] to launch "Find in Custom EEPs" dialog box to enter text to find.
III.Selecting the label in [Label List] will expand Search Results with itemized list of sections/bands

and embedded Custom EEP.
IV.Double-clicking on the link will launch R:BASE Editor with highlighted found text. Use [F8] key to

search next match while in the same block of code.

Note: 
While editing the Custom EEP, notice the Editor Caption with all details related to Report Name,
Action, Band, and option that is used for Custom EEP, such as On Before Generate EEP.

06. External Forms - Find in Custom EEPs

From the Database Explorer, select External Forms from the Group Bar menu on the left.

I. Select a single, multiple, or [Ctrl+A] for all external forms.
II. Use [Ctrl+F] to launch "Find in Custom EEPs" dialog box to enter text to find.
III.Selecting the form in [Form List] will expand Search Results with itemized list of controls and

embedded Custom EEP.
IV.Double-clicking on the link will launch R:BASE Editor with highlighted found text. Use [F8] key to

search next match while in the same block of code.

Note: 
While editing the Custom EEP, notice the Editor Caption with all details related to Form Name,
Control Name, Caption, Coordinates, and option that is used for Custom EEP, such as On Click EEP,
etc.

07. Applications - Find in Custom EEPs

From the Database Explorer, select Applications from the Group Bar menu on the left.
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I. Select a single, multiple, or [Ctrl+A] for all applications.
II. Use [Ctrl+F] to launch "Find in Custom EEPs" dialog box to enter text to find.
III.Selecting the application in [Application List] will expand Search Results with itemized list of

controls and embedded Custom EEP.
IV.Double-clicking on the link will launch R:BASE Editor with highlighted found text. Use [F8] key to

search next match while in the same block of code.

Note: 
While editing the Custom EEP, notice the Editor Caption with all details related to Application Name,
Control Name, Caption, Coordinates, and option that is used for Custom EEP, such as On Click EEP,
etc.

08. Command Files - Find in Files

From the Database Explorer, select Command Files from the Group Bar menu on the left.

I. Select a single, multiple, or [Ctrl+A] for all command files.
II. Use [Ctrl+F] to launch "Find in Files" dialog box to enter text to find.
III.You may also customize the search using Search Options and File Attributes. Click on [Start]

button to search.
IV.Highlight one, multiple, or [Ctrl+A] for all command files that match the criteria. Click on [Open

File(s)] button to open all command files in R:BASE Editor.

09. Command Files - Editing Multiple Files at Once

From the Database Explorer, select Command Files from the Group Bar menu on the left.

Select a single, multiple, or [Ctrl+A] for all command files and then right-click to select Edit File(s) to
edit all files at once.

Make sure to customize R:BASE Editor Settings to take advantage of new and enhanced options,
such as:

General (Background, Selected Block, Text Match) 
o String 
o Display 
o Line Highlight 
o Background 
o Printer Font 
o Compare by Content 
o Structure Toolbar 
o Syntax Schema

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10414 or higher)

4.3 Form Preview From the Database Explorer

Did you know that you can preview any Form from the Database Explorer?

Here's how:

A new setting has been introduced to preview your form canvas from the Database Explorer, when you
are not even using the form designer.

Steps to activate this "Preview" option:

1. From the Database Explorer, select "Settings" > "Form Designer..." from the Menu Bar.

The "Default Form Settings" dialog window will appear.

2. Check the option for [ ] Save Form with Preview
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3. Click on [OK] button to save the user settings.

Now open any form in form designer, make any changes, save the form and then close the Form
Designer. From now on, creating a new form or updating an existing form will be saved with the preview
capabilities.

When using the [Forms] section of the Database Explorer, select that form you have just saved and then
right-click on it for all speed menu options. Notice the additional item [Form Preview]. Selecting this
option will display the Form Preview.

Supported Versions:
· R:BASE 7.6 for Windows (Build 7.6.2.31026 or higher) 
· R:BASE 7.6 (C/S:I) for Windows (Build 7.6.2.31026 or higher) 
· R:BASE Turbo V-8 for Windows (Build 8.0.16.1026 or higher)

4.4 Launch Directory

Did you know that you could launch the current directory location in Windows Explorer with a click,
directly from the R:BASE Database Explorer? 

On the "Property Bar", there is a folder icon with a green arrow. If you left click, a dialog will open
prompting you to change the working directory. 

However, if you right click, you will launch Windows Explorer in your current directory location.

4.5 One Click UNLOAD for Data and Structure

Did you know that you can UNLOAD the STRUCTURE as well as the DATA (ALL), using the one-click
option of the R:BASE Database Explorer?

Here's how:

CONNECT RRBYW10

Database Explorer | Tables

Right-click on the desired table and click on "Unload" > "Structure and Data..." option of the speed
menu.

This will UNLOAD the data as well as the structure of selected table to an external file, using the default
file name as tablename.all, which you can change, if you wish.

The other options for "Unload" include strictly structure output:

· Structure...
· Definition...
· Definition with Constraints, Indexes, Comments...

4.6 Open Table/View Options Using the Data Browser/Editor

Traditionally, when using the Database Explorer, double-clicking on a table/view will bring up the Data
Browser in a Browse mode and then you can sort the data by clicking on a column header or using the
Sort options from the main menu. You can also to press [F4] key or click on the toolbar icon to toggle
Edit or Browse mode. There is no option to limit the number of rows with a WHERE clause after you have
double clicked on the table/view.

Did you know that you can use the new Setting for the DB Explorer to display a "Open Table" dialog with
the following options:
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· WHERE Clause 
· Open As: [ ] Browse [ ] Edit 
· WHERE Builder 
· Open As MDI Window

This setting will provide you with options to customize the data and Data Browser/Editor Window itself.

RBG9 Main Window | Main Menu | Settings | Database Explorer ...

Supported Versions: 
R:BASE eXtreme 9.0 (Build: 9.0.1.11111 and higher)

4.7 Renaming Database Explorer Objects

Using the new Main Window and Database Explorer, while seeing the list of Tables, Views, Stored
Procedures, Forms, Reports, Labels, External Form Files, Applications, and Command Files, now you can
simply left click twice (not double-click) or use the [F2] key to rename the displayed name accordingly.

Be careful using this shortcut!

Supported Versions: 
R:BASE eXtreme 9.0 (Build: 9.0.1.131028 or higher)

4.8 Searching for Text in Control Properties

Did you know that you can search for specific text that may be defined in Form, Report, Label, and
External Form control 
properties?

The new "Find in Control Properties" feature opens a search utility to locate specific text defined within
the properties 
of any object for the connected database. The functionality to search for text within Control Properties
allows users to 
locate Component IDs, hints, text captions, columns listed in WHERE Clauses for Lookup controls, and
also pop-up menus.
Any text defined within a form, report, or label control will be used in the search!

When searching for text within Control Properties, text strings can be located within the following
modules:

· Forms 
· Reports 
· Labels 
· External Forms

Here's how:

To begin searching, press the [Ctrl]+[L] key combination to display the "Find in Control Properties"
dialog.
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Searching for text can include all listed items displayed at the Database Explorer, or just a selected few.
For example, selecting ten out of fifty forms, and then pressing [Ctrl]+[L] will search for the text for all
controls within the ten selected forms.

Note: The "Find in Control Properties" dialog can only be launched from the Database Explorer.

After the search is complete, a list of forms and form objects that match the search will be displayed.
The search results will contain form object(s) whose property and value match the search criteria.

The property value can be launched within a dialog window for editing by double clicking on it, or by
selecting the "Edit..." 
button. The search results can be saved to several output formats. 

The "Expand All" check box allows the list of EEPs in the search results to expand for full viewing.

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.5.11111  or higher)

4.9 Searching for Text in Expressions

Did you know that you can search for specific text that may be defined in Form, Report, and Label
expressions?

The "Find in Expressions" feature opens a search utility to locate specific text defined within the form,
report, and label expressions for the connected database. The functionality to search for text within
expressions allows users to locate specific columns, tables, functions, variables, and any part of a
WHERE Clause.
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Any text defined within an expression will be used in the search!

Here's how:
When searching for text within expressions, text strings can be located within the following modules:

· Forms 
· Reports 
· Labels

To begin searching, press the [Ctrl]+[Shift]+[F] key combination to display the "Find in Expressions"
dialog.

Searching for text can include all listed items displayed at the Database Explorer, or just a selected few.
For example, selecting fifteen out of fifty reports, and then pressing [Ctrl]+[Shift]+[F] will search for the
text for all expressions within the fifteen selected reports.

Note: The "Find in Expressions" dialog can only be launched from the Database Explorer.

After the search is complete, a list of reports and defined variable expressions that match the search will
be displayed.
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The search results will contain the tables(s) and expressions that match the search criteria. The variable
expression can be launched within a dialog window for editing by double clicking on it, or by selecting the
"Edit..." button. The search results can be saved to several output formats. The "Expand All" check box
allows the list of expressions in the search results to expand for full viewing.

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.5.11111  or higher)

4.10 Using MDI Option for Database Explorer Modules

When customizing the settings for Database Explorer, in addition to change the appearance of the
Database Explorer window, you may also select the option to "Use Dialog to Open Table/View". 

Selecting this option toggles the ability to launch a dialog to add a WHERE Clause, change the browse
mode, and use an MDI window when opening a table or view. 
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When you double click on a table or view, "Open Table" or "Open View" dialog box is launched and next
to the WHERE Builder button an "MDI" check box is available. When MDI option is checked, the Data
Browser will be displayed as an MDI windows. You may open as many tables or views at the same time
using the MDI option.

Did you know that you can use the MDI option when double-clicking on Forms, Reports, Labels, or
External Forms to run? Notice the [ ] MDI option next to the [WHERE Builder] button.

You may also use the same option for Reports, Labels, and External Forms. There is no limit.

If you wish to retrieve, switch back to previously opened MDI Browser, Form, Report, Label, External
Form , or would like to see a list of all opened MDI windows, you may use the Window option of the
Database Explorer by selecting Window > MDI Windows.
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Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10414 or higher)
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5 Data Designer (RBDefine)

5.1 Reorganizing Columns in Data Designer

Did you know that you can reorganize/re-sequence table columns in the Data Designer using the Change
Order [Move Up] and [Move Down] speed buttons?

Here's how:

1. Start R:BASE. 
2. Connect to a database.
3. From the Database Explorer, select the "Tables" option.
4. Select the appropriate table and choose the "Design Table" option.
5. Within the "Data Designer", select the "Columns" tab.

Notice the green arrow [Move Up] and [Move Down] speed buttons!

6. Highlight the exact column that you wish to move up/down.
7. Click on the [Move Up] or [Move Down] button accordingly.

Notice the new position of selected column

8. Click on the "Save" button to save the current structure or "Save and Close" to save the current
structure and close the data designer.

Supported Versions
· R:BASE 7.6 (Build 7.6.3.30502) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.3.30502) for Windows 
· R:BASE Turbo (Build 8.0.17.30502 for Windows

5.2 Validate the syntax for an email address

Here is a tip from the Father of R:BASE, Wayne Erickson (Head of the R:BASE Development Team), that
validates the syntax for an email address in R:BASE.

Wayne's Corner: Validating syntax for an email address in R:BASE ...

For an example, assume you have a table called "person" and it has a column called "email" for storing
email addresses. You want to check some things to make sure the values in this column meets some
basic things an email address should have. Here is the rule definition code:

RULES 'Improper Email Address' FOR Person SUCCEED + 
WHERE + 
(SLOC(SMOVE(`Email`,(SLOC(`Email`,'@')+1),SLEN(`Email`)-(SLOC
(`Email`,'@')),' ',1),'.')) > 1 + 
AND + 
((SLEN(SMOVE(`Email`,(SLOC(`Email`,'@')+1),(SLEN(`Email`)-SLOC
(`Email`,'@')),' ',1)))- + 
(SLOC(SMOVE(`Email`,(SLOC(`Email`,'@')+1),(SLEN(`Email`)-SLOC
(`Email`,'@')),' ',1),'.'))) >= 2 + 
AND + 
(SLOC(STRIM(LJS(`Email`,40)),'@')) > 2

This particular rule checks three things:

1. Are there at least 2 characters before an "@" character? This is done with the 

(SLOC(STRIM(LJS(`Email`,40)),'@')) > 2 
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part of the rule.

2. Is there a "." after the "@", and is there at least one character between the "@" and the "."? This is
done with the 

(SLOC(SMOVE(`Email`,(SLOC(`Email`,'@')+1),SLEN(`Email`)-(SLOC
(`Email`,'@')),' ',1),'.')) > 1 

part of the rule.

3. Are there at least 2 characters after the "." which follows the "@" character? This would allow
something like x@x.ca but not x@x.c. This is done with the 

((SLEN(SMOVE(`Email`,(SLOC(`Email`,'@')+1),(SLEN(`Email`)-SLOC
(`Email`,'@')),' ',1)))- + 
(SLOC(SMOVE(`Email`,(SLOC(`Email`,'@')+1),(SLEN(`Email`)-SLOC
(`Email`,'@')),' ',1),'.'))) >= 2 

part of the rule.

Have fun implementing this cool code in your R:BASE applications!

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.4.30623 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.18.30623 or higher)
· R:BASE eXtreme 9.0 (Build: 9.0.1.10701 and higher)
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6 Data Browser

6.1 Accessing Note/BLOB Field Viewer/Editor Using Right-Click

Did you know that while BROWSing or EDITing a table with NOTE, VARCHAR or VARBIT columns, you
can access the Note/BLOB Field Viewer/Editor, using the right-click?

Here's how:

CONNECT RRBYW14 
BROWSE * FROM Contact

Tab over to the ContInfo (NOTE), or ContPhoto (VARBIT) column. Right-Click on the cell and notice the
new "Open" option on the speed menu. Selecting the "Open" option will open the NOTE, VARCHAR or
VARBIT column in appropriate sections of the Note/BLOB Field Viewer/Editor.

Supported Versions:
· R:BASE 7.6 (Build 7.6.3.30314 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.3.30314 or higher) for Windows 
· R:BASE Turbo (Build 8.0.16.30314 or higher) for Windows

6.2 Adding Zebra Stripes to the Data Browser

Did you know that you can add zebra stripes to your Data Browser allowing you to read and understand
your table records easily?

Here's how:

1. Launch R:BASE
2. Connect to a database
3. Open any table to view the records
4. From the Main Menu Bar, select "Layout" > "Draw Zebra Stripe"

You will immediately see the striped color for odd and even records.

Don't like the colors? If you would like to customize the zebra stripe colors, you can. 

To alter the "odd" record color:

From the Main Menu Bar, select "Settings" > "Data Browser" "Set Odd Color"

To alter the "even" record color:

From the Main Menu Bar, select "Settings" > "Data Browser" "Set Even Color"

6.3 Conditionally Managing Data Browser/Editor Options

Traditionally, among many options, the Data Browser/Editor "Edit" list includes:

· Edit Mode [F4] (Switch Between Browse/Edit Mode)
· Print Data
· Export Results to
· Save Result As (Table, Temporary Table, View, Temporary View)

However, there may be circumstances when you may not want to provide these options to any or all
users.

Did you know that you can conditionally manage these options which may include enabling/disabling
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these choices based upon the logged in user?

Here's how:

IF (CVAL('DATABASE')) <> 'RRBYW17' OR (CVAL('DATABASE')) IS NULL THEN
   CONNECT RRBYW17 IDENTIFIED BY NONE
ENDIF

-- Example 01 (Typical Options)
   CLS
   BROWSE Company,CustAddress,CustCity,CustState,CustZip,CustPhone +
   FROM Customer ORDER BY Company +
   OPTION CAPTION Customer Data|WINDOW_STATE NORMAL
   RETURN

-- Example 02 (NOCHG)
-- Disable [F4] key to switch between Browse/Edit Mode
   CLS
   BROWSE Company,CustAddress,CustCity,CustState,CustZip,CustPhone +
   FROM Customer ORDER BY Company NOCHG +
   OPTION CAPTION Customer Data|WINDOW_STATE NORMAL
   RETURN

-- Example 03 (READONLY ON)
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-- Makes the entire data set READONLY.
   CLS
   BROWSE Company,CustAddress,CustCity,CustState,CustZip,CustPhone +
   FROM Customer ORDER BY Company +
   OPTION CAPTION Customer Data|WINDOW_STATE NORMAL|READONLY ON
   RETURN

-- Example 04 (PRINTDATA OFF)
-- Disable Print Data Option
   CLS
   BROWSE Company,CustAddress,CustCity,CustState,CustZip,CustPhone +
   FROM Customer ORDER BY Company +
   OPTION CAPTION Customer Data|WINDOW_STATE NORMAL|PRINTDATA OFF
   RETURN
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-- Example 05 (EXPORTRESULT OFF)
-- Disable Export Result To Option
   CLS
   BROWSE Company,CustAddress,CustCity,CustState,CustZip,CustPhone +
   FROM Customer ORDER BY Company +
   OPTION CAPTION Customer Data|WINDOW_STATE NORMAL|EXPORTRESULT OFF
   RETURN
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-- Example 06 (SAVERESULT OFF)
-- Disable Save Result As Option
   CLS
   BROWSE Company,CustAddress,CustCity,CustState,CustZip,CustPhone +
   FROM Customer ORDER BY Company +
   OPTION CAPTION Customer Data|WINDOW_STATE NORMAL|SAVERESULT OFF
   RETURN
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-- Example 07 (Conditionally Disable Options)
-- (NOCHG,READONLY ON,PRINTDATA OFF,EXPORTRESULT OFF,SAVERESULT OFF)
   CLS
   SET VAR vOptions TEXT = NULL
   IF (CVAL('NetUser')) IN (JohnDoe,JaneDoe,MikeSmith,LLooser) THEN
      SET VAR vOptions = +
      ('CAPTION Customer Data|WINDOW_STATE NORMAL|READONLY ON' + +
       '|PRINTDATA OFF|EXPORTRESULT OFF|SAVERESULT OFF')
   ELSE
      SET VAR vOptions = ('CAPTION Customer Data|WINDOW_STATE NORMAL')
   ENDIF
   BROWSE Company,CustAddress,CustCity,CustState,CustZip,CustPhone +
   FROM Customer ORDER BY Company NOCHG +
   OPTION &vOptions
   CLEAR VARIABLES vOptions
   RETURN



"Tip of the Day" Digest75

Copyright © 1982-2012 R:BASE Technologies, Inc.

Have fun implementing these options in your R:BASE applications!

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10414 or higher)

6.4 Right-Click Calculate (Compute, Tally, Duplicates)

Did you know that while in the Data Browser/Editor, using the right-click on selected column will bring up
a new speed menu option to calculate the following three options?

Calculate >
. Compute... 
. Tally... 
. Duplicates..

Using the right-click on selected column, and selecting the Calculate option, now you can instantly
Compute (Count, Rows, Minimum, Maximum, Sum, Average, Standard Deviation, Variance), Tally, and
most importantly can find the Duplicates without knowing the correct syntax.
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Supported Versions: 
· R:BASE 7.6 for Windows (Build: 7.6.7.30420 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.21.30420 or higher) 
· R:BASE eXtreme 9.0 for Windows (Build: 9.0.1.10420 or higher)

6.5 Turning the Data Browser into a Quick Form

Did you know that you can turn the data browser into a quick form?

You can achieve that by using the "ROWVIEW" option of the BROWSE command.

Here's how:

1. Start R:BASE 
2. CONNECT ConComp
3. Create a command file with the following syntax:

-- DataBrowserAsForm.RMD 
CLS 
BROWSE * FROM Customer + 
ORDER BY Company + 
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NOCHG + 
OPTION WINDOW_STATE MAXIMIZED + 
|CAPTION ConComp Customers + 
|ROWVIEW ON 

RETURN

4. RUN DataBrowserAsForm.RMD

For enhanced database security from users with the same command, you can use disable any output
options.

3. Create a command file with the following syntax:

-- DataBrowsSecure.RMD 
CLS 
BROWSE * FROM Customer + 
ORDER BY Company + 
NOCHG + 
OPTION WINDOW_STATE MAXIMIZED + 
|CAPTION ConComp Customers + 
|ROWVIEW ON +
|EXPORTRESULT OFF +
|SAVERESULT OFF +
|PRINTDATA OFF 

RETURN

4. RUN DataBrowsSecure.RMD

6.6 Using Additional Data Browser/Editor Options

When using the BROWSE/EDIT commands, the following OPTION parameters provide the ability to
customize the Data Browser/Editor Window:

· WINDOW_STATE value (MAXIMIZED, NORMAL, MINIMIZED) 
· CAPTION value 
· LOCK nnn 
· ROWVIEW 
· READONLY value (ON, OFF) 
· MODAL value (ON, OFF) 
· EXPORTRESULT value (ON, OFF) 
· SAVERESULT value (ON, OFF) 
· PRINTDATA value (ON, OFF)

When "BROWSE/EDIT columnlist FROM tableviewname" command includes BLOB (VARCHAR, BITNOTE,
VARBIT) data, typically you will notice a white square box (indication of NOT NULL field) or white square
box with red "X" (indication of NULL or empty field). With the full development version of R:BASE
eXtreme 9.1 installed, you may change the "Layout" settings for Data Browser/Editor to "Show NOTE
Hints" and "Show Image Hints" when mousing over the column cells with BLOB data.

What if you are using a compiled/runtime version of your R:BASE eXtreme 9.1 (32/64) application and
would like to provide these additional options?

Did you know that you can dynamically enable or disable these additional options using the following
parameters in your R:BASE eXtreme 9.1 (32/64) applications?

· ZEBRA_STRIPE value (ON, OFF) - specifies if zebra stripes are displayed
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· CELL_HINTS value (ON, OFF) - specifies if NOTE column cell hints are displayed
· IMAGE_HINT value (ON, OFF) - specifies if image hints are displayed

-- Example 01 (Display Zebra Stripes) 
CONNECT RRBYW17 
BROWSE * FROM Contact OPTION ZEBRA_STRIPE ON

-- Example 02 (Display Cell Hints) 
CONNECT RRBYW17 
BROWSE * FROM Contact OPTION CELL_HINTS ON

-- Example 03 (Display Image Hints) 
CONNECT RRBYW17 
BROWSE * FROM Contact OPTION IMAGE_HINT ON

-- Example 04 (Display Zebra Stripes, Cell Hints, Image Hints) 
CONNECT RRBYW17 
BROWSE * FROM Contact + 
OPTION ZEBRA_STRIPE ON|CELL_HINTS ON|IMAGE_HINT ON

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10428 or higher)
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7 Stored Procedures

7.1 Controlling the Maximum Length of the RETURN Variable

The returned value is stored in the STP_RETURN system variable. The RETURN varname option is used
ONLY within a Stored Procedure to return a value. This option will return an -ERROR- when used outside
a Stored Procedure. The default is TEXT 8 characters, but if you want more, you can set it to a larger
value. 

You can control the maximum length at procedure definition time, or by editing the SYS_PROC_LEN
column in SYS_PROC_COLS system table.

Example 01:

PUT MyTest.PRC AS MyTest P1 INTEGER RETURN TEXT (30) 

This will set the limit for the RETURN value at 30 characters.

7.2 Order of Processing for Stored Procedures and Triggers

A trigger automatically runs a stored procedure when an UPDATE, DELETE, or INSERT command is run
with a table.

The following describes the sequence in which data integrity is maintained when using Stored Procedures
and Triggers:

DELETE 

· Rules 
· Cascades 
· Triggers 
· Keys 
· Row itself

UPDATE 
· Rules 
· Cascades 
· Triggers 
· Keys 
· Row itself

INSERT 
· Rules 
· Triggers 
· Keys 
· Row itself

Triggers automatically run a stored procedure when an UPDATE, DELETE, or INSERT command is run
with a table. The trigger is run before the row that triggered it is updated, inserted, or deleted. 

Since the trigger runs first, it gives you a chance to abort the procedure. 

When indexes are updated it is the last step before completing the update.

The row has valid values, the rules are met, and the triggers did not abort.

The only error out at this point is if the key update fails, such as a PKFK violation. When the key
processing code is done it is a real attempt to update the key, not just a "will it be ok" process. If you do
not want your triggers to run you could modify the trigger to check for PK-FK violations before doing the
rest of the trigger.
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8 Forms

8.1 Accessing/Updating Custom EEPs using Right-Click

Did you know that you can use right-click on a form to directly access the Form Custom EEPs or right-
click on any object/control 
to access object specific Custom EEPs?

While in Form Designer, you can right-click on a blank form area to access form Custom EEPs. While in
Form Designer, you can right-click on any control/object to access control/object specific Custom EEPs.

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.3.30509 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.3.30509 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.17.30509 or higher)

8.2 Action Sequence (Form EEP Execution)

Action Sequence (the order in which the form EEPs are executed)

A typical control's property options within the "EEPs" tab include the following options:

· Predefined Actions 
· Add Row 
· Add Row and Exit 
· Delete Row 
· Discard Row 
· Discard Row and Exit 
· Duplicate Row 
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· Exit 
· Next Row 
· Next Table 
· Previous Row 
· Previous Table 
· Save Row 
· Last Row 
· First Row 
· Save Row and Exit 
· Refresh Current Table 

· Stored Procedure 
· Custom Form Action 
· Custom

This is the actual order in which the form EEPs are executed:

1. Custom Embedded EEP (if defined) 
2. Custom EEP (External File) 
3. Stored Procedure 
4. Custom Form Action 
5. Predefined Actions

8.3 Additional Fields for DB/Variable Email Label Controls

Did you know that you can now use additional fields to specify the CC, BCC, and Message Body fields for
the DB Email Label and Variable Email Label controls?

The Email Label Controls send a message to the user's MAPI mail client. The CC, BCC, and Message
Body fields can be specified within the control properties, or altered on the fly using the PROPERTY
command.

Example:
PROPERTY Comp_ID_CC CC 'joe@newco.com' 
PROPERTY Comp_ID_BCC BCC 'wade@newco.com' 
PROPERTY Comp_ID_MsgBody BODYTEXT 'Thank you for your order!'



Forms 84

Copyright © 1982-2012 R:BASE Technologies, Inc.

The CC, BCC, and Message Body fields for the DB and Variable Email Label controls can now be
specified using the PROPERTY command, and within the control properties!

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.5.11212  or higher)

8.4 Capturing the Value of Form Component IDs

Did you know that you can capture the value of any DB or Variable Edit Control's Component ID, if
defined, while using the form in Enter, Edit or Browse mode?

In addition to all Form System Variables, a new RBTI_FORM_COMPID variable has been added to
capture the value of DB or Variable Edit Component ID, if defined.

Here's a comprehensive list of System Variables used in Forms:

· RBTI_DBGRID_COLUMN 
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· RBTI_DIRTY_FLAG 
· RBTI_FORM_ALIAS 
· RBTI_FORM_COLNAME 
· RBTI_FORM_COLVALUE 
· RBTI_FORM_COMPID 
· RBTI_FORM_DATATYPE 
· RBTI_FORM_DIRTYVAR 
· RBTI_FORM_FORMNAME 
· RBTI_FORM_MODE 
· RBTI_FORM_TBLNAME 
· RBTI_FORM_VARNAME 
· RBTI_FORM_VARVALUE

RBTI_DBGRID_COLUMN 
This variable holds the name of focused Column on DB Grid.

RBTI_DIRTY_FLAG 
Returns 1 if any DB Control value(s) in form were changed or 0 if nothing was changed.

RBTI_FORM_ALIAS 
This variable holds the name of focused form, if used AS alias.

RBTI_FORM_COLNAME 
This variable holds the name of focused column DB Control on form.

RBTI_FORM_COLVALUE 
This variable holds the value of focused column DB Control on form.

RBTI_FORM_COMPID 
This variable holds the value of focused DB/Variable Edit control's Component ID, if defined.

RBTI_FORM_DATATYPE 
This variable holds the data type of focused column DB Control on form.

RBTI_FORM_DIRTYVAR 
Returns 1 if any Variable Control value(s) in form were changed or 0 if nothing was changed.

RBTI_FORM_FORMNAME 
This variable holds the name of the current form. Particularly useful when using the form-in-a-form
technique and multiple forms are running at the same time.

RBTI_FORM_MODE 
This variable holds the value of current mode of the form, such as ENTER, EDIT or BROWSE.

When the form is brought-up as ENTER USING formname ... the value for RBTI_FORM_MODE will be
returned as 'ENTER'.
When the form is brought-up as EDIT USING formname ... the value for RBTI_FORM_MODE will be
returned as 'EDIT'.
When the form is brought-up as BROWSE USING formname ... the value for RBTI_FORM_MODE will
be returned as 'BROWSE'.

RBTI_FORM_TBLNAME 
This variable holds the name of the current table in a form. This is especially useful when used
within a multi-table form.

RBTI_FORM_VARNAME 
This variable holds the name of focused Variable Control on form.

RBTI_FORM_VARVALUE 
This variable holds the value of focused Variable Control on form.
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8.5 Controlling Date/Time Picker Drop-Down

Did you know that you can control the drop-down option of the DB Date/Time Picker or Variable Date/
Time Picker control by simply using the following PROPERTY command?

PROPERTY <DateTimePickerCompID> OPEN 'TRUE' 
RETURN

That will open the DB/Variable Date/Time Picker drop-down calendar, on demand.

8.6 Controlling TABLE Add/Delete Row Properties

Did you know that you can control the "Add" or "Delete" Rows options of Table Settings within a Form
using the following PROPERTY command parameters?

· ENABLE_ADD_NEW_ROWS 

· DISABLE_ADD_NEW_ROWS 

· ENABLE_DELETE_ROWS 

· DISABLE_DELETE_ROWS

Examples:

-- To enable the option for "Add New Rows to the Table":

PROPERTY TABLE tablename ENABLE_ADD_NEW_ROWS 
RETURN

-- To disable the option for "Add New Rows to the Table":

PROPERTY TABLE tablename DISABLE_ADD_NEW_ROWS 
RETURN

-- To enable the option for "Delete Rows":

PROPERTY TABLE tablename ENABLE_DELETE_ROWS 
RETURN

-- To disable the option for "Delete Rows":

PROPERTY TABLE tablename DISABLE_DELETE_ROWS 
RETURN

8.7 Copy and Paste Custom Form Actions

Did you know that you can copy a Custom Form Action from a form, and paste it into another form?

Buttons for "Copy" and "Paste" have been added to the Action Designer for the Forms and External Form
File modules, to allow users to copy and paste selected, or all, Custom Form Actions.

Please note the "Copy" and "Paste" buttons are located next to the "Up" and "Down" arrow buttons,
which reorder the location of a Custom Form Action.

In addition, you may also use [Ctrl+C] to copy selected action(s) and [Ctrl+V] to paste.

Custom Form Action can now be easily moved from one form to another!

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.5.11212  or higher)
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8.8 Copy and Paste Expression Builder Variables_2

Did you know that you can copy a form variable from the Expression Builder, and paste it into another
form?

Buttons for "Copy" and "Paste" have been added to the Expression Builders for the Form, Report, and
Label modules, to allow users to copy and paste selected, or all, variables.

Please note the "Copy" and "Paste" buttons are located next to the "Up" and "Down" arrow buttons,
which reorder the location of a variable in the Expression Builder.

In addition, you may also use [Ctrl+C] to copy selected expression(s) and [Ctrl+V] to paste expression
(s) while placing the cursor over the expression builder window.

Variables and Expressions can now be easily moved from form to form, label to label, and report to
report!

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.5.11111  or higher)
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8.9 Copy and Paste Menu Bar Items

Did you know that you can copy a Menu Bar Item from a form, and paste it into another form?

Buttons for "Copy" and "Paste" have been added to the Menu Bar Designer for the Forms and External
Form File modules, to allow users to copy and paste selected, or all, items.

In addition, you may also use [Ctrl+C] to copy selected item(s) and [Ctrl+V] to paste.

Menu Bar Items can now be easily moved from one form to another!

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.5.11111  or higher)

8.10 Copy and Paste Tree View Nodes

Did you know that you can copy and paste nodes within the Tree View control?

Buttons for "Copy" and "Paste" have been added to the Tree View control to allow users to copy and
paste nodes.
When a node is copied, all sub-items are copied with the main node. 

Nodes can also be copied from one form to another.

In addition, you may also use [Ctrl+C] to copy the selected node and [Ctrl+V] to paste.

Tree View Nodes can now be easily moved into the same Tree View, or into another form!

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.5.11111  or higher)

8.11 Copying and Pasting Windows Clipboard Data in Forms

Did you know that you can copy and paste any image or text to and from the Windows Clipboard to any
designated control on a form using the PROPERTY command?

The following PROPERTY command parameters are now supported:

· CopyToClipboard 

· CutToClipboard 

· PasteFromClipboard

Here's how:

· To copy images or text data TO Windows Clipboard

PROPERTY <ComponentID> CopyToClipboard 'TRUE' 
RETURN

Supported Form Controls:
· DB Edit 
· DB Memo 
· DB Image 
· Variable Edit 
· Variable Memo 
· Variable Image



"Tip of the Day" Digest89

Copyright © 1982-2012 R:BASE Technologies, Inc.

2. To cut images or text data TO Windows Clipboard

PROPERTY <ComponentID> CutToClipboard 'TRUE' 
RETURN

Supported Form Controls:
· DB Edit 
· DB Memo 
· DB Image 
· Variable Edit 
· Variable Memo 
· Variable Image

3. To paste images or text data FROM Windows Clipboard

-- Example 01 

-- To paste Windows Clipboard BLOB Data into DB/VAR Image Field
PROPERTY <BLOBControlComponentID> PasteFromClipboard 'TRUE' 
RETURN

-- Example 02 

-- To paste Windows Clipboard Text Data into DB/VAR Edit/Memo Field
PROPERTY <EditMemoControlComponentID> PasteFromClipboard 'TRUE' 
RETURN

-- Example 03 

-- To paste Windows Clipboard BLOB Data into focused DB/VAR Image Field
PROPERTY RBASE_FORM PasteFromClipboard 'TRUE' 
RETURN

-- Example 04 

-- To paste Windows Clipboard Text Data into focused DB/VAR Edit/Memo

Field
PROPERTY RBASE_FORM PasteFromClipboard 'TRUE' 
RETURN

Supported Versions: 
· R:BASE 7.6 (Build 7.6.2.31224 or higher) for Windows 
· R:BASE (C/S:I) 7.6 (Build 7.6.2.31224 or higher) for Windows 
· R:BASE Turbo (Build 7.6.2.31224 or higher) for Windows

8.12 Creating a Dynamic TreeView Object

Did you know that you can create a dynamic TreeView object in forms using the CREATEOBJECT
command?

Syntax:

CREATEOBJECT <FormObjectName> 'ComponentID' 'Parent' T L W H

Here's an example to create a dynamic TreeView object with Node Items and Sub-Items.

-- Start here 
-- Create TreeView Object 

CREATEOBJECT TreeView 'TreeView' 'RBASE_FORM' 5 10 186 441 
PROPERTY TreeView INIT 'TRUE' 
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-- Add Nodes (Items and Sub-Items) 
-- Create First Item 

CREATEOBJECT TREENODE Node1 TreeView 0 0 0 0 
PROPERTY Node1 TEXT 'Node 1' 
PROPERTY Node1 INIT 'TRUE' 

-- Add Sub-Item to First Item 

CREATEOBJECT TREENODE Node11 TreeView|Node1 0 0 0 0 
PROPERTY Node11 TEXT 'Node 1 - 1' 
PROPERTY Node11 INIT 'TRUE' 

-- Create Second Item 

CREATEOBJECT TREENODE Node2 TreeView 0 0 0 0 
PROPERTY Node2 TEXT 'Node 2' 
PROPERTY Node2 INIT 'TRUE' 

-- Add Sub-Item to Second Item 

CREATEOBJECT TREENODE Node21 TreeView|Node2 0 0 0 0 
PROPERTY Node21 TEXT 'Node 2 - 1' 
PROPERTY Node21 INIT 'TRUE' 
RETURN 
-- End here

--To delete the dynamically created TreeView object

DELETEOBJECT TreeView 
RETURN

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.3.30509 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.3.30509 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.17.30509 or higher)

8.13 Creating a Playlist for Windows Media Player

Did you know that you can create a playlist for the Windows Media Player ActiveX Control and then play
several files in a continuous mode using the PROPERTY command in form?

Here's how:

1. Using RBEdit or any text editor, create a file with ".m3u" extension, such as:

-- PlayList.m3u 
D:\MyStuff\Dave_Brubeck_Take5.mp3 
D:\MyStuff\Shine on You Crazy Diamond.mp3 
D:\MyStuff\Pink_Floyd_Live_At_Pompeii.mpg 
D:\MyStuff\Live 8 Performance - Pink Floyd.mpg 
D:\MyStuff\R:BASE 7.6 for Windows 101.avi 
D:\MyStuff\R:BASE 7.6 for Windows Step-by-Step.avi

Notice that you can mix and match all sorts of formats supported by Windows Media Player.

2. Save the file as PlayList.m3u
3. Download the sample application posted on 02/14/2006

http://www.razzak.com/fte 

http://www.razzak.com/sampleapplications

http://www.razzak.com/fte
http://www.razzak.com/sampleapplications
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"Integrating Windows Media Player ActiveX Control in Forms"

4. Use the following PROPERTY command to dynamically load the playlist.

PROPERTY MediaPlayer 'CALL_PROCEDURE CLOSE' '' 
PROPERTY MediaPlayer 'URL' PlayList.m3u

5. You may also modify the "Load File" routine in sample application to manually load a playlist as
follows:

-- Load File routine for Windows Media Player ActiveX 
CLEAR VAR vFileName 
SET VAR vFileName TEXT = NULL 
PLUGINS LoadFileName.RBL vFileName + 
|FULLPATH ON + 
|TITLE Select File + 
|NO_LONG_NAMES OFF + 
|FILTER + 
AVI Files(*.AVI)#*.AVI# + 
PLAY List Files(*.M3U)#*.M3U# + 
MP3 Files(*.MP3)#*.MP3# + 
MPEG Files(*.MPG)#*.MPG# + 
WMV Files(*.WMV)#*.WMV# + 
All Files(*.*)#*.* + 
|INITIAL_DIR C:\ 

IF (vFileName = NULL) OR (vFileName = '[Esc]') THEN 
RETURN 

ENDIF 
PROPERTY MediaPlayer 'CALL_PROCEDURE CLOSE' '' 
PROPERTY MediaPlayer 'URL' .vFileName 
RETURN

8.14 Customizing DB Grid Column Properties

By default, placing the DB Grid control on the form and assigning the appropriate table will use each
column to be included in the DB Grid when displayed. However, if you wish to include only a selected
column, you'll have to use the [Columns] option of the DB Grid Properties.

Once you select specific columns for DB Grid in selected columns panel, you can individually customize
each column property by highlighting the column and then clicking on the "gear" icon. Using this option,
you may customize the following Column Properties:

· General (Column/Title Properties) 
· Pre-Defined Values 
· Expression

You'll have to go through each column, one at a time, to customize individual column properties. 

However, did you know that you can select more than one column (using Shift+Click, Click+Ctrl+Click,
or Ctrl+Click), and then use the Right-Click to change the following column properties all at once?

Using that approach, you can customize the following column properties:

· Title Properties (Alignment, Color, Font) 
· Column Properties (Alignment, Color, Font) 
· Set Read Only ON 
· Set Read Only OFF
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For samples of customized DB Grid Columns, take a look at the following forms included with RRBYW10.

· DBGridListBox 
· DBGridLookupList 
· DBGridProperties 
· DBGridWithPickList 
· SalesTransactions

Summary:

Highlighting all columns and then clicking on the "gear" icon will only modify the properties of "Last"
column. However, if you wish to modify the properties of all selected columns, you'll need to use the
right-click and then select the appropriate property from the speed 
menu.

8.15 Customizing Filter Options for the Enhanced DB Grid Control

When using the Enhanced DB Grid Control and selecting the option to "Show Filter Bar", the filter type
default is always set to "CONTAINS".

Did you know that you can customize the filter option to use additional conditions such as "LIKE" or
"EQUAL"? Here's how:

Form Designer > Enhanced DB Grid Control > Properties > Enhanced Options ...
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Supported Versions: 
· R:BASE eXtreme 9.0 (Build: 9.0.1.131028 or higher)

8.16 Customizing Form Caption Button Colors

Using the latest updates of R:BASE 7.6 and Turbo V-8, you can customize the Form Caption Button
Colors.

1. Launch the Form Designer 
2. Open the Form Properties with the hot key [F11] 
3. Within Form Properties, choose the "Caption Buttons" tab
4. Add [+] a new caption button or Change existing caption button

Take notice of the following caption button properties:

Caption: 
Hint: 
Width: 
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Background Color: 
Font Color: 
Component ID: 
EEPs:

Ultimately, using the PROPERTY command, you may modify these options as you wish.

Examples:

PROPERTY CaptionButtonComponnetID CAPTION 'test value' 
PROPERTY CaptionButtonComponnetID HINT 'text value' 
PROPERTY CaptionButtonComponnetID WIDTH nnn 
PROPERTY CaptionButtonComponnetID COLOR 'color value' 
PROPERTY CaptionButtonComponnetID FONT_COLOR 'color value'

Supported Versions: 
· R:BASE 7.6 for Windows (Build: 7.6.1.30806 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.1.30806 or higher) 
· R:BASE Turbo V-8 (Build: 8.0.15.30806 or higher)

8.17 Defining a Conditional Background Color of Row in a DB Grid

Did you know that you can conditionally define the background color of a row in a DBGrid? Each
individual row can have its own defined color.

R:BASE now includes an option of defining DBGrid Row Background color based on a color value
specified in a column.

Here's how:

1. Start R:BASE
2. Launch the Form Designer > choose DB Grid Control > Object Properties ...
3. Under DB Grid Properties > choose Effects ...
4. Select Row Background Color Field 
5. Select the column name with color value defined in a table associated with DB Grid

A sample application is also included on "RBG76 SAT CD" to demonstrate the use of such feature and
more ...

8.18 Defining Custom EEPs for "On Roll Up" and "On Roll Down"

R:BASE eXtreme 9.0 (32 and 64) include a cool option of Collapsible Roll-up forms, a form that will
reduce its height to nothing but the title bar when clicked.

To enable the roll up option from within the Form Designer:

1. Open a form's "Form Properties"
2. Select the "Dynamic Caption" tab 
3. Enable the "Roll Up Button" check box

By checking this option, you may create a roll-down and roll-up effect for a form when a user right-clicks
its title bar button.

In addition, now you can define a Form Custom EEP "On Roll Up" and "On Roll Down" to control anything
you can imagine.

Form Designer | Form Properties | EEPs ...

Notice the two additional EEP options for:
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· On Roll Up 
· On Roll Down

Supported Versions: 
· R:BASE eXtreme 9.0 (Builds: 9.0.1.131028 or higher)

8.19 Defining Hint Expressions for DB Grid Columns

Did you know that you can define a descriptive hint based on an expression for a column(s) used in DB
Grid? 

Let's say you have a DB Grid for the InvoiceHeader table with the following columns: 

Now, if you would like to display a hint with the actual Customer Name or Employee Name when mousing
over the CustID or EmpID columns, you can customize these columns using the new "Hint Expression"
feature in the DB Grid Column Properties.

1. Launch the Form Designer and and open the Properties window for a new or existing DB Grid
Control

2. Select the "Columns" tab, Select the Column "CustID" and choose the "Column Properties" button
3. From the "Column Properties" window, select the "Hint Expressions" tab

While defining the expression for selected column, you can also customize the Hint Font and the Hint
Background Color, if you wish. 
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Save the form and use the form preview option to see the results.

Notice the Company Name displayed as a hint for the second Customer with CustID 127: 
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Notice the Employee Name displayed as a hint for the second Employee with EmpID 102: 
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Supported Versions:
R:BASE 7.6 for Windows (Build 7.6.2.31130 or higher ...) 
R:BASE 7.6 (C/S:I) for Windows (Build 7.6.2.31130 or higher) 
R:BASE Turbo V-8 for Windows (Build 8.0.16.1130 or higher)

8.20 Defining TEMPORARY TABLES/VIEWS with Actions

Did you know that now you can define all Form, Label or Report related TEMPORARY TABLES/VIEWS in
"On Before Design Action..."?

The latest R:BASE supports the option to define Form, Label or Report Master and Slave tables or views
based on TEMPORARY tables or view before the form, label or report is brought up in the designer.

This enhancement will eliminate the most common mistake when opening the form, label or report based
on temporary table/view, if not pre-defined at the R> prompt or in a startup command file. 

For example, if you open the "SalesOrder" form in RRBYW10 with pre-defining the required temporary
tables (tInvoiceHeader and tInvoiceDetail), you'll notice the "-ERROR- Table tInvoiceHeader Does Not
Exist!" and you are not able to open the form until you RUN TempTables.RMD to define all temporary
tables/views required for forms/labels/reports.

Well, now all you have to do is include the following block of code in SalesOrder form as "On Before
Design Action...".

Here's how:

Form Designer | Layout | On Before Design Action...

SET ERROR MESSAGE 2038 OFF 
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DROP TABLE tInvoiceHeader 
CREATE TEMPORARY TABLE `tInvoiceHeader` + 
(`TransID` INTEGER, + 
`CustID` INTEGER, + 
`EmpID` INTEGER, + 
`TransDate` DATE, + 
`BillToCompany` TEXT (40), + 
`BillToAddress` TEXT (30), + 
`BillToCity` TEXT (20), + 
`BillToState` TEXT (2), + 
`BillToZip` TEXT (10), + 
`ShipToCompany` TEXT (40), + 
`ShipToAddress` TEXT (30), + 
`ShipToCity` TEXT (20), + 
`ShipToState` TEXT (2), + 
`ShipToZip` TEXT (10), + 
`NetAmount` CURRENCY, + 
`Freight`= ( netamount* .01) CURRENCY, + 
`Tax`= ( netamount* .081) CURRENCY, + 
`InvoiceTotal`= (NetAmount+Freight+Tax) CURRENCY) 

COMMENT ON TABLE tInvoiceHeader IS 'Invoice Header Information' 
DROP TABLE tInvoiceDetail 
CREATE TEMPORARY TABLE `tInvoiceDetail` + 
(`TransID` INTEGER, + 
`DetailNum` INTEGER, + 
`Model` TEXT (6), + 
`Units` INTEGER, + 
`Price` CURRENCY, + 
`Discount` REAL, + 
`SalePrice`= (Price-(Price*Discount/100)) CURRENCY, + 
`ExtPrice`= (Units* SalePrice) CURRENCY) 

COMMENT ON TABLE tInvoiceDetail IS 'Invoice Detail Information' 
SET ERROR MESSAGE 2038 ON 
RETURN 

Save the form and close the form designer.

If you disconnect the database (when all temporary tables/view are automatically dropped), you'll never
have to worry about opening that form in the form designer next time. The required TEMPORARY tables
will automatically be defined before opening the form in form designer.

These features also allow your forms, labels and reports to be totally portable modules for your ever-
changing applications.

8.21 Defining the Number of Items in Pop-up Menus

Did you know that you can define more than 18 items/lines to be displayed for Pop-up Menus used in DB
Edit or Variable Edit Controls?

Using the latest versions/updates, you are no longer limited to 18 items/lines. You may even pick you
own number, if you wish.

Previous versions are restricted to 18 items/lines for Pop-up Menus.

Form Designer > DB Edit Control > Object Property > Pop-up Menus
Form Designer > Variable Edit Control > Object Property > Po-up Menus
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8.22 Designing Custom Pop-up Menus

Did you know that now you can customize all Pop-up Menus for DB Edit and Variable Edit Controls to
look like the ListBox with Show Lines, Title Background Color, Title Font/Color, List Background Color,
and List Font/Color?

To customize the DB Edit and Variable Edit Pop-up Menus:

Form Designer > DB Edit > DB Edit Properties > Pop-up Menus

or

Form Designer > DB Edit > Variable Edit Properties > Pop-up Menus

Notice the following additional options:

· Show Lines (to separate multiple columns for a better look) 
· Title Font and Color 
· List Font and Color 
· Title Background Color 
· List Background Color

Imagine the possibilities!

8.23 Disabling Double Click for DB/VAR Memo Controls

When double clicking on any NOTE or BLOB (VARBIT, VARCHAR) controls in forms, an integrated Note/
BLOB Field Viewer/Editor is used to manage the plain text, formatted text and images stored as BLOBs.

However, for some reason, if you wish to disable the Note/BLOB Field Viewer/Editor when double clicked,
you may use a *new* option of the Object Property or the PROPERTY command to achieve such
objective.

Here's how:

1. Form Designer | DB Memo Control or Variable Memo Control Object Properties | Properties

Notice the additional option: "[ ] Disable Double Click", where the default is un-checked.
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Checking this option will not launch the Note/BLOB Field Viewer/Editor when using the double click.

2. You may also use the following PROPERTY command to disable the double click for DB/Variable
Memo controls:

PROPERTY <DBVARMemoControlCompID> DISABLEDOUBLECLICK 'TRUE' 
RETURN

Supported Versions: 

· R:BASE 7.6 (Build 7.6.2.31211 or higher) for Windows 
· R:BASE (C/S:I) 7.6 (Build 7.6.2.31211 or higher) for Windows 
· R:BASE Turbo (Build 7.6.2.31211 or higher) for Windows

8.24 Displaying the Current Table/Field on the Status Bar

Did you know that you can display the Current Table and Current Field on the form Status Bar?

After placing the Status Bar control, you may add one of the following Status Bar Panes, including
"Current Table" and "Current Field":

· Clock Status 
· Key Status 
· Simple Status 
· Glyph Status 
· Marquee Status 
· Table State Status 
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· DB Field Status 
· Current Table 
· Current Field

Supported Versions:
· R:BASE 7.6 (Build 7.6.3.30404 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.3.30404 or higher) for Windows 
· R:BASE Turbo (Build 8.0.17.30404 or higher) for Windows

8.25 Disabling the Sort Feature for DB Grid Columns

Did you know that you can disable the column sort option used in DB Grid?

When a DB Grid control is placed on a form, by default, every column includes the ability to sort (Asc/
Des) when clicking on the column title; displaying the current sort state. However, there may be
application instances, where you may not want your users to change the default sort state.

A new option [ ] Title Clickable has been added for customizing the individual column properties for DB
Grids. The default is set to checked, i.e, Title Clickable.

A new PROPERTY command is also introduced to manage the column title properties:

Syntax:

PROPERTY <DBGRIDComponentID> Columns[n]-> ClickableTitle 'value'

Example:
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PROPERTY DBGRID Columns[0]-> ClickableTitle 'FALSE'

This property command will disable the sort feature for the first DB Grid column.

Supported Versions:
· R:BASE 7.6 for Windows (Build 7.6.2.31130 or higher ...) 
· R:BASE 7.6 (C/S:I) for Windows (Build 7.6.2.31130 or higher) 
· R:BASE Turbo V-8 for Windows (Build 8.0.16.1130 or higher)

8.26 Displaying the Record Number in a DB Grid

Did you know that you can display the record number in DB Grid?

Here's how:

1. Form Designer > DB Grid Control > Properties > Option
2. [x] Check the option for "Show Record Number" and select the "OK" button
3. Save and close the Form Designer
4. Database Explorer > Select Form > Run Form

The left column will display the actual record number for the table/view.

Here's a visual presentation of such feature in R:BASE:



Forms 104

Copyright © 1982-2012 R:BASE Technologies, Inc.

8.27 Documenting Form EEPs

Did you know that while in Form Designer, you can document all Embedded Custom EPPs (if defined), as
well as External EEPs (if referenced)?

In addition to documenting Custom EEPs (if defined), now you may also document all External EEPs (if
referenced). This will help documenting all references related to Form External EEPs when converting
legacy database/application to R:BASE 7.6 or Turbo V-8 for Windows.

Here's how:

While in Form Designer, select "Form" > "Document EEPs" from the main Menu Bar.

Four output options are available:

· Printer 
· Text File ... 
· PDF File ... 
· Clipboard

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.4.30611 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.4.30611 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.18.30611 or higher)

8.28 Drawing DB Grid Column Titles with Gradient

Did you know that now you can draw DB Grid Column Titles with Gradient?

Here's a visual presentation of drawing DB Grid Column Titles with Gradient:
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Typical DB Grid
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Drawing DB Grid Column Titles with Gradient 
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DB Grid Properties

Programmatically, you may use the PROPERTY command to draw gradient and change the font colors for
the DB Grid Column Titles on demand, as follows:

Example 01:

PROPERTY DBGridCompID DrawGradient 'TRUE' 
PROPERTY DBGridCompID GradientStartColor 'SILVER' 
PROPERTY DBGridCompID GradientEndColor 'GRAY' 
RETURN

Example 02:

PROPERTY DBGridCompID DrawGradient 'TRUE' 
PROPERTY DBGridCompID GradientStartColor 'MAROON' 
PROPERTY DBGridCompID GradientEndColor 'RED' 
PROPERTY DBGridCompID Titles[%]->FONT_COLOR 'WHITE' 
RETURN
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8.29 Dynamically Changing Band List Properties

Did you know that you can dynamically change the properties of Enhanced DB Grid Band List(s),
including the CAPTION and FONT.

Now you may use the following GETPROPERTY/PROPERTY commands:

-- To Obtain Band Count in Enhanced DB Grid 

GETPROPERTY ComponentID BANDS->COUNT vValue

-- To obtain Current Caption for a Given Band in Enhanced DB Grid 

GETPROPERTY ComponentID BANDS[n]->CAPTION vValue

-- To Dynamically Change Caption for a Given Band in Enhanced DB Grid 

PROPERTY ComponentID BANDS[n]->CAPTION value

-- To Dynamically Change Font Name for Band(s) in Enhanced DB Grid 

PROPERTY ComponentID BANDS->FONT_NAME value

-- To Change Font Color for Band(s) in Enhanced DB Grid 

PROPERTY ComponentID BANDS->FONT_COLOR Value

-- To Dynamically Change Font Size for Band(s) in Enhanced DB Grid 

PROPERTY ComponentID BANDS->FONT_SIZE value

-- To Dynamically Change Font Height for Band(s) in Enhanced DB Grid 

PROPERTY ComponentID BANDS->FONT_HEIGHT value

-- To Dynamically Change Font Bold Style for Band(s) in Enhanced DB Grid 

PROPERTY ComponentID BANDS->FONT_BOLD value 
Values TRUE/FALSE

-- To Dynamically Change Font Italic Style for Band(s) in Enhanced DB Grid 

PROPERTY ComponentID BANDS->FONT_ITALIC value 
Values TRUE/FALSE

-- To Dynamically Change Font Strikeout Style for Band(s) in Enhanced DB Grid 

PROPERTY ComponentID BANDS->FONT_STRIKEOUT value 
Values TRUE/FALSE

-- To Dynamically Change Font Underline Style for Band(s) in Enhanced DB Grid 

PROPERTY ComponentID BANDS->FONT_UNDERLINE value 
Values TRUE/FALSE

-- Example 01 
-- Database: RRBYW17 
-- Form Name: RBG91_EnhancDBGrd_BandList_Properties 
-- Control: Enhanced DB Grid 
-- Related Tables: Customers, InvoiceHeader 
-- Component ID: DBGrid_Customers, DBGrid_Invoices 
-- Band List Count: 1 
-- Bit Button: [Change Band Properties] 
-- Custom EEP: 

PROPERTY DBGrid_Invoices BANDS[0]->CAPTION 'Selected Customer Invoice
Details' 
PROPERTY DBGrid_Invoices BANDS->FONT_NAME Tahoma 
PROPERTY DBGrid_Invoices BANDS->FONT_COLOR GREEN 
PROPERTY DBGrid_Invoices BANDS->FONT_SIZE 8 
PROPERTY DBGrid_Invoices BANDS->FONT_BOLD TRUE 
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RETURN

Enhanced DB Grid Band List Before:

Enhanced DB Grid Band List After: 
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Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10417 or higher)

8.30 Dynamically Passing DB Grid Filter Parameters

In addition to many New and Enhanced Controls and Properties in R:BASE eXtreme 9.1, Enhanced DB
Grid in Form Designer includes the option to "Show Filter Bar".

Enabling this option will display a filter bar directly under the titles which allows end-user to enter value
to limit the displayed grid records based on matching criteria. You may also pre-define the Filter Pick List
by selecting "Column Values", if you wish.

Did you know that you can dynamically pass filter parameters as "On After Start Custom EEP" or "On
Demand", using the expanded Enhanced DB Grid Filter PROPERTY commands?

Here is a comprehensive list of supported PROPERTY/GETPROPERTY commands that are specific to
Enhanced DB Grid Filter Bar.

-- Passing Filter Value for a Given Column Number 
-- Syntax 
PROPERTY CompID FILTERS[NNN]->VALUE filter_value 
-- Example 
PROPERTY EDBGridCust FILTERS[2]->VALUE 'CA'

-- Passing Filter Value for Given Column Name 
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-- Syntax 
PROPERTY CompID FILTERS->COLUMN_NAME->ColName filter_value 
-- Example 
PROPERTY EDBGridCust FILTERS->COLUMN_NAME->CustState 'CA'

-- Capturing Filter Value for Given Column Number 
-- Syntax 
GETPROPERTY CompID FILTERS[NNN]->VALUE VarName 
-- Example: 
GETPROPERTY EDBGridCust FILTERS[2]->VALUE vStateFilter

-- Capturing Filter Value for Given Column Name 
-- Syntax 
GETPROPERTY CompID FILTERS->COLUMN_NAME->ColName VarName 
-- Example 
GETPROPERTY EDBGridCust FILTERS->COLUMN_NAME->CustState vValue

-- Clearing Filter Value for Given Column Number 
-- Syntax 
PROPERTY CompID FILTERS[NNN]->CLEAR_ITEMS TRUE 
-- Example 
PROPERTY EDBGridCust FILTERS[2]->CLEAR_ITEMS TRUE

-- Clearing Filter Value for Given Column Name 
-- Syntax 
PROPERTY CompID FILTERS->COLUMN_NAME->ColName->CLEAR_ITEMS TRUE 
-- Example 
PROPERTY EDBGridCust FILTERS->COLUMN_NAME->CustState->CLEAR_ITEMS TRUE

-- Dynamically Defining Single Filter Item for a Given Column Number 
-- Syntax 
PROPERTY ComponentID FILTERS[NNN]->ADD_ITEMS Value 
-- Example 
PROPERTY EnhDBGridCust FILTERS[2]->ADD_ITEMS 'MO'

-- Dynamically Defining Single Filter Item for a Given Column Name 
-- Syntax 
PROPERTY CompID FILTERS->COLUMN_NAME->ColName->ADD_ITEM ItemValue 
-- Example 
PROPERTY EDBGridCust FILTERS->COLUMN_NAME->CustState->ADD_ITEMS 'MO'

-- Dynamically Defining Multiple Filter Items for a Given Column Number 
-- Syntax 
PROPERTY CompID FILTERS[NNN]->ADD_ITEMS Value 
-- Example: 
PROPERTY EDBGridCust FILTERS[2]->ADD_ITEMS 'MO|HN|NY|CT'

-- Dynamically Defining Multiple Filter Items for a Given Column Name 
-- Syntax 
PROPERTY CompID FILTERS->COLUMN_NAME->ColName->ADD_ITEMS Value 
-- Example 
PROPERTY EDBGridCust FILTERS->COLUMN_NAME->CustState->ADD_ITEMS 'MO|HN|NY|
CT'
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-- To repopulate the filter from column values for a given column number 
-- Syntax 
PROPERTY CompID FILTERS[NNN]->ADD_COLUMN_VALUES TRUE 
-- Example 
PROPERTY EDBGridCust FILTERS[2]->ADD_COLUMN_VALUES TRUE

-- To repopulate the filter from column values for a given column name 
-- Syntax 
PROPERTY CompID FILTERS->COLUMN_NAME->ColName->ADD_COLUMN_VALUES TRUE 
-- Example 
PROPERTY EDBGridCust FILTERS->COLUMN_NAME->CustState->ADD_COLUMN_VALUES
TRUE

-- To clear all filter values at once 
-- Syntax 
PROPERTY CompID CLEARFILTER TRUE 
-- Example 
PROPERTY EDBGridCust CLEARFILTER TRUE

Have fun implementing these properties in your R:BASE eXtreme 9.1 applications!

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10428 or higher)

8.31 Enabling/Disabling the "Drag and Drop" Feature

Did you know that you can enable or disable the "drag & drop" feature of any form control using the
PROPERTY command?

A new DRAGDROPENABLED parameter has been added to the PROPERTY command to enable or disable
the "drag & drop" feature of any form control, on demand.

Syntax:

PROPERTY <FormControlCompID> DRAGDROPENABLED 'value'
Values: (TRUE/FALSE)

-- Example 01 (To enable Drag and Drop feature):

PROPERTY <FormControlCompID> DRAGDROPENABLED 'TRUE' 
RETURN

-- Example 02 (To disable Drag and Drop feature):

PROPERTY <FormControlCompID> DRAGDROPENABLED 'FALSE' 
RETURN

Supported Versions:
· R:BASE 7.6 (Build 7.6.3.30314 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.3.30314 or higher) for Windows 
· R:BASE Turbo (Build 8.0.16.30314 or higher) for Windows

8.32 Enhanced DB Grid Control - Hot Keys

In addition to all enhanced features of Enhanced DB Grid Control in Forms, you may also use the
following hot keys to extend the 
use of Enhanced DB Grid Control.
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01. Enhanced DB Grid: Use [Ctrl + F3] to Search Records 

02. Enhanced DB Grid: Use [Ctrl + L] to Customize Filters 
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03. Enhanced DB Grid: Use [Ctrl + S] to Show/Hide Grid Columns 
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You may also use the same hot keys to re-arrange columns.

Supported Versions: 
· R:BASE eXtreme 9.0 (Builds: 9.0.1.131028 or higher)

8.33 Enhanced Tab Control EEPs

Did you know that now you can use "On Enter EEP" and "On Exit EEP" for the Enhanced Tab Control
itself?

Now, you may customize the Enhanced Tab Control to execute your custom code when the focus is
switched in or out of the Enhanced 
Tab Control itself. This is in addition to the "On Tab Change EEP" for individual Tab Pages.

Form Designer > Enhanced Tab Control > Object Property > EEPs:

Enhanced Tab Control Properties:

· On Enter EEP 
· On Exit EEP

8.34 Getting the Radio Button Count

Did you know that you can get the count of total number of radio buttons in a RadioGroup using the
GETPROPERTY command?
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Here's how:

GETPROPERTY <RadioGroupCompID> 'BUTTONCOUNT' varname 
SET VAR vButtonCount = (INT(.varname)) 
RETURN

Variable varname will return the text value of a total number of Radio Buttons in DB/Variable
RadioGroup control. 

Variable vButtonCount will return the integer value of button count (varname).

8.35 GROUPINDEX property for Speed Buttons

Did you know that you can group all Speed Buttons to determine how the buttons behave when clicked?

You can use the new PROPERTY command GROUPINDEX parameter  for Speed Buttons to allows all
speed buttons to work together as a group.

Syntax:

PROPERTY <SpeedButtonComponentID> GROUPINDEX nnnn
You will need to set GROUPINDEX to determine how the button behaves when clicked.

-- Example:

PROPERTY <SpeedButtonOFF> GROUPINDEX 1000 
PROPERTY <SpeedButtonON> GROUPINDEX 1000 
PROPERTY <SpeedButtonOFF> DOWN 'TRUE' 
PROPERTY <SpeedButtonON> DOWN 'FALSE'

When GROUPINDEX is 0, the button behaves independently of all other buttons on the form. When the
user clicks such a speed button, the button appears pressed (in its clicked state) and then returns to its
normal up state when the user releases the mouse button.

When GROUPINDEX is greater than 0, the button remains selected (in its down state) when clicked by
the user. When the user clicks a selected button, it returns to the up state, unless Caption is False.
Setting the GROUPINDEX property of a single speed button to a value greater than 0 causes the button
to behave as a two-state button when Caption is True.

Speed buttons with the same GROUPINDEX property value (other than 0), work together as a group.
When the user clicks one of these buttons, it remains selected until the user clicks another speed button
belonging to the same group. Speed buttons used in this way can present mutually exclusive choices to
the user.

The option DOWN specifies whether the button is selected (down) or unselected (up). Set DOWN to
determine whether a speed button is selected. The DOWN property only applies if the GROUPINDEX
property of the button is nonzero.

When GROUPINDEX is greater than 0, set DOWN to TRUE to select a button. When the user clicks on a
button in the unselected (up) state, the button is selected and DOWN is set to TRUE. When the user clicks
on a button in the selected (down) state, if Caption is True, the button becomes unselected and DOWN is
set to FALSE.

At design time, specify which button in a group is the initially selected button by setting the Down
property of the selected 
button to TRUE.

Note: When GROUPINDEX is 0, buttons do not remain in the selected state when clicked.

A sample application to demonstrate the use of new GROUPINDEX property is also available at:

2008 SAT Sample Applications: http://www.rupdates.com/SAT2008/
Folder: \UsingGroupIndexPropertyForSpeedButtons 
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Database: GrpIndex 
Form: GroupIndexProperty 
Command File: UsingGroupIndexPropertyForSpeedButtons.dat

Supported Versions:
· R:BASE 7.6 (Build 7.6.3.30404 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.3.30404 or higher) for Windows 
· R:BASE Turbo (Build 8.0.17.30404 or higher) for Windows

8.36 Listing All Controls with Component IDs

Did you know that you can list all controls with Component IDs, while in a form designer? Here's how:

While in Form Designer, press the [F3] key to launch the Data Dictionary.

Notice the additional tabs...

Now click on the [Form Component IDs] tab

The list will display all Component ID-associated form controls and the control caption (if exists).

While in Form Designer, you may also list "Form Actions", if defined, by clicking on the [Form Actions]
tab of data dictionary.

8.37 Making an Enhanced GroupBox Transparent

When using "Enhanced GroupBox" Control on the form, if you would like the Enhanced GroupBox to
acquire the background color and/or application theme of your form wallpaper, etc., try the following:

1. Start R:BASE 

2. CONNECT dbname

3. Database Explorer > Forms 

· Highlight the form with Enhanced GroupBox 

· Right-Click > choose "Design Form"

4. While in Form Designer:

· Right-Click on Enhanced GroupBox Object placed on the form

· Select Object Property

· [x] Transparent (set to True)

· Click on "Effects" Tab

· Select Border: "Group Style" as "Custom"

· Click on [OK] button to save property.

5. Click on "Run Form" button or use [Ctrl+F9] to Preview

· Close the form
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8.38 Managing Custom Form Actions

Did you know that you can duplicate a Custom Form Action while using the Custom Form "Action
Designer"?

While in the Action Designer, now you can duplicate the selected form action by simply clicking on the
"Duplicate" button or selecting the "Duplicate" option from the right-click speed menu.

You may also re-arrange the list of defined actions by clicking on the "Move Up" or "Move Down" arrow
buttons.

Supported Versions: 
· R:BASE 7.6 (Build 7.6.2.31211 or higher) for Windows 
· R:BASE (C/S:I) 7.6 (Build 7.6.2.31211 or higher) for Windows 
· R:BASE Turbo (Build 7.6.2.31211 or higher) for Windows

8.39 Managing DB Navigator Properties

Did you know that you can manage the DB Navigator Properties in forms using the PROPERTY
command?

Here's how:

1. First, this example creates a DB Navigator dynamically, On Demand!

-- Example 
CREATEOBJECT DBNavigator 'Navigator' 'Panel' 100 90 200 20 
PROPERTY Navigator TblName 'Customer' 
PROPERTY Navigator INIT 'TRUE' 
PROPERTY Navigator ImageStyle 'Razzmatazz' 
PROPERTY Navigator FLAT 'TRUE'
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2. Next, change the DB Navigator Style:

-- Syntax 
PROPERTY <DBNavigatorComponentID> ImageStyle 'value'

-- Example 01: 
PROPERTY DBNavigator ImageStyle 'OLD'

-- Example 02: 
PROPERTY DBNavigator ImageStyle 'Razzmatazz'

3. Then, make any of the default buttons visible/invisible. The default is Visible (TRUE).

-- Syntax 
PROPERTY <DBNavigatorCompID> <ButtonType> 'value'

Button Types: 

· FirstVisible 
· PriorVisible 
· NextVisible 
· LastVisible 
· InsertVisible 
· DeleteVisible 
· EditVisible 
· PostVisible 
· CancelVisible 
· RefreshVisible 
· CloseWindowVisible 

Values: 

· TRUE 
· FALSE

-- Example 01 (To hide insert button): 
PROPERTY DBNavigator InsertVisible 'FALSE'

-- Example 02 (To hide delete button): 
PROPERTY DBNavigator DeleteVisible 'FALSE'

4. Even change the hint for default buttons:

-- Syntax 
PROPERTY <DBNavigatorCompID> <ButtonHint> 'hint text'

Button Hint: 

· FirstHint 
· PriorHint 
· NextHint 
· LastHint 
· InsertHint 
· DeleteHint 
· EditHint 
· PostHint 
· CancelHint 
· RefreshHint 
· CloseWindowHint



Forms 120

Copyright © 1982-2012 R:BASE Technologies, Inc.

-- Example 01 (To change the hint for first button): 
PROPERTY DBNavigator FirstHint 'First Customer'

-- Example 02 (To change the hint for previous button): 
PROPERTY DBNavigator PriorHint 'Previous Customer'

-- Example 03 (To change the hint for next button): 
PROPERTY DBNavigator NextHint 'Next Customer'

-- Example 04 (To change the hint for last button): 
PROPERTY DBNavigator LastHint 'Last Customer'

-- Example 05 (To change the hint for post button): 
PROPERTY DBNavigator PostHint 'Save Changes'

Versions: 
R:BASE 7.6, C/S:I 7.6 and Turbo V-8 for Windows

8.40 Managing Digital Clock Properties

Did you know that you can change the default 24-hour Digital Clock control in forms to display a 12-hour
(AM/PM) clock by 
using the TWELVEHOURCLOCK parameter in the PROPERTY command?

Syntax:

PROPERTY <DigitalClockCompID> TWELVEHOURCLOCK 'value'

The default is set to 'FALSE'.

-- Example 01: To Display 12 Hour (AM/PM) Clock

PROPERTY DigitalClockCompID TWELVEHOURCLOCK 'TRUE'

-- Example 02: To Display 24 Hour Clock

PROPERTY DigitalClockCompID TWELVEHOURCLOCK 'FALSE'

In addition, you may also use the following PROPERTY command enable/disable the display of "Seconds"
in Digital Clock.

Syntax:

PROPERTY <DigitalClockCompID> SHOWSECONDS 'value' 
The default is set to 'TRUE'

-- Example 03: To Disable/Hide the Seconds in Digital Clock

PROPERTY <DigitalClockCompID> SHOWSECONDS 'FALSE'

-- Example 04: To Enable/Show the Seconds in Digital Clock

PROPERTY <DigitalClockCompID> SHOWSECONDS 'TRUE'

Supported Versions:
· R:BASE 7.6 (Build 7.6.3.30404 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.3.30404 or higher) for Windows 
· R:BASE Turbo (Build 8.0.17.30404 or higher) for Windows



"Tip of the Day" Digest121

Copyright © 1982-2012 R:BASE Technologies, Inc.

8.41 Managing RBTI Form Variables

When working on a single form at a time, it is very easy to manage the following RBTI Form Variables:

· RBTI_FORM_FORMNAME (TEXT) 

· RBTI_DIRTY_FLAG (INTEGER) 

· RBTI_FORM_ALIAS (TEXT) 

· RBTI_FORM_MODE (TEXT) 

· RBTI_FORM_DIRTYVAR (INTEGER) 

· RBTI_FORM_TBLNAME (TEXT) 

· RBTI_FORM_COLNAME (TEXT) 

· RBTI_FORM_COLVALUE (TEXT) 

· RBTI_FORM_DATATYPE (TEXT) 

· RBTI_FORM_COMPID (TEXT)

However, if you have a situation where a form is called from within another form, you may have a stack
of forms being displayed on top of each other. RBTI Form Variables defined by the last form will of
course overwrite the results of the previous form.

So, how do you keep track and manage all resulting variables for each form separately?

To manage this particular situation, all you need to do is define form variables with specific form-related
expressions with a unique naming convention.

Here's how:

Assuming you have two forms (FormA and FormB).

1. Define the following expressions for FormA

vFormA_FormName TEXT = (.RBTI_FORM_FORMNAME) 
vFormA_DirtyFlag INTEGER = (.RBTI_DIRTY_FLAG) 
vFormA_Alias TEXT = (.RBTI_FORM_ALIAS) 
vFormA_Mode TEXT = (.RBTI_FORM_MODE) 
vFormA_DirtyVar INTEGER = (.RBTI_FORM_DIRTYVAR) 
vFormA_TblName TEXT = (.RBTI_FORM_TBLNAME) 
vFormA_ColName TEXT = (.RBTI_FORM_COLNAME) 
vFormA_ColValue TEXT = (.RBTI_FORM_COLVALUE) 
vFormA_DataType TEXT = (.RBTI_FORM_DATATYPE) 
vFormA_CompID TEXT = (.RBTI_FORM_COMPID)

2. Define the following expressions for FormB

vFormB_FormName TEXT = (.RBTI_FORM_FORMNAME) 
vFormB_DirtyFlag INTEGER = (.RBTI_DIRTY_FLAG) 
vFormB_Alias TEXT = (.RBTI_FORM_ALIAS) 
vFormB_Mode TEXT = (.RBTI_FORM_MODE) 
vFormB_DirtyVar INTEGER = (.RBTI_FORM_DIRTYVAR) 
vFormB_TblName TEXT = (.RBTI_FORM_TBLNAME) 
vFormB_ColName TEXT = (.RBTI_FORM_COLNAME) 
vFormB_ColValue TEXT = (.RBTI_FORM_COLVALUE) 
vFormB_DataType TEXT = (.RBTI_FORM_DATATYPE) 
vFormB_CompID TEXT = (.RBTI_FORM_COMPID)

Using this technique, all variables will be unique to each individual form, and you can easily track the
status of each variable when working in a multi-form application.
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8.42 Managing Table Properties on Demand

Did you know that you can manage table properties on demand while using the form in ENTER, EDIT or
BROWSE mode?

Imagine a situation where you have one multi-table form, and you wish to manage all related controls
for a specific table, based on certain conditions, such as network user.

Conditionally, depending on the logged in user, you may enable or disable all controls related to any
table without knowing 
the individual Component IDs.

Using the "PROPERTY TABLE tablename DISABLECONTROLS" or "PROPERTY TABLE tablename
ENABLECONTROLS" commands, you may manage the status of any table as deemed necessary.

Use the following PROPERTY commands as "On After Start EEP": 

-- To disable all controls related to given table 

PROPERTY TABLE tablename DISABLECONTROLS 
RETURN

-- To enable all controls related to given table 

PROPERTY TABLE tablename ENABLECONTROLS 
RETURN

Here's a comprehensive list of all supported table properties:

· ENABLE_DELETE_ROWS 
· ENABLE_ADD_NEW_ROWS 
· DISABLE_DELETE_ROWS 
· DISABLE_ADD_NEW_ROWS 
· UPDATE 
· CLOSE 
· DISABLECONTROLS 
· ENABLECONTROLS 
· OPEN 
· EDIT 
· NEXT 
· PRIOR 
· LAST 
· FIRST 
· INSERT 
· APPEND 
· DELETE 
· POST 
· CANCEL 
· REFRESH 
· JUMPTO 
· JUMP 
· SEARCH

8.43 Managing Windows Media Player Properties

Did you know that now you can manage every property of the Windows Media Player ActiveX control
when implemented in R:BASE forms?

Here is a list of new supported PROPERTY command parameters to manage the Windows Media Player
ActiveX control:

Syntax:

PROPERTY <WMPActiveXComponentID> 'WMPProperty' 'value'
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Example 01 (Load File): 

PROPERTY MediaPlayer 'URL' 'D:\Videos\Stockholm Syndrome.avi'

Example 02 (Play): 

PROPERTY MediaPlayer 'CALL_PROCEDURE Controls.Play' ''

Example 03 (Pause): 

PROPERTY MediaPlayer 'CALL_PROCEDURE Controls.Pause' ''

Example 04 (Next): 

PROPERTY MediaPlayer 'CALL_PROCEDURE Controls.Next' ''

Example 05 (Fast Forward): 

PROPERTY MediaPlayer 'CALL_PROCEDURE Controls.FastForward' ''

Example 06 (Fast Previous): 

PROPERTY MediaPlayer 'CALL_PROCEDURE Controls.Previous' ''

Example 07 (Fast Reverse): 

PROPERTY MediaPlayer 'CALL_PROCEDURE Controls.Reverse' ''

Example 08 (Stop): 

PROPERTY MediaPlayer 'CALL_PROCEDURE Controls.Stop' ''

Example 09 (User Interface): 

PROPERTY MediaPlayer uiMode 'NONE' 
PROPERTY MediaPlayer uiMode 'MINI' 
PROPERTY MediaPlayer uiMode 'FULL'

Example 10 (Stretch to Fit TRUE/FALSE): 

PROPERTY MediaPlayer STRETCHTOFIT 'TRUE' 
PROPERTY MediaPlayer STRETCHTOFIT 'FALSE'

Example 11 (Enabled TRUE/FALSE): 

PROPERTY MediaPlayer ENABLED 'TRUE' 
PROPERTY MediaPlayer ENABLED 'FALSE'

Example 12 (Currently Playing File Name) 

GETPROPERTY MediaPlayer URL vURLName
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Supported Versions:
· R:BASE 7.6 for Windows (Build:7.6.5.31125 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build:7.6.5.31125 or higher) 
· R:BASE Turbo V-8 for Windows (Build:8.0.19.31125 or higher) 
· R:BASE eXtreme 9.0 for Windows (Build:9.0.1.31125 or higher)

8.44 Placing Hidden Buttons

A hidden button can be added to you forms to run code, or even allow you as the developer access the
Database Explorer from a application Main Menu.

Reference: Running R:BASE Your Way! (Part 2) 

1. Start R:BASE 

Switch the default directory to: C:\RBTI\RBG(version number)\Samples\Database\RRBYW2

2. Database Explorer > Commands > RRBYW2.DAT > Run 

(to start RRBYW2 application)
OR 
At the R> Prompt, type: RUN RRBYW2.DAT 

From the Main Menu, if you click on the [Exit] the application will be closed (a normal process and works
exactly as designed).

But, if you would like to get back on the Database Explorer click on the "Lower Left" Invisible "Speed
Button" on the form. You'll have to use mouse around to see the invisible button.
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Now click on that speed button. You'll be back at the Database Explorer.

That is another way for application designer or developer to get back on the Database Explorer.

End-User will NOT be able to see the Speed Button with [Flat] properties and no [Caption].

8.45 Selecting All Items in ListBox/ListViewControls

Did you know that you can use the [Ctrl+A] or [Shift+F6] keys to toggle between selecting all items and
unselecting all items in Variable Lookup ListBox or Variable Lookup ListView controls?

Here's how to "Select All Items" in Variable Lookup ListBox and Variable Lookup ListView controls.

1. Start R:BASE.
2. Connect to your database.
3. Open a form with a Variable Lookup ListBox or Variable Lookup ListView Control, in the Form

Designer.
4. Make sure that associated variable data type is capable of accepting multi-select List Source Key

Field items.
5. Make sure to enable the "MultiSelect" option for the Variable Lookup ListBox or ListView Control.
6. Save the form.
7. Run the form.
8. Use [Ctrl+A] or [Shift+F6] to toggle between Select and Un-Select All items.
9. Use [Ctrl+Click] to select multiple items.
10. Use [Shift+Click] to select an highlighted group of items.

You may also use the following PROPERTY commands to dynamically select all items, if you wish:

-- For Variable Lookup ListBox Control 

PROPERTY <VarLookupListBoxCompID> MULTISELECT 'TRUE' 
PROPERTY <VarLookupListBoxCompID> SELECT_ALL 'TRUE' 
RETURN

-- For Variable Lookup ListView Control 

PROPERTY <VarLookupListViewCompID> MULTISELECT 'TRUE' 
PROPERTY <VarLookupListViewCompID> SELECT_ALL 'TRUE' 
RETURN

Support Versions
· R:BASE 7.6 for Windows (Build: 7.6.3.30516 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.3.305016 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.17.30516 or higher)

8.46 Setting the Background Color for Focused Controls

When you design a cool form with so many DB/Variable Edit controls, sometimes the end user simply
cannot figure out where the tiny mouse cursor is locared. In the past we have found a workaround to
change the background color properties for the "On Enter EEP" for each control.

Did you know that you can use the default "Form Settings" for "Edit Objects" to achieve your goal without
customizing each and every edit control on the form?

Here's how:

1. Start R:BASE 7.6 or Turbo V-8 for Windows
2. From the Database Explorer > Main Menu > Settings > Form Designer
3. Within the Default Form Settings > Edit Objects ...



Forms 126

Copyright © 1982-2012 R:BASE Technologies, Inc.

[ ] Background Color When Focused

This is where you'll have to define the color, including the option to define your own custom color, if you
wish.

Using this custom setting will provide the option for any individual to use their favorite color.

You may also customize this setting for individual DB/Variable Edit/Memo controls as follows:

Form Designer > Object Properties > Effects > [ ] Background Color When Focused

Programmatically, you may use the PROPERTY command as "On After Start EEP" to dynamically enforce/
change the background color for any DB/Variable Edit/Memo Controls.

Example:

PROPERTY <ComponentID> HighlightFocus 'TRUE' 
PROPERTY <ComponentID> HighlightFocusColor 'YELLOW' 
RETURN

8.47 Suppressing Script Errors in WEB Browser Controls

When implementing Web Browser, DB Web Browser, or Variable Web Browser controls in forms,
depending on the server URLs, users may encounter script errors or warning messages which force them
to click on an "OK" button to continue and so on. This may create an inconvenience for your R:BASE
custom applications.

Now, you can suppress those warning or script error messages by either checking the additional
property option to "Suppress Script Errors" for Web Browser, DB Web Browser or Variable Web Browser
controls or use the following PROPERTY command:

PROPERTY WebBrowserComponentID SuppressScriptErrors 'TRUE' 
RETURN

8.48 The TreeView Menu in RRBYW3

Did you know that you can design a fully menu-driven application using TreeView Control and you can
either display (VISIBLE TRUE) or hide (VISIBLE FALSE) the entire TreeView control using the PROPERTY
command?

Running R:BASE Your Way! (Part 3) demonstrates the use of such menu driven application.

Based on the user login, you can control the display of assigned Component ID as demonstrated in the
sample database and application.

Startup File: RRBYW3.DAT
Associated Form: TreeViewMenu
Associated EEP: TreeViewMenuAccess

-- TreeViewMenuAccess.EEP 
IF vLogin <> 'RRBYW3' OR vLogin IS NULL THEN 
PROPERTY MM_TreeView_AllOptions VISIBLE FALSE 
PROPERTY MM_Treeview_ReportsLabels VISIBLE TRUE 
ELSE 
PROPERTY MM_TreeView_AllOptions VISIBLE TRUE 
PROPERTY MM_Treeview_ReportsLabels VISIBLE FALSE 
ENDIF 
RETURN
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Here's how:
Take a look at the TreeViewMenu form bundled with Running R:BASE Your Way! (Part 3). There are two
TreeView controls placed on the form.

The First TreeView control with seven nodes, such as Customers, Contacts, Employees, Products, Sales,
Reports and Labels.

The Second TreeView control with only two nodes, i.e., Reports and Labels.

First TreeView Control with all options is assigned a Component ID "MM_TreeView_AllOptions".

Second TreeView control with only two nodes is assigned a Component ID
"MM_TreeView_ReportsLabels".

Second Treeview control is placed on the top of first TreeView control and is "Send to Back" with the
"Align" property of "none". It will always be in the back.

First Treeview control has the "Align" property of "Left" and will ALWAYS be on the top.

Before stating the form, TreeViewMenuLogin.EEP is used as "On Before Start EEP".

After the form starts, TreeViewMenuAccess.EEP is used as "On After Start EEP".

Based on the user login the property of TreeView control with Component ID is changed accordingly.

IF vLogin <> 'RRBYW3' OR vLogin IS NULL THEN 
PROPERTY MM_TreeView_AllOptions VISIBLE FALSE 
PROPERTY MM_Treeview_ReportsLabels VISIBLE TRUE 

ELSE 
PROPERTY MM_TreeView_AllOptions VISIBLE TRUE 
PROPERTY MM_Treeview_ReportsLabels VISIBLE FALSE 

ENDIF

That's all there is to it!

Caution: To understand the entire process make sure to play with a backup copy of the form.

8.49 Understanding Tab Order

Tab Order Priority:

01. Form itself 
02. Panel(s) and Controls within that panel 
03. Individual Controls

When you place any control(s) in a form designer which posses the property of being "Containers" itself,
such as Enhanced Panel, Enhanced Group Box, Scrolling Region and Tab Control, then the tab order of
any placed controls within is related to that container itself.

It is also important to know the order in which the Panel(s) were defined.

So, if you would like to re-order the tab within each container (Enhanced GroupBox in your case), first
you need to select that container and then:

Layout > Change Tab Order will display the objects placed on that container, such as Enhanced
GroupBox.

Also, the form designer remembers the order in which you placed the container and the contents within
that container.

BUT ... using the PROPERTY command, you CAN change the tab order as well as the focus.
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Typical Scenario:
Let's say you have three "Enhanced GroupBox" controls on the form and when the form starts, you
would like the focus to be on the third (3rd) control (DB Edit) on the Middle (2nd) Enhanced GroupBox,
irregardless of the sequence they were placed on the form, etc.

In that case:
1. Assign the Component ID as "Panel2" for the middle Enhanced GroupBox.
2. Assign the Component ID as "Field3" on the third control (DB Edit) placed on the middle (2nd)

Enhanced GroupBox.
3. Create an EEP, for example, TabOrder.EEP with the following commands:

PROPERTY Panel2 TABORDER 0 
PROPERTY Field3 SET_FOCUS 0 
RETURN

4. Use TabOrder.EEP as "On After Start EEP"

Form Properties > Miscellaneous > "On After Start EEP"

5. Save the form.

Now when you run that form, the focus will be on the third control (DB Edit) placed on the middle (2nd)
Enhanced GroupBox.

That's all there is to it!

To understand that scenario, take a good look at the form "CallNotesEdit" included in Running R:BASE
Your Way! (Part 3).

Database: RRBYW3 
Form: CallNotesEdit 
Associated Command File: RRBYW3.RMD 
Associated EEPs: CallNotesEdit_PanelOrder.EEP

8.50 Understanding the "Space Evenly" Option for RadioGroup
Controls

Within the Form Designer, choose either the DB RadioGroup or the Variable RadioGroup. View the
Properties for the control and select the "Effects" tab.

When "Space Evenly" option is set to True (checked), the columns are positioned so that each "column"
of controls takes up the same amount of space. This specific option is very useful when "Columns" are
set to more than 1.

Example:

Properties > Columns: 2

To specify the number of pixels used between "rows" (when Columns: is set to 1), use the PROPERTY
command to specify the number of pixels used between rows of Radio Buttons in a Radio Group Control.

Example:

PROPERTY <Component ID> VERTICALSPACING xxx

Where xxx is the number of pixels used between rows of Radio Buttons in a Radio Group Control.
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8.51 Using a Date Picker (Calendar) in a DB Grid

Did you know that you can use a Date Picker (Calendar) in a DB Grid?

If you have a DB Grid Column associated with DATE, now you can use the Calendar to Enter or Update
the field in DB Grid.

Here's how:

1. Form Designer > DB Grid Control > Properties > Effects
2. [x] Check the option for "Show Picker for DATE Fields" and select the "OK" button
3. Save and close the Form Designer
4. Database Explorer > Select Form > Run Form

Notice the drop-down arrow on DATE field when the date column is focused.

Clicking on the drop-down arrow will bring up a calendar.

8.52 Using a Default State for DB/Variable CheckBoxes

Did you know that you can set the "Default State" for DB and Variable Check Boxes?

· Form Designer > DB CheckBox > Properties ...

Default State: [ ] Unchecked [ ] Checked

· Form Designer > Variable CheckBox > Properties ...

Default State: [ ] Unchecked [ ] Checked

8.53 Using Images in the DB TreeView Control

Did you know that now you can use images in DB TreeView control?

Here's a visual presentation of using images in a DB TreeView control:
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Typical DB TreeView Control
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DB Tree View Control with Images
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DB TreeView Properties A



"Tip of the Day" Digest133

Copyright © 1982-2012 R:BASE Technologies, Inc.

DB TreeView Properties B

8.54 Using Images in Variable/DB ListView Controls

Did you know that now you can use your favorite images (16x16) in a DB Lookup ListView or Variable
Lookup ListView control?

Here's a visual presentation of using images in a DB ListView control:
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Typical DB Lookup ListView
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Using Images in DB Lookup ListView 
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DB Lookup ListView Properties
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DB Lookup ListView with Column Images 
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DB Lookup ListView Properties

8.55 Using the Mouse Over Property for Images

Did you know that in addition to "On Click" and "Right Click" EEPs, now you also have the following
additional properties for Image, DB Image and Variables Image Controls?

· On Mouse Enter 
· On Mouse Over 
· On Mouse Leave

On Mouse Enter: 
Use this option to run EEP automatically when the mouse cursor moves into the control's area.

On Mouse Over: 
Use this option to run EEP when the mouse moves across the control. Please keep in mind that as the
mouse cursor moves across a control, the EEP is called repeatedly. Each time it is called, it is with the
new coordinates that reflect the continuous path of the mouse cursor across the screen real estate
covered by the control's visual representation.

On Mouse Leave: 
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Use this option to run EEP automatically when the mouse cursor moves out of the control's area.

8.56 Using the New Display Format in Forms

Generally, all DB and Variable controls in Form Designer include a "Format Mask" property option to
customize the format for data entry and data update purposes. This Format Mask property cannot be
used for customizing the "display format" of database or variable edit controls.

Did you know that you can use the newly implemented enhancement to customize the "Display Format"
for DB and Variable controls in form designer (A nice end-of-the-year goody)?

Here's how:

1. Open any form in the Form Designer
2. From the Menu Bar, choose "Tables" > "Display Format ..."

Notice the dynamic Tables/Columns TreeView with all associated table(s) and the list of
customizable column(s). 

3. Click on the desired column that needs the custom display format.
4. Depending on the data type of the selected column, a list of appropriate display formats is

generated.
5. Select the most suitable format from the list. You may further customize (overwrite) the selected

format is necessary.
6. Click on [OK] button to save the Display Format.

Using this enhanced feature, now you can have your cake and eat it too!

Supported Versions: 
· R:BASE 7.6 (Build 7.6.2.31221 or higher) for Windows 
· R:BASE (C/S:I) 7.6 (Build 7.6.2.31221 or higher) for Windows 
· R:BASE Turbo (Build 7.6.2.31221 or higher) for Windows



Forms 140

Copyright © 1982-2012 R:BASE Technologies, Inc.

8.57 Using the "On Right-Click" EEP on ListBox/ListViewControls

Did you know that you can use the "Right-Click" mouse button on Variable Lookup ListBox or Variable
Lookup ListView controls to execute any code, defined within a "On Right-Click" EEP?

Here's how:

For the Variable Lookup ListBox:

1. Within the Form Designer, select an existing or add a new  Variable Lookup ListBox
2. Within the Object Properties, select the "EEPs" tab.
3. Notice the additional option for "On Right Click"
4. You may also access your Custom EEP by simply right-clicking on the object and selecting the

"Custom EEP" > "On Right Click" menu option.

For the Variable Lookup ListView:

1. Within the Form Designer, select an existing or add a new  Variable Lookup ListView
2. Within the Object Properties, select the "EEPs" tab.
3. Notice the additional option for "On Right Click"
4. You may also access your Custom EEP by simply right-clicking on the object and selecting the

"Custom EEP" > "On Right Click" menu option.

Supported Versions: 
· R:BASE 7.6 for Windows (Build: 7.6.3.30516 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.3.30516 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.17.30516 or higher)

8.58 Using the SCALEBY Property

Did you know that you can scale the form and all placed control dynamically to fit the screens with
higher resolution?

You may use the PROPERTY RBASE_FORM SCALEBY 'nnnn' command to automatically scale form and all
related controls to specified 
screen pixel width.

SCALEBY property modifies the Height and Width properties of the form and all controls placed on it, but
it does not change the Top and Left properties; therefore, the size of the controls changes, but not the
coordinates of the top-left corners of the controls. Thus, it preserves the position of all controls on the
form. 

If you have developed a form that is 800x600 for the majority of users having a monitor with 800x600
screen resolution to fit the form on the entire available screen, but a few users of your application have
a higher resolution (1024x768) and if you wish your 800x600 form to fill the entire screen of a monitor
with a resolution of 1024x768, you'll need to use the RBASE_FORM SCALEBY 
property as follows:

PROPERTY RBASE_FORM SCALEBY '800' 
RETURN

This will scale the original form designed as 800x600 to fill the entire screen even if the screen resolution
is higher than 800x600, such as, 1400×1050, 1280x800 or 1024x768.

Notes:

· Use the SCALEBY property as embedded custom EEP in "On After Start EEP" in form 
· To take advantage of this feature, make sure that you use the scaled true type fonts for all controls

on that form
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A sample form to demonstrate the use of SCALEBY property in forms is also available at:

http://www.razzak.com/sampleapplications

8.59 Using the File ListBox Control

Did you know that now you can use "On Click EEP" for the File ListBox Control?

Form Designer > File System Controls > File ListBox > Properties

Using this feature, you can capture the entire file name as a "Long File Name" or "Short File Name" into
variable(s) by simply clicking on any file name listed in the File ListBox.

Example:

1. Place a File ListBox Control on a form.
2. Assign a Component ID for File ListBox Control, for example, "cFileListBoxControl".
3. Place two Variable Edit or Variable Label Controls associated with "vLongFileName" and

"vShortFileName" to monitor the captured results.
4. Use the following code as File ListBox Control "On Click EEP":

-- Begin 
-- File ListBox Control (On Click Custom EEP) 

CLEAR VAR vLongFileName, vShortFileName 
SET VAR vLongFileName TEXT = NULL 
SET VAR vShortFileName TEXT = NULL 
GETPROPERTY cFileListBoxControl LONGFILENAME vLongFileName 
GETPROPERTY cFileListBoxControl SHORTFILENAME vShortFileName 
RECALC VARIABLES 
RETURN 
-- End

5. Save and close the form.
6. At the R> Prompt or using the Database Explorer:

EDIT USING formname

Click on any file listed in the list box and notice the resulting captured values as Long/Short file names.

8.60 Using the Directory Tree Control

Did you know that now you can use an "On Click EEP" for the Directory Tree Control?

Form Designer > File System Controls > Directory Tree > Properties

Using this feature, now you can capture the value into a variable by simply clicking on any node of the
tree.

Example:

1. Place a Directory Tree Control on a form.
2. Assign a Component ID for Directory Tree Control, for example, "cDirTreeControl".
3. Place a Variable Edit or Variable Label Control on the form to monitor the captured results.
4. Use the following code within the Directory Tree Control "On Click EEP":

-- Begin 
-- Directory Tree Control (On Click Custom EEP) 

CLEAR VAR vValue 
SET VAR vValue TEXT = NULL 

http://www.razzak.com/sampleapplications
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GETPROPERTY cDirTreeControl DIRECTORY vValue 
RECALC VARIABLES 
RETURN 

-- End

5. Save and close the form.
6. At the R> Prompt or using the Database Explorer:

EDIT USING formname

Click on any level of the Directory Tree Control and notice the resulting captured value.

8.61 Using the Multi-Select Option for the ListView Control

Did you know that you can use a multi-select option for the Variable Lookup ListView control in forms?

Here's how:

Form Designer > Variable Controls > Variable Look-up ListView > Object Property > Effects >
MultiSelect

Notes:

1. To use the multi-select option, make sure that the variable data type is pre-defined as TEXT, NOTE
or VARCHAR. Choosing which of these to use depends on the anticipated cumulative value for the
variable. You must choose the data type wisely as the TEXT variable length is limited to 1500
characters, the NOTE variable length is limited to 4092 characters, and the VARCHAR variable
length is limited to 256MB. 

2. Use single-click to select one item. 

· Use [Ctrl + Click] to add item(s) to the list 
· Use [Ctrl + Click] to un-select the already selected item 
· Use [Ctrl + A] to select ALL items 
· Use [Ctrl + A] to un-select ALL items 
· Use [Shift + F6] key to select ALL items 
· Use [Shift + F6] key to un-select ALL items

3. All key values will be separated by a comma.

An application to demonstrate the practical use of this new feature is included on RBG76 Super Advanced
Training CD.

Folder: \76_MultiSelectListView 
Database: MSListVw 
Related Forms: 
· ListViewAsCHOOSE 
· MSListView 
· MSListViewMainMenu 
· MSListView_ShowVar 
· VarLookupListView 
Command File: MultiSelectListView.DAT

8.62 Using the Object List Toolbar

While in Form Designer, the Object List is very useful to displays the list of *all* object(s) placed on the
form. You may view all objects by selecting [All Controls] from the Object List, or view all objects by
selecting individual category, such as:

· Standard Controls 
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· Database Controls 
· Variable Controls 
· Additional Controls 
· Internet Controls 
· File System Controls 
· Legacy Controls
· ActiveX Controls

By selecting the object and clicking on [Object Property] button, you may customize the property of
selected object.

Did you know that you can also dock or float the Object List? Here's how:

Form Designer > Layout > Toolbars > Object List

Notice the floating Object List.

You may resize the height and width of this control and then dock it or float it, as you wish!

This is similar to other Toolbars.

8.63 Using  the"On Key Press" EEP for Instant Results

Did you know that you can use the new "On Key Press" EEP to execute code while you start typing a
character in a DB Edit or Variable Edit control?

Use "On Key Press" EEP, an event handler to make something happen as a result of a single character
key press on the keyboard.

The key parameter in the "On Key Press" event handler is of type TEXT; therefore, the "On Key Press"
event registers the ASCII character of the key pressed. Keys that don't correspond to an ASCII
character value (i.e. [Shift] or [F1]) will not execute an "On Key Press" EEP. Key combinations of non-
ASCII and ASCII characters (i.e. [Shift]+[A]), execute an "On Key Press" EEP only once. For this
example, [Shift]+[A] results in a key value of "A", if [Caps Lock] is off.
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A sample application to demonstrate the use of "On Key Press" EEP is also available at:

2008 SAT Sample Applications: http://www.rupdates.com/SAT2008/
Folder: \DesigningSearchScreensUsingKeyPressOption 
Database: KeyPress 
Form: SearchAndEditCust2 
Command File: DesigningSearchScreensUsingKeyPressOption.dat

Supported Versions:
· R:BASE 7.6 (Build 7.6.3.30404 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.3.30404 or higher) for Windows 
· R:BASE Turbo (Build 8.0.17.30404 or higher) for Windows

8.64 Using Wallpapers

The Next Generation of R:BASE for Windows allows R:BASE Developers/Users to develop and deploy
cool applications with a great look and feel using either standard wallpaper or custom wallpaper option of
Standard Controls in Form Designer.

While this is a cool feature, as a developer/user, you'll need to assess the working environment,
hardware and operating system of end-user using your wonderfully designed application(s).

Wallpaper adds additional overhead to the available memory resources on end-users' workstation. It is
strongly suggested to NOT use heavy duty wallpaper(s) on your forms if your end-user is using
workstations running MS Windows 98 operating system. There is no problem using cool wallpapers if
end-user is running MS Windows 2000 and/or Windows XP with at least 128-256MB RAM.
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Also, while in a form designer, if you're planning to use the custom wallpaper, use that as the last control
after adding all other controls.

When using Wallpaper as the last control on the top of all other controls, make sure to Right Click and
then select "Send To Back" in order for other controls to be visible.

8.65 Using Zebra Stripes in ListView Controls

Did you know that now you can totally customize the Variable Lookup ListView control in a form to
display Zebra Stripes and custom column titles?

The latest builds of R:BASE 7.6 and Turbo V-8 include added properties to support "Zebra Stripes" as
well as the options to select Background Color and Font Color for Column Titles.

For Zebra Stripes in ListView:

1. Open the R:BASE Form Designer 
2. Select the ListView Control 
3. Right click and select Object Property
4. Select the "Effects" tab
5. Check the option for Zebra Stripe and then select the Odd and Even colors.

For Custom Column Headers in ListView:

1. Open the R:BASE Form Designer 
2. Select the ListView Control 
3. Right click and select Object Property
4. Select the "Columns" tab
5. Select the column and then define the Background Color and Font Color.

Using these added properties and options, you can customize the ListView controls to match your
application theme.

Here is a screen shot example:
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Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.2.31003 or higher ...) 
· R:BASE 7.6 (C/S:I) for Windows (Build: 7.6.2.31003 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.16.31003 or higher)

8.66 Viewing Custom Form Action Code as a Hint

Did you know that when hovering over an form action, while in the form designer, you can view the
entire code as hint?

R:BASE now includes a new feature to view the entire code as a hint when hovering over the form
action.

To activate this new feature, an additional setting option has been implemented in the "Form Designer
Settings".

Select "Settings" > "Form Designer..." from the R:BASE min Menu Bar.

On the "Form" tab, notice the "Show Form Action Designer Hints" check box.

By default this setting in unchecked.

Supported Versions: 
· R:BASE 7.6 (Build 7.6.2.30102 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.2.30102 or higher) for Windows 
· R:BASE Turbo (Build 7.6.2.30102 or higher) for Windows
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9 Reports and Labels

9.1 Altering the CrossTab Grid Color

Did you know that you can customize the grid color of CrossTab control in Reports?

In addition to customizing the CrossTab column and row titles, now you may also customize the
CrossTab grid color.

Here's how:

1. Start R:BASE 7.6 or Turbo V-8 
2. CONNECT to RRBYW10, RRBYW12 or RRBYW14
3. From the Database Explorer > Reports > CrossTabReport > Design
4. From the Report Designer, right click on the CrossTab control and select "Grid Color..."
5. Select your favorite color and click on "OK" button
6. Click on the "Report Preview" tab to preview the report while in the Report Designer
7. Save the report and close Report Designer

You may also use the PROPERTY command to dynamically change the CrossTab grid color on demand.

Syntax:

PROPERTY CrossTabCompID GRIDCOLOR ColorName

-- Example 01: 

PROPERTY CrossTab GRIDCOLOR 'MAROON' 
RETURN

-- Example 02: 

PROPERTY CrossTab GRIDCOLOR 'GREEN' 
RETURN

Make sure to use above PROPERTY command as a "Before Generate..." action in reports.

9.2 Capturing Report System Variables

The following System Variables are supported in Reports:

· Date (Current Date) 
· Date Time (Current Date and Time) 
· Document Name (Report Name) 
· Print Data Time (Print Date and Time) 
· Page Count (Total page count such as 9) 
· Page Set (such as 1 of 9, 2 of 9) 
· Page Set with Description (such as Page 1 of 9, Page 2 of 9) 
· Page Number (such as 1, 2, 3, 4, 5, 6, 7, 8, 9) 
· Page Number with Description (such as Page 1, Page 2, Page 3) 
· Time (Current Time)

Did you know that you can capture the value any of these System Variables using the GETPROPERTY
command?

Syntax:

GETPROPERTY <ReportSystemVariableComponentID> TEXTVALUE varName

All you need to do is assign a unique Component ID to a System Variable object placed on a report band
and then use GETPROPERTY command to capture the value. In addition, you may also use the following
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GETPROPERTY commands to retrieve REPORT specific values.

-- To Retrieve Report Name 

GETPROPERTY REPORT REPORT_NAME vReportName
Report name may also be captured using the RBTI_REPORT_NAME variable.

-- To Retrieve Total Number of Tables Associated with Report 

GETPROPERTY REPORT REPORT_TABLE_COUNT vReportTblCount

-- To Retrieve the Name of Master Table 

GETPROPERTY REPORT 'REPORT_TABLE_NAME[0]' vReportMasterTbl

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.3.30516 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.3.30516 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.17.30516 or higher)

9.3 Changing the Report Section for All Expressions At Once

Traditionally, while in Report Designer Expression Builder, if you need to change the [Section] of all
defined variables, or a group variables, you will have to first highlight the variables, one at a time, and
then select the appropriate section from the drop-down list of sections of [Calculate On], and click on
[Apply] to change the section.

Did you know that you can select/highlight multiple variables, and and then select the appropriate
section from the drop-down list of sections of [Calculate On], and click on [Apply] to change section for
all expressions at once?

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10414 or higher)

9.4 Copy and Paste Expression Builder Variables

Did you know that you can copy a report/label variable from the Expression Builder, and paste it into
another report/label?

Buttons for "Copy" and "Paste" have been added to the Expression Builders for the Form, Report, and
Label modules, to allow users to copy and paste selected, or all, variables.

Please note the "Copy" and "Paste" buttons are located next to the "Up" and "Down" arrow buttons,
which reorder the location of a variable in the Expression Builder.

In addition, you may also use [Ctrl+C] to copy selected expression(s) and [Ctrl+V] to paste expression
(s) while placing the cursor over the expression builder window.
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Variables and Expressions can now be easily moved from form to form, label to label, and report to
report!

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.5.11111  or higher)

9.5 Customizing Column and Row Titles for CrossTab Reports

Did you know that you can customize the "Titles" for Rows and Columns used in Cross Tab Reports?

Here's how:

1. Report Designer > Cross Tab Control > Configure ...
2. Cross Tab Configuration Layout Panel
3. Right-click on the default column heading and select "Title..." from the list of speed menu options
4. Enter the text for title and click on the [OK] button
5. Right-click on the default row heading and select "Title..." from the list of speed menu options
6. Enter the text for title and click on the [OK] button
7. Use the Steps 3-6 to also customize the following:

· Font... 
· Color... 
· Display Format... 
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· Skip NULLs 
· Gridlines

9.6 Customizing Print Preview Screens with Themes

Did you know that you can customize the Print Preview Screen to match your application/form theme?

Try the following examples and see what you find.

Example 01:

CONNECT RRBYW10 
CLS 
PRINT Invoice WHERE TransID = 1002 + 
OPTION SCREEN + 
|WINDOW_STATE MAXIMIZED + 
|ZOOM_TYPE PERCENTAGE + 
|ZOOMPERCENT 90 + 
|THEMENAME Razzmatazz + 
|PREVIEW_BACKGROUND_COLOR 16180442 + 
|PREVIEW_CAPTION Running R:BASE Your Way! 

RETURN 

Example 02:

CONNECT RRBYW10 
CLS 
PRINT Invoice WHERE TransID = 1002 + 
OPTION SCREEN + 
|WINDOW_STATE MAXIMIZED + 
|ZOOM_TYPE PERCENTAGE + 
|ZOOMPERCENT 90 + 
|THEMENAME R:BASE Rocks!+ 
|PREVIEW_BACKGROUND_COLOR [R234,G234,B234] + 
|PREVIEW_CAPTION Running R:BASE Your Way! 

RETURN 

9.7 Customizing Report/Label Designer Toolbars

By default, a new R:BASE installation setup installs the following options for Report Designer Toolbar: 

1. Standard Controls 
· Label 
· Memo 
· Rich Text 
· Image 
· Shape 
· Line 
· Diagonal Line
· Barcode 
· CheckBox 
· Rotated Label

2. Variable Controls 
· System Variables 
· Variable Label 
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· Variable Memo 
· Variable Rich Text 
· Variable Image 
· Variable Barcode 
· Variable CheckBox 

3. Database Controls 
· DB Label 
· DB Memo 
· DB Rich Text 
· DB Calc 
· DB Image 
· DB Barcode 
· DB CheckBox 

4. Advanced Controls 
· Region 
· Cross Tab 

5. Format 
· Font 
· Font Size 
· Bold 
· Italic 
· Underline 
· Left Justify 
· Center 
· Right Justify 
· Justify 
· Font Color 
· Highlight Color 
· Bring to Front 
· Send to Back 

6. Edit 
· displays dynamic "Edit" options when using Standard, DB and Variable Controls

BUT ... if you would also like to see the following additional options on your Report Designer Tool Bar, all
you have to do is to check remaining options as following:

Report Designer > Main Menu > View > Toolbars and then check the options accordingly:

7. Standard 
· New 
· Open 
· Save 
· Close 
· Page Setup 
· Print 
· Print Preview 
· Cut 
· Copy 
· Paste
· Delete
· Select All

8. Draw 
· Fill Color 
· Line Color 
· Line Thickness 
· Line Style

9. Align or Space 
· Align Left 
· Align Middle 
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· Align Right 
· Align Top 
· Align Center 
· Align Bottom 
· Space Horizontally 
· Space Vertically 
· Center Horizontally in Band 
· Center Vertically in Band 

10. Size 
· Shrink Width to Smallest 
· Grow Width to Largest 
· Shrink Height to Smallest 
· Grow Height to Largest 

11. Nudge 
· Nudge Up 
· Nudge Down 
· Nudge Left 
· Nudge Right

Now you have every usable options visible in Report Designer Tool Bar!

You may re-arrange the sequence of Tool Bar options by simply drag-and-drop accordingly.

The last re-arranged setup will be saved under user registry.

9.8 Defining Built-in PAUSE Messages in Reports

There are situations where a report with hundreds of thousands of records
may take a while to print to a file or the screen, and you may want your
end-users to stay tuned while the report is being prepared.

The traditional approach of utilizing the PAUSE 3 command in an application
before Printing the report is good. However, as soon as the report starts
printing, the report takes over control of the window, and your good old
PAUSE command is no longer staying on top. So, how do we print a huge
report and display the PAUSE message until the entire report is actually
generated? 

Did you know that you can use a cool PAUSE 3 message within a Report
Action, such as the "Before Generate..." action and then issue the "CLS"
command to clear the PAUSE 3 message when the report is actually finished
in an "After Generate..." action?

Here's how:

1. Start R:BASE for Windows and open your favorite report in the Report
Designer

2. Choose "Report" > "Actions" > "Before Generate..." from the main Menu
Bar

3. Use the following code in your "Before Generate..." action:

 -- Before Generate Action in Report 
CLS 
GETPROPERTY REPORT REPORT_NAME vReportName 
PAUSE 3 USING + 
'Preparing Report ... Please Stand By ...' + 
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CAPTION .vReportName + 
ICON APP + 
OPTION GAUGE_VISIBLE ON + 
|GAUGE_COLOR 2708091 + 
|GAUGE_INTERVAL 10 + 
|MESSAGE_FONT_NAME VERDANA + 
|MESSAGE_FONT_SIZE 10 + 
|MESSAGE_FONT_COLOR RED + 
|THEMENAME R:BASE Rocks! 
RETURN

4. Choose "Report" > "Actions" > "After Generate..." from the main Menu Bar
5. Use the following code in the "After Generate..." action

-- After Generate Action in Report 
CLS 
CLEAR VARIABLE vReportName 
RETURN

6. Save the report

You may "Preview" the report while in the Report Designer, PRINT the report
from within the Database Explorer or use the PRINT command to see the
results.

Notice the real-time PAUSE 3 message with the report name as the caption
and the moving gauge, all while the message stays on screen until the
entire report is completely generated.

Versions: 
R:BASE 7.6, C/S:I 7.6 and Turbo V-8 for Windows

9.9 Defining TEMPORARY Table(s) within a Before Generate Action

Did you know that you can design a report and then use TEMPORARY tables to populate the data
dynamically using the "Before Generate" action in Reports?

Similarly, once the report is designed and finalized, you can use the "On Before Design" action to create
the required table(s) before bringing up the same report in report designer.

Here's a sample report to demonstrate the use of "Before Design" and "On Before Generate" actions in
Reports.

Sample Applications: http://www.razzak.com/sampleapplications/ 
Defining TEMPORARY Table(s) as On Before Generate Action in Reports 

Steps:

1. Unzip the file in your sample RRBYW10 folder, such as: 

C:\RBTI\RBG76\Samples\RRBYW10 

or 

C:\RBTI\RBG8\Samples\RRBYW12

http://www.razzak.com/sampleapplications/
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The zip file include two files: tCustomerList.RPT and tCustomerList.LOB

2. Start R:BASE 7.6 Turbo V-8 and CONNECT to RRBYW10 or RRBYW12
3. At the R> Prompt:

RUN tCustomerList.RPT

4. At the R> prompt:

LIST REPORTS

Notice that tCustomerList report is based on tCustomerList table. However, there is no such table
defined in RRBYW10 or RRBYW12

5. If you the open the tCustomerList report in Report Designer, notice that the required table is
dynamically created.

6. If you run the tCustomerList report, notice that the required table with populated data is dynamically
created.

To understand the entire logic, open the report in Report Designer and review the "Before Generate..."
and "On Before Design..." actions.

· Report Designer > Main Menu > Report > Actions > Before Generate ...
· Report Designer > Main Menu > Report > Actions > On Before Design ...

9.10 Documenting Report/Label EEPs

Did you know that while in Report/Label Designer, you can document all Embedded Custom EPPs (if
defined), as well as External EEPs (if referenced)?

In addition to documenting Custom EEPs (if defined), now you may also document all External EEPs (if
referenced). This will help documenting all references related to Form External EEPs when converting
legacy database/application to R:BASE 7.6 or Turbo V-8 for Windows.

Here's how:

With the Report Designer, select "Report" > "Document Custom EEPs" from the main Menu Bar, and the
available output options include:

· Printer
· Text file
· PDF file
· Clipboard

With the Label Designer, select "Label" > "Document Custom EEPs" from the main Menu Bar, and the
available output options include:

· Printer
· Text file
· PDF file
· Clipboard

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.4.30611 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.4.30611 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.18.30611 or higher)
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9.11 Getting the Total Number of Pages in a Report

Did you know that using the GETPROPERTY command, now you can get the total number of pages in a
report?

Here's how:

Use the following custom EEP as an "After Generate EEP..." for the Report Footer:

SET VAR vTotPageCount TEXT = NULL 
GETPROPERTY REPORT TotalPageCount 'vTotPageCount' 
SET VAR vPauseMessage = ('Total Number of Pages:'&.vTotPageCount) 
PAUSE 2 USING .vPauseMessage + 
CAPTION 'GETPROPERTY in Reports' + 
ICON INFO + 
BUTTON 'Press any key to continue ...' + 
OPTION BACK_COLOR WHITE + 
|MESSAGE_COLOR WHITE + 
|MESSAGE_FONT_COLOR GREEN 

CLS 
RETURN

9.12 Managing the Memo Control

While in Report Designer, after placing a Memo Object on appropriate band, now you can use the
double-click to open Memo Editor. You may use the [Load] option to load an external file, if you wish.
Clicking on the [OK] button will save the contents. Then, you will be able to preview Memo contents
without using the Memo Editor.

You may still use the right-click speed menu for more options related to Memo Control in Report
Designer.

Supported Versions: 
· R:BASE eXtreme 9.0 (Build: 9.0.1.10624 or higher) 

9.13 Opening a PDF Report in Presentation Mode

Did you know that when you PRINT an R:BASE for Windows report with the OPTION PDF parameter, you
can open that PDF report in Presentation Mode?

Here's how:

Use the PRESENTATION_MODE and DURATION options when PRINTing your report as PDF.

In addition to built-in document security (64/128Bit encryption level), now you can open the PDF
document with defined presentation using the User/Owner Password.

Try the following sample command file, using PDFModes sample database.

CLEAR VAR vCaption, vPauseMessage, vChkFile 
SET VAR vCaption TEXT = 'Running R:BASE Your Way!' 
SET VAR vPauseMessage TEXT = 'MUST have RBG7.5 or higher to run this
application' 
SET VAR vChkFile INTEGER = NULL 
IF (SGET(CVAL('BUILD'),3,1)) < '7.5' THEN 
CLS 
PAUSE 2 USING .vPauseMessage + 
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CAPTION .vCaption + 
ICON STOP + 
BUTTON 'Click here to continue ...' + 
OPTION BACK_COLOR WHITE + 
|MESSAGE_COLOR WHITE + 
|MESSAGE_FONT_COLOR RED + 
|BUTTON_COLOR WHITE + 
|BUTTON_FONT_COLOR GREEN 

EXIT 
ENDIF
CONNECT PDFModes 

-- Verify the existance of PDF Sub-Directory 
SET VAR vChkFile = (CHKFILE('PDF')) 
IF vChkFile <> 1 THEN 
MD PDF 

ENDIF
PRINT SalesSumAndSubTot + 
OPTION PDF + 
|FILENAME PDF\SalesSumAndSubTotals.PDF + 
|SHOW_CANCEL_DIALOG ON + 
|BACKGROUND_FILE NONE + 
|BACKGROUND_COLOR WHITE + 
|INCLUDE_LINES ON + 
|INCLUDE_SHAPES ON + 
|INCLUDE_RICHTEXT ON + 
|RICHTEXT_ENCODING_TYPE PLAINTEXT + 
|INCLUDE_IMAGES ON + 
|IMAGE_FORMAT JPG + 
|PIXELFORMAT 32 + 
|JPEG_QUALITY 100 + 
|IMAGE_DPI -1 + 
|INCLUDE_HYPERLINKS ON + 
|GENERATE_TOC ON + 
|TITLE Customer Sales Sub-Totals and Totals + 
|SUBJECT Sales Summary Report + 
|AUTHOR R:BASE 7.5 for Windows Report Writer + 
|KEYWORDS SubTotals Totals Sales Summary + 
|USE_COMPRESSION ON + 
|COMPRESSION_METHOD MAXCOMPRESS + 
|FONT_ENCODING WIN_ANSI + 
|EMBED_USED_FONTS ON + 
|ENCRYPT_FILE ON + 
|USER_PASSWORD PDFModes + 
|OWNER_PASSWORD PDFModesOwner + 
|ENCRYPTION_LEVEL 128BIT + 
|ENABLE_PRINTING OFF + 
|ENABLE_COPYING OFF + 
|ENABLE_MODIFYING OFF + 
|HIDE_TOOLBAR OFF + 
|HIDE_MENUBAR OFF + 
|HIDE_WINDOW_UI OFF + 
|FIT_WINDOW OFF + 
|CENTER_WINDOW OFF + 
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|PAGE_LAYOUT SINGLE_PAGE + 
|PAGE_MODE NONE + 
|NON_FULL_SCREEN_PAGE_MODE NONE + 
|PRESENTATION_MODE WIPE_RIGHT_TO_LEFT + 
|DURATION 1 + 
|OPEN ON 

CLEAR VAR vCaption, vPauseMessage, vChkFile 
RETURN

The following PDF presentation modes are supported:

· SPLIT_HOR_INWARD 
· SPLIT_HOR_OUTWARD 
· SPLIT_VERT_INWARD 
· SPLIT_VERT_OUTWARD 
· BLINDS_HOR 
· BLINDS_VERT 
· BOX_INWARD 
· BOX_OUTWARD 
· WIPE_LEFT_TO_RIGHT 
· WIPE_BOTTOM_TO_TOP 
· WIPE_RIGHT_TO_LEFT 
· WIPE_TOP_TO_BOTTOM 
· DISSOLVE 
· GLITTER_LEFT_TO_RIGHT 
· GLITTER_TOP_TO_BOTTOM 
· GLITTER_TOPLEFT_TO_BOTTOMRIGHT

Note:
Use the password "PDFModes" or "PDFModesOwner" when prompted to open the secure PDF report. 

A sample application "Opening PDF Report in Presentation Mode" is also available at:
http://www.razzak.com/sampleapplications 

9.14 Printing a Portion of a Report to a Different Printer

Did you know that the Sub-Reports in R:BASE 7.5 for Windows also have the capability to change the
printer settings for the portion of the report in which they generate?

Here's how:

Use the Sub-Report's Printer Setup property to specify the different settings, including a different printer
or paper tray, etc., just as you would a normal report.

If you specify a different printer in Printer Setup than that of the main (parent) report, then a New Print
Job will be started on that printer when the report generates. This means that different sections of a
report can not only use different printer settings, but that they can also be sent to different printers.

To do this, click on the appropriate Sub-Report tab in report designer and then simply customize the
page setup as you would do for the normal report.

Report Designer > Select Sub-Report > Main Menu ...

Main Menu > File > Page Setup ... > Printer ...

When the Page Setup property is set for the Sub-Report, then this property determines whether a new
print job is started when the Sub-Report is sent to the printer. This property can be used when a portion
of a report needs to be printed to a separate printer. If you need to change printer settings for a certain
section, you can do so without starting a new print job. Simply set the Page Setup properties (Printer,
Paper Size, Orientation, Paper Tray, etc.) and these settings will be applied as the report prints.

http://www.razzak.com/sampleapplications
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Think about printing a Summary Page with R:Charts Analysis on a color printer and then printing all
details with hundreds of pages on a separate black and white printer.

9.15 Printing Watermark Images in RTF Reports

When printing an RTF report with transparent images as watermark, everything looks good on the
SCREEN. However, if you print that exact report directly to PRINTER, you will notice that the
transparency is lost. This is how the RTF reports are printed when sent directly to the printer. This is a
limitation of the RTF file format when using transparent images and overlapping text.

In order to print an RTF report with transparent images as watermark, first you need to print that report
as PDF and then print that PDF report to printer to achieve your goal. Here's how:

PRINT reportname OPTION PDF + 
|FILENAME filename.PDF + 
|RICHTEXT_ENCODING_TYPE PLAINTEXT + 
|OPEN ON

9.16 Retrieving Report Properties

Using the GETPROPERTY command you can retrieve the following properties of a report.

· Report Name 
· Associated Number of Tables 
· Associated Names of Tables (Master/Slave) 

(For Sub-Reports)

Example 01: (To Retrieve Report Name) 

GETPROPERTY REPORT 'REPORT_NAME' vReportName 
RETURN

Variable vReportName will return the name of the report.

Example 02: (To Retrieve the Number of Associated Tables in Report)
 

GETPROPERTY REPORT 'REPORT_TABLE_COUNT' vReportTableCount 
RETURN

Variable vReportTableCount will return the total number of associated tables in report.

Example 03: (To Retrieve the Name of Master Table Name for the Report) 

GETPROPERTY REPORT 'REPORT_TABLE_NAME[0]' vReportMasterTable 
RETURN

Variable vReportMasterTable will return the name of master table name for the report.

Example 04: (To Retrieve the Name of First Slave Table Name for the Report) 

GETPROPERTY REPORT 'REPORT_TABLE_NAME[1]' vReportSlaveTable1 
RETURN

Variable vReportSlaveTable1 will return the name of first slave table associated with a report in a Sub-
Report environment.

Example 05: (To Retrieve the Name of Second Slave Table Name for the Report) 
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GETPROPERTY REPORT 'REPORT_TABLE_NAME[2]' vReportSlaveTable2 
RETURN

Variable vReportSlaveTable2 will return the name of second slave table associated with a report in a
Sub-Report environment.

9.17 Sorting Slave Tables with Forms/Sub-Reports

If you have a form with slave tables and a report with sub-reports, and if you wish to sort the matching
rows related to slave table(s)/sub-report(s), you'll need to use the ARRANGE BY clause to achieve your
goal.

ARRANGE tablename BY columnlist sorts the rows displayed by a form's or report's lower-level tables.
Each lower-level table in the form or report that you want to sort requires its own ARRANGE clause. You
can specify up to twenty-five tables to ARRANGE and up to five columns in each table on which R:BASE
will sort.

Example 01:

Database: RRBYW10 
Sample Form: SalesTransactions 
Associated Tables (5): 

· Customer (Master) 
· InvoiceHeader (Slave 1) 
· InvoiceDetail (Slave 2) 
· Employee (Slave 3) 
· Contact (Slave 4)

Command: 

EDIT USING SalesTransactions + 
ARRANGE InvoiceHeader BY TransID, + 
ARRANGE InvoiceDetail BY ItemNum, + 
ARRANGE Employee BY EmpLName,EmpFName + 
ARRANGE Contact BY ContLName,ContFName + 
ORDER BY Company WHERE CustState = 'CA' 

RETURN 

Example 02:

Database: RRBYW10 
Sample Report with Sub-Report: CustomerContacts 
Associated Tables (2): 

· Customer (Master) 
· Contact (Slave 1)

Command: 

PRINT CustomerContacts + 
ARRANGE Contact BY ContLName,ContFName + 
ORDER BY Company WHERE CustState = 'CA' + 
OPTION SCREEN|WINDOW_STATE MAXIMIZED + 
|ZOOM_TYPE PERCENTAGE|ZOOMPERCENT 90 

RETURN 
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9.18 Using BRUSH_STYLE and PEN_STYLE Properties in Reports

While in Report Designer, when placing a Shape Object, you may also customize the Shape Type, Fill
Color, Line Color, Line Thickness, and Line Style.

Did you know that using the new PROPERTY commands you may dynamically change the Shape Style
and Pen Style as well?

Syntax:

PROPERTY <ShapeObjectCompID> BRUSH_STYLE 'value' 

Supported Values: 
SOLID 
CLEAR 
HORIZONTAL 
VERTICAL 
F_DIAGONAL 
B_DIAGONAL 
CROSS 
DIAG_CROSS

PROPERTY <ShapeObjectCompID> PEN_STYLE 'value' 

Supported Values: 
SOLID 
DASH 
DASH_DOT 
DASH_DOT_DOT 
CLEAR 
INSIDE_FRAME 
USER_STYLE 
ALTERNATE

You may dynamically change BRUSH_STYLE and PEN_STYLE Properties as On Before Generate Report
Action or conditionally as On Before Generate Action on any Report Band, as you wish.

-- Example 01 
-- Database: RRBYW17 
-- Report: InvoiceSummary_Brush_Style_Pen_Style 
-- Using New BRUSH_STYLE and PEN_STYLE Properties for Shape Control
-- Action: Report Header [Before Generate] 
-- Cover Page Shapes 
PROPERTY CoverPage_Shape_01 BRUSH_STYLE 'HORIZONTAL' 
PROPERTY CoverPage_Shape_01 PEN_STYLE 'SOLID' 
PROPERTY CoverPage_Shape_02 BRUSH_STYLE 'VERTICAL' 
PROPERTY CoverPage_Shape_02 PEN_STYLE 'DASH' 
PROPERTY CoverPage_Shape_03 BRUSH_STYLE 'F_DIAGONAL' 
PROPERTY CoverPage_Shape_03 PEN_STYLE 'DASH_DOT' 
PROPERTY CoverPage_Shape_04 BRUSH_STYLE 'B_DIAGONAL' 
PROPERTY CoverPage_Shape_04 PEN_STYLE 'DASH_DOT_DOT' 
RETURN
-- Action: Page Header [Before Generate] 
-- Page Header Shapes 
PROPERTY PageHeader_Shape_01 BRUSH_STYLE 'CROSS' 
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PROPERTY PageHeader_Shape_01 PEN_STYLE 'INSIDE_FRAME' 
PROPERTY PageHeader_Shape_01 BRUSH_STYLE 'DIAG_CROSS' 
PROPERTY PageHeader_Shape_01 PEN_STYLE 'ALTERNATE' 
RETURN
-- Action: Break Footer 0 [Before Generate] 
-- Break Footer Shape 
PROPERTY BreakFooter_Shape_01 BRUSH_STYLE 'B_DIAGONAL' 
PROPERTY BreakFooter_Shape_01 PEN_STYLE 'DASH_DOT_DOT' 
RETURN
-- Action: Report Footer [Before Generate] 
-- Report Footer Shape 
PROPERTY ReportFooter_Shape_01 BRUSH_STYLE 'SOLID' 
PROPERTY ReportFooter_Shape_01 PEN_STYLE 'DASH_DOT' 
RETURN

For your viewing pleasure, here is a report that illustrates the use of new BRUSH_STYLE and PEN_STYLE
properties of Shape control.
http://www.razzak.com/tips/InvoiceSummary_Brush_Style_Pen_Style.pdf

In addition, notice the feature of designing a custom "Cover Page" and Page Header and Page Footer
options, not to mention the compact size of PDF document using R:BASE eXtreme 9.1.

Have fun implementing BRUSH_STYLE/PEN_STYLE properties in Reports!

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10414 or higher)

9.19 Using Printer Control Codes

Did you know that you can use Printer Control Codes (PCC) in R:BASE for Windows? Using the new PCC
(Printer Control Codes) Label control in either the Label or Report Designers, you can now send any
Printer or POS Cash Drawer code to control the features of your printer or any other device that accepts
application codes. Here's how:

1. Start R:BASE and open the Database Explorer
2. Select Reports from the Group Bar and select an existing report
3. Right click on it and select "Design Report"
4. In the Designer, notice the new "PCC Label" control under Advanced Controls

04. While in Report Designer, select the new PCC Label control and place it on the appropriate band of
the report and then enter 
the correct code in the "Set Value" box.

Let's assume that the control code you must send to your printer to have it open your cash drawer
is 27, 112, 0, 50, 250. In that particular case, you'll need to enter the following code in Set Value
box to open the cash drawer before printing the receipt in R:BASE POS system. 

Enter "27 112 0 50 250" into the "Set Value" box.

http://www.razzak.com/tips/InvoiceSummary_Brush_Style_Pen_Style.pdf
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Another good scenario would be where the original tractor feed forms frequently require filling in data at
the top of the form, which is above the area where the print head sits at rest. In order to avoid wasting
the first form, the user would need back up the form to line up the top of the form with the top of the
print head which would be pretty inconvenient. The other choice would be to roll up the forms on the
printer and waste the first form by leaving it blank (wastes paper and is not good for the environment or
trees!).

So, to achieve that goal, now all you need to do is to place the PCC label on appropriate band of the
report, enter the printer specific codes, and you are done. All hardware specific codes, when placed
while in the Label or Report Designer, are only enforced when printing the label or report to a printer
using the OPTION PRINTER command.

Supported Versions: 
· R:BASE 7.6 (Build 7.6.3.30214 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.3.30214 or higher) for Windows 
· R:BASE Turbo (Build 8.0.16.30214 or higher) for Windows

9.20 When to Use Report Actions vs. Report Band EEPs

Do you know when it is appropriate to use Report Actions versus using Report Band EEPs?

In the R:BASE Report/Label Designer there are now several different options now available for
developers and users to run custom code within reports and labels. There are "Report Actions" and
"Report Band EEPs".

With Actions, there are several levels that your custom code can be executed during a report's stages of
use. The levels 
include:

· Before Preview - executes code before a report is previewed
· After Preview - executes code after a report is previewed
· Before Generate - executes code before a report is generated
· After Generate - executes code after a report is generated
· On Before Design - executes code before the designer is launched
· On After Design - executes code after the designer is closed
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A Report Action is geared to be used for initializing variables and creating temporary or permanent
tables and views. The reason for this is because Report Actions are only intended to be executed once
when the report is generated in the R:BASE Report Generator.

When using Report Band EEPs, you can run custom code before or after a report band, i.e. Page Header
(PH), Report Footer (RF), etc., is generated. As R:BASE reports are generated from top to  bottom, the
Report Band EEPs will execute in this same fashion. If you right click on any report band, you will see the
following options for EEPs:

· Before Generate Custom EEP
· After Generate Custom EEP

If you intend to alter the characteristic of any report field, i.e. color, visibility, size, etc., then you must
issue the appropriate PROPERTY and GETPROPERTY commands within your Report Band EEPs.

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.3.30516 or higher)
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.3.305016 or higher)
· R:BASE Turbo V-8 for Windows (Build: 8.0.17.30516 or higher)



Part

X



File Gateway 166

Copyright © 1982-2012 R:BASE Technologies, Inc.

10 File Gateway

10.1 Automating Gateway Import/Export Routines

Did you know that you can totally automate your Gateway Import/Export routines using your own
custom specifications?

Using the SPECIFICATION_FILE_NAME parameter, 

When using either the "Existing Table" Import option or the "Export Wizard", the "Specifications..." button
is available to save your import/export options to a specification file. The specification file will store your
import options for type, source file, fields, settings and mode. 

The specification files can be loaded for the current data import, saved for future imports (using both the
user interface or the GATEWAY command), or deleted. The specification files are stored in the current
database directory with the .RGW file extension. 

Import Example:

GATEWAY IMPORT XLS +
D:\TEMP\SkyData.XLS +
APPEND SkyData + 
OPTION SHEET_INDEX 0 +
|SPECIFICATION_FILE_NAME SkyData_Imprt.RGW

Export Example:

GATEWAY EXPORT CSV +
C:\TEMP\SkyData.CSV  +
OPTION COL_NAMES OFF +
|SHOW_PROGRESS ON +
|MESSAGES ON +
|SPECIFICATION_FILE_NAME SkyData_Exprt.RGW

10.2 Defining Column Count When Importing Data

Did you know that while automating the entire File Gateway Import routines to import MS Spreadsheet (.
xls) or .CSV file into R:BASE, now you can specify the exact number of columns to import?

An additional "OPTION COLUMN_COUNT nnn" has been implemented to simplify your entire load process.

-- Example:

GATEWAY IMPORT filename.csv CREATE newtable OPTION COLUMN_COUNT 5

This command will import only first 5 columns from the CSV file.

Supported Versions: 
· R:BASE 7.6 for Windows (Build: 7.6.7.30420 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.21.30420 or higher) 
· R:BASE eXtreme 9.0 for Windows (Build: 9.0.1.10420 or higher)

10.3 Defining Header/Footer when Using GATEWAY EXPORT XLSW

When automating GATEWAY EXPORT XLSW options, did you know that you can also include Header and
Footer text?

Two additional OPTIONs are implemented when exporting data as XLSW.
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HEADER_TEXT value
FOOTER_TEXT value

-- Example 01:

-- Start here
   CONNECT RRBYW17
   SET ERROR MESSAGE 2077 OFF
   DELETE InvoiceHeader.xls
   SET ERROR MESSAGE 2077 ON
   GATEWAY EXPORT XLSW InvoiceHeader.xls +
   SELECT TransID AS `Invoice No`, +
   TransDate AS `Invoice Date`, +
   NetAmount AS `Sub Total`, +
   Freight, Tax, +
   InvoiceTotal AS `Invoice Total` +
   FROM InvoiceHeader ORDER BY TransID +
   OPTION COL_NAMES ON +
   |HEADER_TEXT Customer Invoices +
   |FOOTER_TEXT Quarterly Report +
   |SHEET_NAME Invoices +
   |ACTION OPENVIEW
   RETURN
-- End here

Notes:

· You can customize the column names with spaces by surrounding the names with IDQUOTE character.

· Once the worksheet is opened, notice the header information in Row 1, Cell 1 (A1), and the footer
information in the last row, Cell 1.

· You may also notice the "Number Format" for Invoice No, Invoice Date, Net Amount, Freight, Tax, and
Invoice Total. All data types, such as INTEGER (Number), DATE, and CURRENCY are now reflected
accordingly and not formatted as custom.

· You may also customize and automate the file extension (.xls or .xlsx) by using the PLUGIN RRegistry
Command.

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.2.10214 or higher)

10.4 Importing New Table as Temporary

Did you know that using the File Gateway Import option, now you can create a new table as
TEMPORARY?
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Supported Versions: 
· R:BASE 7.6 for Windows (Build: 7.6.7.30420 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.21.30420 or higher) 
· R:BASE eXtreme 9.0 for Windows (Build: 9.0.1.10420 or higher)

10.5 Multi-Tab Excel Workbook with Headers Using GATEWAY
EXPORT XLSW

Here's an example to create multi-tab Excel Workbook with Headers using GATEWAY EXPORT XLSW
options,

-- GATEWAY_Multi_Tab_EXPORT_XLS_XLSW.RMD 
-- Author: A. Razzak Memon 
-- Date Created: March 31, 2011 
-- Last Updated: 
IF (CVAL('DATABASE')) <> 'RRBYW17' OR (CVAL('DATABASE')) IS NULL THEN 

CONNECT RRBYW17 IDENTIFIED BY NONE 
ENDIF 
CLEAR VARIABLES vCaption,vPause3Message,vPause4Message,vCheckExtension 
SET VAR vCaption TEXT = 'Multi-Tab XLS/XLSX Workbook' 
SET VARIABLE vPause3Message TEXT = NULL 
SET VARIABLE vPause4Message TEXT = NULL 
SET VARIABLE vCheckExtension TEXT = NULL 
SET VARIABLE vFileName TEXT = NULL 
SET VAR vPause3Message = + 

((CHAR(013))+' Now Preparing Multi-Tab XLS/XLSX Workbook') 
CLS 
PAUSE 3 USING .vPause3Message + 

CAPTION .vCaption + 
ICON INFO + 
OPTION MESSAGE_FONT_NAME Tahoma + 
|MESSAGE_FONT_COLOR GREEN + 
|MESSAGE_FONT_SIZE 11 + 
|THEMENAME Vista CG 

-- Delete previously created RRBYW17_Multi_Tab_WorkBook.xl??, if any 



"Tip of the Day" Digest169

Copyright © 1982-2012 R:BASE Technologies, Inc.

SET ERROR MESSAGE 2077 OFF 
DELETE RRBYW17_Multi_Tab_WorkBook.xl?? 
SET ERROR MESSAGE 2077 ON 
-- Define file name with appropriate file extension (.xls or .xlsx) 
-- .xlsx for MS Office Excel 2007 or higher 
PLUGIN RRegistry 'vCheckExtension|CHECK_KEY|HKCR|.xlsx|' 
IF vCheckExtension = 'TRUE' THEN 

SET VARIABLE vFileName = 'RRBYW17_Multi_Tab_WorkBook.xlsx' 
ELSE 

SET VARIABLE vFileName = 'RRBYW17_Multi_Tab_WorkBook.xls' 
ENDIF 
-- Create Tab 1 (Customers) 
SET VAR vPause4Message = + 

((CHAR(013))+' Now Adding Tab 1 - Customers') 
PAUSE 4 USING .vPause4Message + 

CAPTION .vCaption + 
ICON INFO + 
OPTION MESSAGE_FONT_NAME Tahoma + 
|MESSAGE_FONT_COLOR GREEN + 
|MESSAGE_FONT_SIZE 11 + 
|THEMENAME Vista CG 

GATEWAY EXPORT XLSW .vFileName + 
SELECT CustID AS `Cust ID`, + 
Company AS `Company Name`, + 
CustAddress AS `Address`, + 
(CustCity+','&CustState&CustZip) AS `City, State and Zip Code`, + 
CustPhone AS `Phone Number` + 
FROM Customer ORDER BY Company + 
OPTION COL_NAMES ON + 
|HEADER_TEXT Customers + 
|SHEET_NAME Customers|SHEET_INDEX 1 

-- Create Tab 2 (Invoice Headers) 
SET VAR vPause4Message = + 

((CHAR(013))+' Now Adding Tab 2 - Invoice Headers') 
PAUSE 4 USING .vPause4Message + 

CAPTION .vCaption + 
ICON INFO + 
OPTION MESSAGE_FONT_NAME Tahoma + 
|MESSAGE_FONT_COLOR GREEN + 
|MESSAGE_FONT_SIZE 11 + 
|THEMENAME Vista CG 

GATEWAY EXPORT XLSW .vFileName + 
SELECT TransID AS `Invoice No`, + 
CustID AS `Cust ID`, + 
TransDate AS `Invoice Date`, + 
NetAmount AS `Sub Total`, + 
Freight, Tax, + 
InvoiceTotal AS `Invoice Total` + 
FROM InvoiceHeader ORDER BY TransID + 
OPTION COL_NAMES ON + 
|HEADER_TEXT Invoices + 
|SHEET_NAME Invoices|SHEET_INDEX 2 + 
|ACTION OPENVIEW 
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CLEAR VARIABLES vCaption,vPause%,vCheckExtension,vFileName 
CLS 
RETURN

Notes:

· Notice the use of PLUGIN RRegistry Command to customize and automate the file name extension (.
xls or .xlsx).

· You can customize the column names with spaces by surrounding the names with IDQUOTE character.

· Once the worksheet is opened, notice the header information in Row 1, Cell 1 (A1), and the footer
information in the last row, Cell 1.

· You may also notice the "Number Format" for Invoice No, Invoice Date, Net Amount, Freight, Tax, and
Invoice Total. All data types, such as INTEGER (Number), DATE, and CURRENCY are now reflected
accordingly and not formatted as custom.

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.2.10214 or higher)
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11 R:BASE Editor

11.1 Commenting and Uncommenting Commands

There are several different methods you can use in order to comment and uncomment lines or blocks of
code in your command files. 

To comment an individual line, add two hyphen characters "-" to the beginning of the line. In R:BASE
Editor, the syntax highlighting will alter the display and change the font color to pink and the style to
italicized. In the following example;

CLEAR VAR vResult

the command will become:

--CLEAR VAR vResult

Another use of characters that will comment your code is the asterick character preceding a set of
parentheses "*()", with the desired commented text or commands enclosed within the parentheses. In
the following example;

PLUGIN RPDFMerge.RBL 'vResult +
|ACTION MERGE +
|DOC_LIST_FILE PDFFilesToMerge.LST +
|SHOW_SETUP_DIALOG ON +
|OUTPUT_FILE OneBigMergedFile.PDF '

the commands will become:

*(

PLUGIN RPDFMerge.RBL 'vResult +

|ACTION MERGE +

|DOC_LIST_FILE PDFFilesToMerge.LST +

|SHOW_SETUP_DIALOG ON +

|OUTPUT_FILE OneBigMergedFile.PDF '

)

Although this option is still supported in R:BASE, it is now recommended that you use an alternative
method to avoid confusing parentheses with your R:BASE expressions. The suggested alternative is the
use of a set of squiggly brackets "{}", with the desired commented text or commands enclosed within
the squiggly brackets . In the following example;

PLUGIN RPDFMerge.RBL 'vResult +
|ACTION MERGE +
|DOC_LIST_FILE PDFFilesToMerge.LST +
|SHOW_SETUP_DIALOG ON +
|OUTPUT_FILE OneBigMergedFile.PDF '

the commands will become:

{

PLUGIN RPDFMerge.RBL 'vResult +

|ACTION MERGE +

|DOC_LIST_FILE PDFFilesToMerge.LST +

|SHOW_SETUP_DIALOG ON +
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|OUTPUT_FILE OneBigMergedFile.PDF '

}

Other methods to comment an entire block of text or code include the options in the R:BASE Editor:

Highlight the entire block of text 

Right Click > Block > Comment

You can uncomment the entire block of your code in RBG7 RBEdit by:

Highlight the entire block of text 

Right Click > Block > Uncomment

You may also want to explore other options in completely re-designed R:BASE Editor!

11.2 Customizing RBEdit Structure Toolbar Options

Did you know that you can customize the R:BASE Editor (RBEdit) Structure Toolbar settings to include
custom structure options when editing or analyzing your application or command file?

Here's how:

From the main Menu Bar, select > Settings > R:BASE Editor. Then, select the Structure Toolbar tab.

Once you check all appropriate options accordingly, click on OK button to save your custom settings.

Now when editing your application or command file, clicking on the [Refresh Structure] with document all
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selected options.

Clicking on [Output Structure] button will let you save the entire structure with all details as follows:

· Printer 
· Text File 
· PDF File 
· Copy to Clipboard

Have fun taking advantage of Expanded Structure as well as Output options in R:BASE eXtreme 9.1
(32/64).

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10414 or higher)

11.3 Integrating the External R:BASE Editor

With the added power and features of R:BASE Editor, http://www.rbedit.com/, if you wish to integrate
the external editor into R:BASE, all you have to do is to simply use the following command at the R>
prompt:

SET EDITOR 'C:\RBTI\RBEdit\RBEdit.exe'

This will set the default editor to your choice of R:BASE Editor.

The following will reveal the setting for your default editor.

SHOW EDITOR 

http://www.rbedit.com/
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The default editor setting can also be captured in a variable using the following Function:

(CVAL('EDITOR')) 

You may also use the following option in your R:BASE configuration file (line #86):

EDITOR C:\RBTI\RBEdit\RBEdit.exe

11.4 Running Your Code Within RBEdit

Did you know that now you can RUN your code while creating new code or updating existing code while
in RBEdit?

Here's how:

1. Start R:BASE (7.6, C/S:I 7.6 or Turbo V-8)
2. Open your existing command file or simply create a new one and use the following code:

CLS 
SET VAR vTest TEXT = 'R:BASE Rocks!' 
DIALOG 'Enter Text Messge' vTest=26 vEndKey 1 + 
CAPTION 'Using AUTOSELECT' ICON APP + 
OPTION AUTOSELECT TRUE + 
|THEMENAME R:BASE Rocks! 
RETURN

3. While still in RBEdit, either click on the new Run [>] button on the tool bar or use [Ctrl + F9] keys to
RUN your code.

If you need to make any changes, do it while in RBEdit and test your code again without closing RBEdit.

Supported Versions:
· R:BASE 7.6 for Windows (Build 7.6.2.31130 or higher ...) 
· R:BASE 7.6 (C/S:I) for Windows (Build 7.6.2.31130 or higher) 
· R:BASE Turbo V-8 for Windows (Build 8.0.16.1130 or higher)

11.5 Wrapping Commands Using the Right Margin

Did you know that you can customize the location of the right margin in R:BASE Editor, in order expand
the display of command files and EEPs?

The Right Margin is helpful in automatically displaying and wrapping long commands within the defined
screen, when "Word Wrap" and "Break Word at Right Margin" are both enabled.

Here's how:
01. Within the R:BASE Editor, select "Editor Settings" > "General" tab, and locate the "Break Word at
Right Margin" and "Word Wrap" check boxes in the right column.
02. Make sure both settings are enabled by clicking on the check box if it is empty.
03. While the "Editor Settings" is still displayed, select the "Display" tab and locate the "Right Margin"
field (default 80 characters).
04. Using the available arrow buttons or by typing the new value, increase the value anywhere from 100
to 125, based upon your available screen space on the right.
05. Click the "OK" button.

Where long R:BASE commands are listed, you will see the extra space become populated, allowing for
more of the command files to be displayed on the screen.

Have fun customizing the many options available within the R:BASE Editor!
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Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10428 or higher)
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12 Trace Debugger

12.1 Managing Watch Variables in TRACE Mode

While tracing R:BASE code, using the TRACE command, you may press the [F6] key to Add/Remove
Watch Variable(s) or simply right-click on the watch variables window to bring up the speed menu option,
and then select click on the Add/Remove Watch Variable(s).

Using the Add/Remove Variable(s) console window, typically, you would select/highlight the variable
from the list of Available 
Variables and then click on the right arrow [>] button to add.

Did you know that now you can Add/Remove variable(s) by using the double-click?

Supported Versions:
· R:BASE 7.6 (Build 7.6.3.30314 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.3.30314 or higher) for Windows 
· R:BASE Turbo (Build 8.0.16.30314 or higher) for Windows

12.2 Tracking Errors in the Trace Debugger

Did you know that the new Trace Debugger window now include a separate option to list all errors,
including the Error Number, File Name and Position?
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Supported Versions: 
· R:BASE 7.6 for Windows (Build: 7.6.7.30420 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.21.30420 or higher) 
· R:BASE eXtreme (v9) for Windows (Build: 9.0.1.10420 or higher)
·
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13 BLOB Editor

13.1 About the R:BASE eXtreme 9.1 BLOB Editor

The R:BASE BLOB Editor is an integrated data utility to manage Large OBjects (LOBs) and Binary Large
OBjects (BLOBs) within R:BASE.

LOBs are basically large ASCII data files. These objects refer to text files that can be in any ASCII
format, including RTF. The recommended data type for large text files is VARCHAR. Within the R:BASE
BLOB Editor, the LOB data is manipulated from the "RTF" and "Note/VarChar" tabs. A Hex Editor is also
available to manipulate binary data.

You can add, edit, or delete Binary Large Objects (BLOBs) within your database files. R:BASE recognizes
the following file formats for images: BMP, JPG, GIF, WMF, PCX, EPS, SVG, TIF, PNG, ICO, EMF, WMF,
and more. The R:BASE BLOB Editor has also been enhanced to manage multipage images. This
enhancement will allow users to manage multipage images, such as .DCX, .GIF, or .TIFF files, when
saved as BLOB data in R:BASE. The recommended data type for images is VARBIT.

The data for VARBIT and VARCHAR data types is stored in the fourth R:BASE database file.

13.1.1 Image

You can add, edit, or delete images (BLOBs) within your database files. The R:BASE BLOB Editor has
also been enhanced to manage multipage images. Drawing objects, like lines, boxes, text, etc., can also
be added to images.

R:BASE eXtreme 9.1 recognizes the following file formats for images: 
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File Format File Extension
TIFF Bitmap tif, tiff, fax, g3n, g3f, xif
CompuServe Bitmap gif
JPEG Bitmap jpg, jpeg, jpe, jif
PaintBrush pcx
Windows Bitmap bmp, dib, rle
Windows Icon ico
Windows Cursor cur
Portable Network Graphic png
Windows Metafile wmf
Enhanced Windows Metafile emf
Targa Bitmap tga, targa, vda, icb, vst, pix
Potable Pixmap, GrayMap, BitMap pxm, ppm, pgm, pbm
Wireless Bitmap wbmp
JPEG2000 jp2
JPEG2000 Code Stream j2k, jpc, j2c
Multipage PCX dcx
Camera RAW crw, cr2, nef, raw, pef, raf, x3f, bay, orf, srf, mrw, dcr, sr2
Photoshop PSD psd
Video for Windows avi
Mpeg mpeg, mpg
Windows Media Video wmv

13.1.1.1 Menu Bar

The Menu Bar within the "Images" tab provides many other advanced features to manage and
manipulate images.

File

· Open... - opens a dialog window to browse and select an image file
· Load from URL... - loads an image from a URL
· File Save - saves the current image as an external file

· Insert Image from File - inserts image(s)

· Delete Selected Images - deletes the selected image(s)

· Print Preview... - opens the Print Preview dialog for changing print-specific settings
· Select Source... - opens a window to select or change TWAIN sources 
· Acquire Pages... - starts the scan process of the current document

Edit

· Undo - undoes the last change made

· Redo - redoes the last "undo" operation

· Cut - cuts the current selection
· Copy - copies the current selection

· Paste - pastes the current clipboard selection

· Paste to Rectangle - inserts or pastes the currently cut or copied selection

View

· Histogram - displays a graphical representation of the tonal distribution

· Calculate Image Colors - provides the total number of colors in the active image
· Background Style - displays a style for the image background
· Background Color - specifies the background color
· Gradient End Color - specifies the background gradient end color, when gradient is selected
· Mouse Mode - changes the mouse mode for image editing 

Zoom

· Actual Size - zooms the image to the actual size

· Fit Image - fits the image to the current BLOB Editor window

· Fit to Width - fits the image to the current BLOB Editor window width
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· Fit to Height - fits the image to the current BLOB Editor window height

· Zoom In - zooms in

· Zoom Out - zooms out

· Zoom Properties - applies a zoom filter

Tools

· Color Adjust... - displays a dialog to adjust the color of the image
· Negative - replaces each pixel color with its opposite on the color wheel
· Grey Scale - converts the image to gray colors
· Reduce Colors... - reduces the number of images used. A prompt for the new image number will

appear.
· Convert to BW... - converts the image to black and white colors
· Convert to True Color - converts the image to a 24-bit color image
· Edge Detection - marks the points at which the intensity changes sharply
· Resize... - changes the size of the image

· Resample... - change the resolution of an image up or down

· Effects... - displays a dialog to add effects to the image
· White Balance - removes unrealistic color casts, so that objects in the image are rendered white just

as in person
· Rotate... - rotates an image around its center point
· Vertical Flip - flips an image vertically 
· Horizontal Flip - flips an image horizontally
· Remove Red Eyes - removes "red eye" from photos 
· Equalize - builds a histogram of colors used in all pixels in the image, from the brightest to the

darkest, and then alters colors of pixels in between so there is the same number of pixels at all
brightness levels

· Blur - reduces areas of high contrast and softens the appearance of an image

Annotations

· Draw Line - places a line drawing object

· Draw Box - places a box drawing object

· Draw Ellipse - places a ellipse drawing object

· Draw Text - places a text drawing object

· Draw Ruler - places a ruler drawing object

· Draw Polyline - places a polyline drawing object

· Draw Angle - places a angle drawing object

13.1.1.2 Toolbars

13.1.1.2.1  Image File

Button Description
Open...

Load From URL...

File Save...

Insert Image from File...

Delete Selected Images

Print Preview

Select Source...

Acquire Pages
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13.1.1.2.2  Image Mouse Mode

Button Description
Scroll

Zoom

Magic Wand

Ellipse Selection

Polygon Selection

Rectangular Selection

Select Object

13.1.1.2.3  Image Zoom

Button Description
Actual Size

Fit Image

Fit to Width

Fit to Height

Zoom In

Zoom Out

Zoom Properties...

13.1.1.2.4  Image Annotations

Button Description
Draw Line

Draw Box

Draw Ellipse

Draw Text

Draw Ruler

Draw Polyline

Draw Angle

13.1.1.2.5  Image Tools

Button Description
Color Adjust...

Negative

Grey Scale
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Reduce Colors...

Covert to BW... (black/white)

Covert to True Color

Edge Detection

Resize...

Resample...

Effects...

White Balance

Rotate...

Vertical Flip

Horizontal Flip

Remove Red Eyes

Equalize

Blur

13.1.1.2.6  Image Edit

Button Description
Undo

Redo

Cut

Copy

Paste

Paste to Rectangle

13.1.1.3 Color Adjust

When adjusting the color for an image, an original and resulting image is displayed to preview any
changes before they are saved. To remove the automatic preview, unselect the "Lock preview" check
box across the bottom of the window. 
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· Contrast - adjusts the Contrast and Brightness controls to lighten or darken the underlying layers and

change the amount of shading, or contrast, between areas. 

· HSV - adjusts the Hue, Saturation, and Value as related representations of points in an RGB color

space

· HSL - adjusts the Hue, Saturation, and Luminosity as related representations of points in an RGB color

space

· RGB - adjusts the Red, Green, Blue based upon the RGB color model

· Equalization - distributes the lightness values of the pixels more evenly across the light spectrum from

black to white

· FFT - (Fast Fourier Transform) converts the image from the image (spatial) domain to the frequency

domain

· Gamma correction - adjusts the the contrast and brightness in unison by using the red, green, and

blue check boxes adjust the image color balance 

· Sharpen - increases the contrast between adjacent pixels where there are significant color contrasts,

usually at the edges of objects
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13.1.1.4 Effects

· User filter - provides filter presets, with the ability to load and save custom filters  

· Bump map - creates a 3D effect by embossing an image and then mapping it to another image

· Lens - adds a lens filter to enhance depth

· Wave - distorts the image as if it had been disturbed by a number of waves

· Morphing filters - warps the image

· Rotate - rotates the image to an exact degree

13.1.1.5 Image Annotations

When adding or displaying images in the R:BASE BLOB Editor, annotations can be made using several
type of drawing tools. Objects include: 

· Line
· Box
· Ellipse
· Text
· Ruler
· Polyline
· Angle

Image Annotation Notes:

· After an object is added to the image, the properties will automatically display. Double clicking on
the object will redisplay the Properties dialog.

· When a field object is selected, small tan circles appear on the corners and sides or line ends,
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based upon the drawing object added. These circles are called handlebars which are used to
manipulate the size and location.

· Objects can be stretched, resized and/or manipulated by hovering the mouse cursor over and
dragging any of the available handlebars that are displayed upon the object's edges or end points.
The cursor will change to a double pointed arrow.

· Objects can be moved by hovering the mouse cursor along any line portion of the object between
the handlebars and dragging the mouse cursor. The cursor will change to a black four-pointed
cross. 

· After placing an object, any objects added after will use the same pen and brush properties, if the
setting applies.

· When placing a text object, "Draw Text" option, on an image and then clicking the "OK" button to
save the object properties, start typing your text. You will notice the text being displayed against a
grey background. 

· In order to save an image annotation, double click on the thumbnail (left side of the separator).
The change will then be visible in the thumbnail image. 

· Selecting the "OK" or "Cancel" buttons (lower right corner) of the R:BASE BLOB Editor will save or
cancel your changes accordingly.

13.1.1.5.1  Line

Pen Settings

Color - specifies the line color
Width - Specifies the line width
Style - specifies the line style

Brush Settings

Color - specifies the fill color for the
arrow start and end shapes, if defined
Style - specifies the fill style for the
arrow start and end shapes, if defined
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Start Shape - specifies the arrow start
shape for the line

End Shape - specifies the arrow end
shape for the line

The following object properties for a line were used to add the line object in the screen shot below.

Notice the handlebars on each end of the line that can be used to stretch or move the starting/ending
points for the arrow.
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13.1.1.5.2  Box

Pen Settings

Color - specifies the box border color 
Width - Specifies the box border width
Style - specifies the box border style

Brush Settings

Color - specifies the box fill color
Style - specifies the box fill style

The following object properties for a box were used to add the object in the screen shot below.
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Notice the handlebars on each corner, and between each corner, that can be used to stretch or move the
box.
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13.1.1.5.3  Ellipse

Pen Settings

Color - specifies the ellipse color 
Width - Specifies the ellipse width
Style - specifies the ellipse style

Brush Settings

Color - specifies the ellipse fill color
Style - specifies the ellipse fill style

The following object properties for an ellipse were used to add the object in the screen shot below.

Notice the handlebars at the corners and sides that can be used to stretch or move the ellipse.
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13.1.1.5.4  Text

Pen Settings

Color - specifies the text and border
color 
Width - Specifies the text border width
Style - specifies the text border style

Brush Settings

Color - specifies the text background
color
Style - specifies the text background
style

Font - specifies the text font type, size,
and style

After adding the Text object, the following object properties were used.
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The gray box is the input mode waiting for your text key entry.

With the above settings, the text is displayed in the screen shot below. Notice the handlebars at the
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corners and sides that can be used to stretch or move the text object.

13.1.1.5.5  Ruler

Pen Settings

Color - specifies the ruler line color 
Width - Specifies the ruler line width

Font - specifies the text font type, size,
and style

After adding the Ruler object, the following object properties were used.
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With the above settings, the ruler is displayed in the screen shot below.
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13.1.1.5.6  Polyline

Pen Settings

Color - specifies the polyline border
color 
Width - Specifies the polyline border
width
Style - specifies the polyline border style

The following object properties for a polyline were used to add the object in the screen shot below.

Notice the handlebars at the corners and sides that can be used to stretch or move the polyline.
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13.1.1.5.7  Angle

Pen Settings

Color - specifies the angle line color 
Width - Specifies the angle line width

Font - specifies the text font type, size,
and style

After adding the Angle object, the following object properties were used.
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Notice the handlebars at the end and corner that can be used to stretch or move the angle object.

13.1.1.6 Print Preview

The Print Preview screen allows the image print to be customized with the margins, size, location,
gamma correction, and the ability to print a selected image.
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13.1.1.7 Rotate

An image can be rotated within the R:BASE BLOB Editor. By selecting up/down arrows for the "Angle"
field, the image will rotate based upon the angle value.
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13.1.1.8 Zoom Properties

The Zoom properties allow for various filter methods for zooming in and out of large images.
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13.1.2 Note/VarChar

You can load, edit, and save Note/VarChar data within R:BASE. 

Toolbar

Button Description

Load From External File

Save To External File 

Print

Cut selected item

Copy selected item

Paste contents

Undo the last action

Search

Search and Replace

Show/Hide Right Margin

Word Wrap

f
Font...
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13.1.3 Rich Text

You can load, edit, and save RTF data within R:BASE. The "RTF" tab of the R:BASE BLOB Editor allows
many word processing capabilities for your RTF data.

Menu Bar

File 

· New - allows you to create a new file
· Open - opens an existing file
· Save - saves the current file
· Save As... - saves the current file as a new file
· Export - exports the current file to an RTF or text file
· Print Setup... - opens the Print Setup dialog for changing page specific settings
· Print Preview - opens the Print Preview dialog 
· Print - prints the current file to the default printer

Edit

· Undo - undoes the last change made
· Redo - reverses the effect of the last undo
· Cut - cuts the currently selected object(s)
· Copy - copies the currently selected object(s)
· Paste - pastes the currently cut or copied object(s)
· Paste Special - pastes text as Richview, rich text, text or Unicode format
· Make Line(s) Read-Only - current file becomes read-only or removes read-only status
· Find... - opens Find Text dialog box to locate text
· Find Next - locates the next text where matches search
· Replace... - opens Replace Text dialog box to locate and replace text

· Character Case - alters the case of the selected text

· Insert Page Break - adds a page break

· Remove Page Break - removes the page where the cursor is located
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· Select All - selects all of the items

Font

· Font - alters a text font type, size, style, effect, character spacing, horizontal spacing, and offset

· Style - alters the select text style

· Size - alters the selected text size

· Text Color - alters the text color

· Text Background Color - alters the text background color

Paragraph

· Paragraph - specifies paragraph indents, spacing, tabs, and text flow

· Paragraph Borders and Background - specifies paragraph border options and color settings 

· Align Left - aligns text to the left

· Align Center - aligns text to the center

· Align Right - aligns text to the right

· Justify - justifies text to fit within the window

· Bullets and Numbering - allows customized options for bulleted and numbered lists

· Bullets - adds list bullets to the selected text

· Numbering - adds list numbering to the selected text

· Word Wrap - specifies if text is wrapped within the window

· Decrease Indent - decreases the indent for text

· Increase Indent - increases the indent for text

· Single Line Spacing - enables single line spacing

· 1.5 Line Spacing - enables 1.5 line spacing

· Double Line Spacing - enables double line spacing

Format

· Background - adds an image to the background

· Background Color - specifies the entire background color

· Fill Color - specifies the fill color

· Object Properties - used to edit Table Properties

Insert

· File - inserts a rich text or text file

· Picture - inserts an image

· Horizontal Line - inserts a horizontal line

· Hypertext Link - adds a hypertext link

· Symbol - inserts a character symbol

· DB Label - inserts a database label for a column

· Variable Label - inserts a variable label for a defined variable

Table

· Insert Table - inserts a table

· Insert Column Left - inserts a column to the left of the cursor within the current table

· Insert Column Right - inserts a row to the right of the cursor within the current table

· Insert Row Above - inserts a row above the cursor within the current table

· Insert Row Below - inserts a row below the cursor within the current table

· Delete Rows - deletes the selected rows

· Delete Columns - deletes the selected columns

· Delete Table - deletes the current table

· Select - allows a table, the columns, rows, or all to be selected
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· Align - allows alignment options 

· Cell Borders - toggles the display of the table cell borders

· Split Cells - splits a current cell

· Merge Cells - merges the selected cells

· Show Grid Lines - toggles the display of the table grid lines

· Table Properties - displays the Table Properties

Toolbars

Button Description

New

Open

Save 

Print Preview

Print 

Find

Replace

Cut 

Copy 

Paste 

Undo

Redo

Picture

Insert Table

Hypertext Link

Nonprinting Characters

Button Description

Insert Column Left

Insert Column Right

Insert Row Above

Insert Row Below

Delete Column

Delete Table

Left Border

Right Border

Top Border

Bottom Border

All Borders

No Borders

Button Description

Font Style

Font Size

            
Bold, Italic, Underline, Strikeout, and Overline

         
Left, Center, Right, and Full Justify

Bullets

Numbering

   
Decrease Indent , Increase Indent
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Paragraph Background Color

13.1.4 Unicode/BSTR

The "Unicode/BSTR" tab allows the ability to see or edit binary string data. This tab is specific to R:BASE
eXtreme 9.1 (64) only.

Toolbar

Button Description

Open

Save

Print 

Undo

Cut

Copy

Paste  

Word Wrap

Font...
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13.1.5 Hex

The "Hex" tab allows the ability to see or edit the raw binary data. 

Toolbar

Button Description

New

Open

Save 

Undo

Redo

Copy

Cut  

Paste 

View

13.2 About the R:BASE 7.6/Turbo V-8 BLOB Editor

The enhanced R:BASE BLOB Editor includes four tab options to manage data appropriately:

· Images
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· RTF
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· Note/VarChar
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· Multipage Images



"Tip of the Day" Digest211

Copyright © 1982-2012 R:BASE Technologies, Inc.

So, how is the appropriate "tab" of the R:BASE BLOB Editor brought up when double-clicking on the
NOTE, VARCHAR, BITNOTE, or VARBIT data type columns in the Data Browser/DB Grid and Forms?

Here's the logic behind it:

1. When working with Data Browser/Editor and DB Grids;

Data Type R:BASE BLOB Editor "Tab" Page

NOTE Note/VarChar 

VARCHAR Images, RTF, Note/VarChar, Multipage Images 

BITNOTE Images, RTF, Note/VarChar, Multipage Images 

VARBIT Images, RTF, Note/VarChar, Multipage Images

For image types of DCX, TIFF and GIF, the default tab page is set to Multipage Images.

2. When working with Form Controls in Forms:

Form Control R:BASE BLOB Editor "Tab" Page

DB Memo Note/VarChar 

DB Rich Edit RTF 

DB Image Images, Multipage Images

For image types of DCX, TIFF and GIF, the default tab page is set to Multipage Images.

Supported Versions: 
· R:BASE 7.6 (Build 7.6.2.31211 or higher) for Windows 
· R:BASE Turbo (Build 7.6.2.31211 or higher) for Windows
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13.3 Customizing the BLOB Editor

Did you know that now you can customize the caption and icon of R:BASE BLOB Editor?

One of the more exciting features in R:BASE for Windows is the ability to add, edit, delete, and display
binary files-Binary Large OBjects, or BLOBs. This term refers to binary data as opposed to ASCII data.
The data types VARBIT and BITNOTE were added for storing binary files within an R:BASE database. In
addition, the VARCHAR data type lets you store large ASCII data files (Large OBjects, or LOBs). The
data for VARBIT and VARCHAR data types is stored in the fourth R:BASE data file, DBName.RB4 or
DBName.RX4.

In addition, you may also use R:BASE BLOB Editor to create a new or update an existing files, such as
RTF, BMP, TXT, JPG, GIF, PNG, and more...

While deploying R:BASE applications with integrated features of R:BASE BLOB Editor, now you can
customize the caption and icon. Here's how:

First, use the following PROPERTY commands to customize R:BASE BLOB Editor.

PROPERTY BLOB_EDITOR CAPTION ' This is the R:BASE you have always wanted!' 
PROPERTY BLOB_EDITOR ICON 'IntoTheFuture.ico'

Then, use the following command to create a new Rich Text File with your favorite logo into a singe table
column.

RBBE NewRTFFile.RTF

Notice the customized caption and icon for R:BASE BLOB Editor.

Note: R:BASE 7.6 and Turbo V-8 use standard R:BASE BLOB Editor. R:BASE eXtreme 9.0 (32/64) include
Enhanced R:BASE BLOB Editor as shown in the above illustration.

Supported Versions: 
· R:BASE 7.6 for Windows (Build: 7.6.7.30420 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.21.30420 or higher) 
· R:BASE eXtreme 9.0 for Windows (Build: 9.0.1.10420 or higher)
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13.4 Setting Rich Text Default Font for Blob Editor

Did you know that you can set the default font for Rich Text option of the R:BASE Blob Editor? Here's
how:

01. Start R:BASE eXtreme
02. Select "Settings" > "Blob Editor Settings ..." from the main Menu Bar. 

This is where you will define the default Font, Font Style, Size, Effects and Color for Rich Text.

Supported Versions: 
· R:BASE eXtreme 9.0 (Build: 9.0.1.10624 or higher) 



Part

XIV
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14 Commands

14.1 Assigning Line Numbers using the SELECT Command

Did you know that you can assign the line numbers for the SELECT command?

Use the (CVAL('ROWCOUNT')) function to achieve that goal.

Here's how:

1. Start R:BASE 
2. CONNECT ConComp
3. At the R> Prompt:

SELECT (INT(CVAL('ROWCOUNT'))) AS LineNo,Company=35, + 
(CustCity+','&CustState&CustZip)=35 AS CityStateZip FROM Customer

Notice the line counter!

4. If you would like to print that select statement output as PDF, use the following example:

SET VAR vLines = (INT(CVAL('LINES'))) 
SET LINES 0 
OUTPUT CustomerList.PDF PDF 
SELECT (INT(CVAL('ROWCOUNT'))) AS LineNo,Company=35, + 
(CustCity+','&CustState&CustZip)=35 AS CityStateZip FROM Customer 
OUTPUT SCREEN 
SET LINES .vLines

That will send the output as CustomerList.PDF using the "built-in" PDF capabilities of R:BASE OUTPUT
command.

Use the LAUNCH CustomerList.PDF command to view the results.

14.2 Attaching Server Tables as TEMPORARY Tables

Did you know that now you can attach server tables as TEMPORARY tables?

Among so many enhancements and features in R:BASE 7.6 and R:BASE Turbo V-8, the traditional
SATTACH command has been enhanced to include the option for attaching server tables as TEMPORARY.

Syntax:

SATTACH TEMPORARY tablename AS tablealias USING ...

The optional TEMPORARY parameter allows you to create a Temporary Table with the SATTACH
command and all supported parameters. The temporary tables will disappear when the database is
DISConnected. 

Use this option to take the exact snapshot of the sever table to manage and analyze the data as you
wish.

Note: 

Any changes made to the temporary table will not be reflected upon the original SQL data source. The
sole purpose of this enhancement is to let R:BASE attach server tables as TEMPORARY tables specific to
that User/R:BASE session even when the database is connected with STATICDB ON.
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14.3 Changing CASCADE Options

With prior versions/builds of R:BASE, if you have already added the CASCADE option to a table with a
Primary Key (PK) that automatically executes the UPDATE and DELETE options, and if you wish to
change the default option to UPDATE only, use the following command at the R> prompt:

ALTER TABLE <PKtablename> ADD CASCADE UPDATE

This will change the CASCADE option to UPDATE only.

If you wish to change the default option to DELETE only, use the following command at the R> prompt:

ALTER TABLE <PKtablename> ADD CASCADE DELETE

If you wish to change the default option to both, use the following command at the R> prompt:

ALTER TABLE <PKtablename> ADD CASCADE

And finally, if you wish to cancel the CASCADE option altogether, use the following command at the R>
prompt:

ALTER TABLE <PKtablename> DROP CASCADE

You may also implement these options using the enhanced R:BASE Data Designer (RBDEFine).

14.4 Changing Report Margins Using the PRINT Command

Did you know that you can change the report margins dynamically using the enhanced PRINT command
with the "margin" parameters?

Here's how:

Four additional PRINT OPTION parameters are now supported to change Left, Top, Right and Bottom
margins of report.

Syntax:

PRINT reportname OPTION outputvalue|MARGIN_xxxx nnn

Where:

outputvalue is the parameter such as SCREEN, PRINTER, BMP, EMF, ETXT, GIF, HTML, JPG, PDF, RTF,
TIFF, TXT, WMF, XHTML, or XLS.

MARGIN_xxxx are the parameters for:
· MARGIN_LEFT 
· MARGIN_TOP 
· MARGIN_RIGHT 
· MARGIN_BOTTOM

nnn is the REAL data type value; such as 0.5, 1.0, or 0.75

MARGIN_LEFT - specifies the horizontal position on the page where printing should begin. All report
component positions are relative to the margin. In other words, if the MARGIN_LEFT parameter is set to
0.25 inches and you place a report component in a band and set the component's "left" parameter to 0,
then that component will print 0.25 inches from the edge of page (or at the left margin).

MARGIN_TOP - specifies the vertical position on the page where printing should begin. All report
component positions are relative to the margin. In other words, if the MARGIN_TOP parameter is set to
0.25 inches and you place a report component in a band and set the component's "top" parameter to 0,
then that component will print 0.25 inches from the edge of page (or at the top margin).
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MARGIN_RIGHT - specifies the horizontal position on the page where printing should stop. All report
component positions are relative to the margin.

MARGIN_BOTTOM - specifies the vertical position on the page where printing should stop. All report
component positions are relative to the margin.

-- Example 01: 
PRINT CustomerList OPTION PRINTER|MARGIN_LEFT 1.25

-- Example 02: 
PRINT CustomerList OPTION PRINTER|MARGIN_TOP 0.50

-- Example 03: 
PRINT CustomerList OPTION PRINTER|MARGIN_RIGHT 0.75

-- Example 04: 
PRINT CustomerList OPTION PRINTER|MARGIN_BOTTOM 0.50

-- Example 05: 
PRINT CustomerList OPTION PRINTER + 
|MARGIN_LEFT 1.25 + 
|MARGIN_TOP 0.50 + 
|MARGIN_RIGHT 0.75 + 
|MARGIN_BOTTOM 0.50

Supported Versions: 
· R:BASE 7.6 (Build 7.6.2.31224 or higher) for Windows 
· R:BASE (C/S:I) 7.6 (Build 7.6.2.31224 or higher) for Windows 
· R:BASE Turbo (Build 7.6.2.31224 or higher) for Windows

14.5 Changing the Caption of Plugin Buttons

Did you know that you can customize the default captions of the LoadFileNamePlusPlus.RBL Plugin
buttons to suit your application?

Here's how:

Use the following additional options:

OK_BUTTON_CAPTION <value> - to change "OK" button caption 

CANCEL_BUTTON_CAPTION <value> - to change "CANCEL" button caption.

Background:

The LoadFileNamePlusPlus.rbl Plugin is used to load a file name into a variable by displaying a dialog
window for the user to browse the operating system.

The LoadFileNamePlusPlus.rbl Plugin allows all the same parameters from previous "LoadFileName"
Plugins, only this version return a list of variable values after a file or files are selected. It does not
appear in the R:BASE for Windows Plugins Menu.

Syntax:

PLUGINS LoadFileNamePlusPlus.rbl VarName|<options>
Options:
FULLPATH (ON/OFF) 
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TITLE <value> 
VIEW_MODE <value> 
THUMBNAILS 
TILES 
ICONS (Default) 
LIST 
DETAILS 
FILTER <value> 
INITIAL_DIR <value> 
MULTISELECT (ON/OFF) 
SHOW_HIDDEN (ON/OFF) 
NO_LONG_NAMES (ON/OFF) 
NO_NETWORK_BUTTON (ON/OFF) 
HIDE_READ_ONLY (ON/OFF) 
NO_DEREFERENCE_LINKS (ON/OFF) 
DONT_ADD_TO_RECENT (ON/OFF) 
ENABLE_SIZING (ON/OFF) 
OLD_STYLE (ON/OFF) 
NO_VALIDATE (ON/OFF) 
OK_BUTTON_CAPTION <value> - to change "OK" button caption 
CANCEL_BUTTON_CAPTION <value> - to change "CANCEL" button caption

Where:

VarName is the variable name to return text results 
Returned Variables: 

vLFNFileCount = 1 INTEGER 
vLFNFileName1 = C:\RBTI\RBG75\Samples\RRBYW10\CustList.jpg TEXT 
vLFNFilePath1 = C:\RBTI\RBG75\Samples\RRBYW10\ TEXT 
vLFNFileNameS1 = CustList.jpg TEXT 
vLFNFileExt1 = .jpg TEXT 
vLFNFileDT1 = 12/14/2006 4:15:00 PM TEXT 
vLFNFileSize1 = 5018 INTEGER

Notes:

Each parameter must be separated by the pipe "|" symbol. A value of '[Esc]' will be returned if the
[Cancel] button or Close Window [x] option is clicked on the file selection dialog.

The LoadFileNamePlusPlus.rbl Plugin is included with exclusive collection of R:BASE Plugin Power Pack.

14.6 Converting 6.5++ Databases to Turbo V-8

The TURBO command in R:BASE Turbo V-8 is intended to UPGRADE your existing R:BASE 7.x database
to Turbo V-8, including all 
R:BASE 7.x Forms, Labels, Layouts and Reports. 

However, if you need to jump directly from 6.5++ for Windows to R:BASE Turbo V-8 for Windows, you
may use the alternative method of building an R:BASE Turbo V-8 database from the R:BASE 6.5++
structure and data using the traditional UNLOAD ALL command.

Here' how:

1. Start R:BASE 6.5++ for Windows and connect to the database
2. Check the IDQUOTE settings of connected database:

At the R> Prompt:

SHOW CHARACTERS
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Notice the last parameter, IDQUOTES

If IDQUOTES is set to NULL, you'll need to change NULL to the appropriate character, such as `
(reversed quote) as following:

SET IDQUOTES=`

3. Unload the entire database:

At the R> Prompt:

SET NULL -0- 
OUTPUT filename.ALL 
UNLOAD ALL 
OUTPUT SCREEN

This process will create two files (filename.ALL and filename.LOB)

4. Disconnect the database:

At the R> Prompt:

DISCONNECT

5. Now Start R:BASE Turbo V-8 (default: C:\RBTI\RBG8\RBG8.exe)

Switch the default directory to the folder with filename.ALL and filename.LOB files.

At the R> prompt of R:BASE Turbo V-8:

RUN filename.ALL

This step will build a clean database to be used exclusively by R:BASE V-8 Turbo.

New database files will have the following extensions:

dbname.RX1 
dbname.RX2 
dbname.RX3 
dbname.RX4

X = eXtended

The LIST DATABASE command at the R> prompt will only list Turbo V-8 database(s) in that folder.

All R:BASE 6.5++ for Windows Forms, Reports, and Labels can be converted to Turbo V-8 for Windows
using the "Convert" option from appropriate module of Database Explorer.

Once the database is converted, it can only be connected using R:BASE V-8 Turbo.

14.7 Converting RTF to Plain TEXT, NOTE or VARCHAR

Did you know that you can convert Rich Text Format (RTF) data to a plain TEXT, NOTE or VARCHAR data
using the RTFtoTEXT.RBL 
Plugin?

Syntax: (Four Different Scenarios)
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-- (01.) When Input/Output Data is a VARIABLE 

PLUGIN RRTFtoTXT.RBL vResult + 
|INPUT_TYPE VARIABLE + 
|INPUT_VARIABLE inputvarname + 
|OUTPUT_TYPE VARIABLE + 
|OUTPUT_VARIABLE outputvarname + 
|OUTPUT_DATA_TYPE value

WHERE: 
· vResult is the resulting message value, such as, "OK" or the actual "-ERROR- message"
· INPUT_VARIABLE inputvarname is the input RTF data as variable 
· OUTPUT_VARIABLE outputvalue is the resulting output variable name with converted data 
· OUTPUT_DATA_TYPE value is the data type (TEXT, NOTE, or VARCHAR)

-- (02.) When Input/Output Data is an external FILE 

PLUGIN RRTFtoTXT.RBL vResult + 
|INPUT_TYPE FILE + 
|INPUT_FILE inputfilename.rtf + 
|OUTPUT_TYPE FILE + 
|OUTPUT_FILE outputfile.txt + 
|OUTPUT_DATA_TYPE value

WHERE: 
· vResult is the resulting message value, such as, "OK" or the actual "-ERROR- message"
· INPUT_FILE inputfilename.rtf is the input RTF file name 
· OUTPUT_FILE outputfilename.txt is the resulting output file with converted data 
· OUTPUT_DATA_TYPE value is the data type (TEXT, NOTE, or VARCHAR)

-- (03.) When Input is a VARIABLE and Output is an external FILE 

PLUGIN RRTFtoTXT.RBL vResult + 
|INPUT_TYPE VARIABLE + 
|INPUT_VARIABLE inputvarname + 
|OUTPUT_TYPE FILE + 
|OUTPUT_FILE outputfilename.txt + 
|OUTPUT_DATA_TYPE value 

WHERE: 
· vResult is the resulting message value, such as, "OK" or the actual "-ERROR- message"
· INPUT_VARIABLE inputvarname is the input RTF data as variable 
· OUTPUT_FILE outputfilename.txt is the resulting output file with converted data 
· OUTPUT_DATA_TYPE value is the data type (TEXT, NOTE, or VARCHAR)

-- (04.) When Input is a an external FILE and Output is a VARIABLE 

PLUGIN RRTFtoTXT.RBL vResult + 
|INPUT_TYPE FILE + 
|INPUT_FILE inputfilename.rtf + 
|OUTPUT_TYPE VARIABLE + 
|OUTPUT_VARIABLE outputvarname + 
|OUTPUT_DATA_TYPE value 

WHERE: 
· vResult is the resulting message value, such as, "OK" or the actual "-ERROR- message"
· INPUT_FILE inputfilename.rtf is the input RTF file name 
· OUTPUT_VARIABLE outputvarname is the resulting output variable name with converted data 
· OUTPUT_DATA_TYPE value is the data type (TEXT, NOTE, or VARCHAR)
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Examples:

-- ConvertingRTF_to_TEXT.RMD 
-- Author: A. Razzak Memon 
-- Date Created: January 16, 2007 
-- Converting _NOTE_VARCHAR.RMD 
-- To be used with R:BASE 7.6 for Windows 
-- Required Plugin: 
-- RRTFtoTXT76.RBL in C:\RBTI\RBG76 or application .EXE folder

IF (CVAL('DATABASE')) <> 'RTFtoTXT' OR (CVAL('DATABASE')) IS NULL THEN 
CONNECT RTFtoTXT IDENTIFIED BY NONE 

ENDIF
LABEL Start 
CLS 
CLEAR VARIABLES iv%,vRecordID,vRTFData,vTextData,vNoteData, + 
vVarCharData,vResult 

SET VARIABLE vRecordID INTEGER = 2 
SET VARIABLE vRTFData VARCHAR = NULL 
SET VARIABLE vTextData TEXT = NULL 
SET VARIABLE vNoteData NOTE = NULL 
SET VARIABLE vVarCharData VARCHAR = NULL 
SET VARIABLE vResult TEXT = NULL
SELECT RecordID,RTFData INTO + 
vRecordID INDICATOR ivRecordID, + 
vRTFData INDICATOR ivRTFData + 
FROM RTFData WHERE RecordID = .vRecordID

-- Converting RTF Data to TEXT 

PLUGIN RRTFtoTXT76.RBL vResult + 
|INPUT_TYPE VARIABLE + 
|INPUT_VARIABLE vRTFData + 
|OUTPUT_TYPE VARIABLE + 
|OUTPUT_VARIABLE vTextData + 
|OUTPUT_DATA_TYPE TEXT 

IF vResult <> 'OK' THEN 
PAUSE 2 USING .vResult ICON ERROR 

ELSE 
INSERT INTO TextData VALUES (.vRecordID,.vTextData) 

ENDIF

-- Converting RTF Data to NOTE 

PLUGIN RRTFtoTXT76.RBL vResult + 
|INPUT_TYPE VARIABLE + 
|INPUT_VARIABLE vRTFData + 
|OUTPUT_TYPE VARIABLE + 
|OUTPUT_VARIABLE vNoteData + 
|OUTPUT_DATA_TYPE NOTE 

IF vResult <> 'OK' THEN 
PAUSE 2 USING .vResult ICON ERROR 

ELSE 
INSERT INTO NoteData VALUES (.vRecordID,.vNoteData) 

ENDIF

-- Converting RTF Data to VARCHAR 

PLUGIN RRTFtoTXT76.RBL vResult + 
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|INPUT_TYPE VARIABLE + 
|INPUT_VARIABLE vRTFData + 
|OUTPUT_TYPE VARIABLE + 
|OUTPUT_VARIABLE vVarCharData + 
|OUTPUT_DATA_TYPE VARCHAR 

IF vResult <> 'OK' THEN 
PAUSE 2 USING .vResult ICON ERROR 

ELSE 
INSERT INTO VarCharData VALUES (.vRecordID,.vVarCharData) 

ENDIF
LABEL Done 
CLEAR VARIABLES iv%,vRecordID,vRTFData,vTextData,vNoteData, + 
vVarCharData,vResult 

RETURN

A sample application is also available at: 
http://www.razzak.com/sampleapplications/

14.8 Clearing Stubborn Table Locks

In a multi-user environment, have you ever been in a situation where a table is left locked and you have
no way to clear the lock(s), even knowing that there is no one out there using the same database?

Well, now you have the option to clear those stubborn table locks by simply using the *new* CLEAR
TABLE LOCKS command.

Here's how:

DISCONNECT 
SET MULTI OFF 
CONNECT dbname 
CLEAR TABLE LOCKS

This will CLEAR all stubborn table locks.

14.9 Creating/Editing RTF Files Outside the Database

Did you know that you can create and/or edit RTF file(s) outside the R:BASE 7.x database?

Use the new RBBEDIT command at the R> Prompt, in a Command File or in an EEP.

Example:

RBBEDIT ThePowerOfRBASE.RTF

or

RBBE ThePowerOfRB.RTF

14.10 Customizing DIALOG POPUP Colors

Did you know that you can customize the DIALOG POPUP colors to match your custom application
theme?

Here's how:

http://www.razzak.com/sampleapplications/
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Example 01:
-- Start 
-- DIALOG_POPUP_CustomColors_Razzmatazz.RMD 
-- Supported Versions: R:BASE 7.6 and Turbo V-8 for Windows 
-- Theme: Razzmatazz 
IF (CVAL('DATABASE')) <> 'RRBYW14' OR (CVAL('DATABASE')) IS NULL THEN 
CONNECT RRBYW14 IDENTIFIED BY NONE 

ENDIF 
CLEAR VARIABLES vCustIDTxt,vCustID,vEndKey 
SET VAR vCustIDTxt TEXT = NULL 
SET VAR vCustID INTEGER = NULL 
SET VAR vEndKey TEXT = NULL 
CLS 
DIALOG 'Enter a Customer ID' vCustIDTxt=8 vEndkey 1 + 
CAPTION 'DIALOG Custom Colors' + 
OPTION THEMENAME Razzmatazz + 
|POPUP_ENABLED TRUE + 
|POPUP_DIALOG_TYPE LOOKUP + 
|DIALOG_EDIT_HINT Double-click for a List + 
|POPUP_CAPTION CustID Selection + 
|POPUP_TITLE_TEXT Select a Customer + 
|POPUP_TABLE Customer + 
|POPUP_SELECT Company + 
|POPUP_WHERE ORDER BY Company + 
|POPUP_RETURN_COLUMN CustID + 
|POPUP_WINDOW_BACK_COLOR [R218,G228,B246] + 
|POPUP_LIST_BACK_COLOR [R218,G228,B246] + 
|POPUP_LIST_FONT_COLOR NAVY + 
|POPUP_LIST_FONT_NAME ARIAL + 
|POPUP_LIST_FONT_SIZE 10 + 
|POPUP_LIST_FONT_BOLD ON + 
|POPUP_TITLE_BACK_COLOR [R218,G228,B246] + 
|POPUP_TITLE_FONT_COLOR NAVY + 
|POPUP_TITLE_FONT_NAME ARIAL + 
|POPUP_TITLE_FONT_SIZE 10 + 
|POPUP_TITLE_FONT_BOLD ON + 
|POPUP_LINES 16 

-- Do what you have to do here ... 
RETURN 
-- End

Example 02:
-- Start 
-- DIALOG_POPUP_CustomColors_RBASERocks.RMD 
-- Supported Versions: R:BASE 7.6 and Turbo V-8 for Windows 
-- Theme: R:BASE Rocks! 
IF (CVAL('DATABASE')) <> 'RRBYW14' OR (CVAL('DATABASE')) IS NULL THEN 
CONNECT RRBYW14 IDENTIFIED BY NONE 

ENDIF 
CLEAR VARIABLES vCustIDTxt,vCustID,vEndKey 
SET VAR vCustIDTxt TEXT = NULL 
SET VAR vCustID INTEGER = NULL 
SET VAR vEndKey TEXT = NULL 
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CLS 
DIALOG 'Enter a Customer ID' vCustIDTxt=8 vEndkey 1 + 
CAPTION 'DIALOG Custom Colors' + 
OPTION THEMENAME R:BASE Rocks! + 
|POPUP_ENABLED TRUE + 
|POPUP_DIALOG_TYPE LOOKUP + 
|DIALOG_EDIT_HINT Double-click for a List + 
|POPUP_CAPTION CustID Selection + 
|POPUP_TITLE_TEXT Select a Customer + 
|POPUP_TABLE Customer + 
|POPUP_SELECT Company + 
|POPUP_WHERE ORDER BY Company + 
|POPUP_RETURN_COLUMN CustID + 
|POPUP_WINDOW_BACK_COLOR 2708091 + 
|POPUP_LIST_BACK_COLOR 2708091 + 
|POPUP_LIST_FONT_COLOR WHITE + 
|POPUP_LIST_FONT_NAME ARIAL + 
|POPUP_LIST_FONT_SIZE 10 + 
|POPUP_LIST_FONT_BOLD ON + 
|POPUP_TITLE_BACK_COLOR 2708091 + 
|POPUP_TITLE_FONT_COLOR WHITE + 
|POPUP_TITLE_FONT_NAME ARIAL + 
|POPUP_TITLE_FONT_SIZE 10 + 
|POPUP_TITLE_FONT_BOLD ON + 
|POPUP_LINES 16 

-- Do what you have to do here ... 
RETURN 
-- End

Supported Versions: 
· R:BASE 7.6 for Windows (Build: 7.6.1.30806 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.1.30806 or higher) 
· R:BASE Turbo V-8 (Build: 8.0.15.30806 or higher)

14.11 Customizing the PRNSETUP Dialog

Did you know that you can customize the PRNSETUP box, and use themes to match your Form,
Application, #WHERE, CHOOSE, DIALOG and PAUSE windows?

Try the following examples which demonstrate the use of PRNSETUP command to match your Form,
Application, #WHERE, CHOOSE, DIALOG and PAUSE themes.

Example 01: 

--(Changing Printer and then showing the window) 
PRNSETUP 'Adobe PDF' 
PRNSETUP 
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Example 02: 

-- (Customizing Caption) 
PRNSETUP OPTION CAPTION Select Printer 

Example 03: 
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-- (Customizing Caption with R:BASE eXtreme 9.1 Theme) 
PRNSETUP OPTION CAPTION Select Printer|THEMENAME Vista CG 

Notes:

01. If you use a printer name that does not exist there will be no error and the current printer will not be
changed.
02. Use RBTI_PRNSETUP variable to capture user action. When using the PRNSETUP window, clicking on
[OK] button will return the value of RBTI_PRNSETUP as "OK". When using the PRNSETUP window, clicking
on [Cancel] button will return the value of RBTI_PRNSETUP as "CANCEL".
03. Use PRNSETUP INFO command at the R> prompt for detailed info on your currently selected printer.
04. For complete details, PRNSETUP parameters and OPTIONs: HELP PRNSETUP

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10428 or higher)

14.12 Defining Font Name/Size with OUTPUT PRINTER

Did you know that you can define the font name and size when using the OUTPUT PRINTER command?

R:BASE 7.x, Turbo V-8, or R:BASE eXtreme (v9.0) allows you to define font name and font size when
using the OUTPUT PRINTER command at the R> prompt, in a command file or in an EEP used in Forms,
Reports and Labels.

Example 01 

CONNECT RRBYW14 
SET LINES 0 
SET WIDTH 120 
SET NULL ' ' 
OUTPUT PRINTER FONTNAME COURIER FontSize 9 
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SELECT + 
Company=38 AS `Company Name`, + 
CustAddress=32 AS `Address`, + 
(CustCity+','&CustState&CustZip)=30 AS `City, State and Zip` + 
FROM Customer ORDER BY Company 
OUTPUT SCREEN 
SET LINES 20 
SET WIDTH 79

Example 02 

CONNECT RRBYW14 
SET LINES 0 
SET WIDTH 120 
SET NULL ' ' 
OUTPUT PRINTER FONTNAME COURIER FontSize 8 
SELECT + 
Company=38 AS `Company Name`, + 
CustAddress=32 AS `Address`, + 
(CustCity+','&CustState&CustZip)=30 AS `City, State and Zip`, + 
CustPhone=14 AS `Phone Number` + 
FROM Customer ORDER BY Company 
OUTPUT SCREEN 
SET LINES 20 
SET WIDTH 70

Supported Versions:
· R:BASE 7.6 for Windows (Build:7.6.5.31125 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build:7.6.5.31125 or higher) 
· R:BASE Turbo V-8 for Windows (Build:8.0.19.31125 or higher) 
· R:BASE eXtreme for Windows (Build:9.0.1.31125 or higher)

14.13 Differentiating Between Regular and Temporary Tables/Views

RBG7 Beta Update 36 includes the new feature of differentiating between Regular and Temporary
Tables/Views when using the LIST or LIST TABLES command at the R> prompt.

To safely indicate which tables are temporary tables in the LIST or LIST TABLES command, you will now
see a "(T)" in front of the table 
name.

Example:

1. Launch R:BASE

2. CONNECT Concomp

3. Switch to R> Prompt and create a TEMPorary table as following:

PROJECT TEMP tCustomer FROM Customer USING ALL
LIST TABLES

You will notice the (T) in front of the tCustomer table.

4. Now create a TEMPorary VIEW as following:
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CREATE TEMP VIEW `tYTDInvoiceTotal` + 
(CustID, YTDInvoiceTotal) AS + 
SELECT CustID,(SUM(InvoiceTotal)) FROM TransMaster + 
GROUP BY CustID 

COMMENT ON VIEW `tYTDInvoiceTotal` IS + 
'Year-To-Date Invoice Total by Customer'

LIST

You will notice (T) in front of the tYTDInvoiceTotal view.

Note: All TEMPorary Tables/View created during individual R:BASE session disappear when the database
is DISConnected.

14.14 Displaying Longer Table/Column Names in Turbo V-8

Using R:BASE Turbo V-8 for Windows, if you have a table or column name that is more than the
traditional 18 characters wide, and if you wish to display a list of TABLES or COLUMNS, use the
NAMEWIDTH setting.

The default setting for this exclusive NAMEWIDTH option in R:BASE Turbo V-8 is set to 18. However, you
can change the name width to display table or columns names that are more than 18 characters to list
them accordingly.

Syntax:

SET NAMEWIDTH nnn

Example:

SET WIDTH 120 
SET NAMEWIDTH 40 
SET LINES 0 
LIST COLUMNS

14.15 Encrypting an UNLOADed DATA File

Traditionally, the UNLOAD command is used to unload the structure, data, structure with data, forms,
labels or reports to a specified OUTPUT file. Depending on the option used, the UNLOAD command also
creates a LOB file with matching output file name.

Typically, you can view the entire ASCII unloaded data using text editor. However, it becomes critical
when the unloaded file contains sensitive data, including owner and user passwords, etc.

Did you know that you can encrypt the entire file using the new built-in 512-bit ENCRYPT option in R:
BASE 7.6, C/S:I 7.6 and Turbo V-8 for Windows?

Example 01: 

CONNECT RRBYW14 
OUTPUT rrbyw14.str ENCRYPT mypassword 
UNLOAD STRUCTURE 
OUTPUT SCREEN

This will create an encrypted password-protected structure file (rrbyw14.str).

Example 02: 
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CONNECT RRBYW14 
OUTPUT rrbyw14.all ENCRYPT mypassword 
UNLOAD ALL 
OUTPUT SCREEN

This will create an encrypted password-protected data rrbyw14.all and rrbyw14.lob file.

Example 03: 

CONNECT RRBYW14 
OUTPUT employee.asc ENCRYPT mypassword 
UNLOAD DATA FOR Employee USING + 
EmpID,EmpFName,EmpLName,EmpAddress,EmpAddress2,EmpCity,EmpState, + 
EmpZip,EmpPhone,HireDate,EntryDate,EMailAddress AS ASCII 
OUTPUT SCREEN

This will create an encrypted password-protected ascii employee.asc file.

While using the built-in RBEdit or external R:BASE Editor 7.6, you may also create/edit any external
command file/EEP and add the encryption by using the "Add Encryption" when saving or using the "Save
As" option.

An output file created with "ENCRYPT yourpassword" option can only be opened using any version of R:
BASE for Windows (listed below) or R:BASE Editor 7.6 and higher.

Attempting to edit or run the encrypted file will prompt you to enter the appropriate password.

Supported Versions: 
· R:BASE 7.6 and C/S:I 7.6 for Windows 
· R:BASE Turbo V-8 for Windows

14.16 Enhanced DIALOG Command

Did you know that you can include end-user "hints", apply a "theme", and use "lookup" options for pop-
up menus when using the DIALOG command? These are just a few new enhancements in the DIALOG
command.

When you double-click on the DIALOG edit box, not only can you bring up the customized lookup pop-up
menus, but when you hover your mouse cursor over the dialog edit box, the hint can be displayed.

Here's how:

1. DIALOG_EDIT_HINT value, specifies the hint.
2. POPUP_ENABLED (ON/OFF), enables the option of bringing up a custom pop-up menu when using

the double-click.
3. POPUP_DIALOG_TYPE value, specifies the Pop-up type when double-clicking on the DIALOG edit

box.

Example: (Dialog with Hint and Pop-ups as Lookup)

-- Dialog_With_Hint_And_Popups_As_Lookup.RMD 

-- Popup Dialog Type: LOOKUP 

-- Along with DIALOG_EDIT_HINT value ...
CONNECT RRBYW10
CLEAR VAR vCaption,vResponse,vEndKey,vCustID,vRows, +
ivRows,vPauseMessage 

SET VAR vCaption TEXT = 'DIALOG with Hint and Pop-up Menus' 
SET VAR vResponse TEXT = NULL 
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SET VAR vEndkey TEXT = NULL 
SET VAR vCustID INTEGER = NULL 
SET VAR vRows INTEGER = NULL 
SET VAR vPauseMessage TEXT = NULL
LABEL GetCustID 
CLS 
DIALOG 'Enter Customer ID' vResponse=33 vEndKey 1 + 
CAPTION .vCaption + 
ICON APP + 
OPTION DIALOG_EDIT_HINT Double-Click for List of Customers + 
|POPUP_ENABLED TRUE + 
|POPUP_DIALOG_TYPE LOOKUP + 
|POPUP_TITLE_FONT_NAME VERDANA + 
|POPUP_TITLE_FONT_SIZE 9 + 
|POPUP_TITLE_FONT_BOLD TRUE + 
|POPUP_TITLE_FONT_COLOR WHITE + 
|POPUP_TITLE_BACK_COLOR 5142690 + 
|POPUP_TITLE_TEXT Select Customer + 
|POPUP_LIST_FONT_COLOR WHITE + 
|POPUP_LIST_BACK_COLOR 5142690 + 
|POPUP_CAPTION List of Customers + 
|POPUP_TABLE Customer + 
|POPUP_SELECT Company,CustCity+','&CustState&CustZip + 
|POPUP_RETURN_COLUMN CustID + 
|POPUP_WHERE ORDER BY Company + 
|POPUP_SHOW_LINES TRUE + 
|POPUP_RETURN_TYPE COLUMN + 
|POPUP_LINES 20 + 
|POPUP_DISTINCT TRUE + 
|THEMENAME R:BASE Rocks!

IF vEndKey = '[Esc]' THEN 
GOTO Done 

ENDIF
IF vResponse IS NULL THEN 
PAUSE 2 USING 'Missing Customer ID!' + 
CAPTION .vCaption ICON STOP + 
BUTTON 'Click here to enter Customer ID again ...' + 
OPTION BACK_COLOR WHITE + 
|MESSAGE_COLOR WHITE + 
|MESSAGE_FONT_NAME Verdana + 
|MESSAGE_FONT_COLOR RED + 
|MESSAGE_FONT_SIZE 9 + 
|MESSAGE_FONT_BOLD ON + 
|MESSAGE_FONT_ITALIC OFF + 
|MESSAGE_FONT_STRIKEOUT OFF + 
|BUTTON_COLOR WHITE + 
|BUTTON_FONT_COLOR GREEN 

GOTO GetCustID 
ENDIF 
SET VAR vCustID = (INT(.vResponse)) 
CLS 
SELECT COUNT(*) INTO vRows INDIC ivRows FROM + 
Customer WHERE CustID = .vCustID 
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IF vRows > 0 THEN 
SET VAR vFormMode = 'EDIT' 

EDIT USING Customers WHERE CustID = .vCustID 
ENDIF 
SET VAR vResponse = NULL 
SET VAR vCustID = NULL 
GOTO GetCustID
LABEL Done 
CLEAR VAR vCaption,vResponse,vEndKey,vCustID,vRows, + 
ivRows,vPauseMessage 

RETURN 

Customize or modify above code to meet your needs. 

For more details, options and examples, please refer to:

From The Edge: http://www.razzak.com/fte 
Topic: All About DIALOG Command

14.17 Finding the Row Size using the RRowSize.RBL Plugin

Here's how to find Row Size using RRowSize.RBL Plugin.

You may integrate this technique in your own database/application.

Example 01:

-- Start 
IF (CVAL('DATABASE')) <> 'RRBYW14' OR (CVAL('DATABASE')) IS NULL THEN 
CONNECT RRBYW14 IDENTIFIED BY NONE 

ENDIF
LABEL Start 
CLEAR VAR vTableName,vRowSize,vString,vPauseMessage,vYesNo,vCaption,
vEndKey 
SET VAR vTableName TEXT = NULL 
SET VAR vRowSize INTEGER = NULL 
SET VAR vString TEXT = NULL 
SET VAR vPauseMessage TEXT = NULL 
SET VAR vYesNo TEXT = 'No' 
SET VAR vCaption TEXT = ' Finding Row Size - Select Table Name' 
CLS 
CHOOSE vTableName FOR #TABLES + 
CHKBOX 1 + 
TITLE 'Select a table and then click on [OK] button to continue' + 
CAPTION .vCaption LINES 19 FORMATTED + 
OPTION LIST_FONT_COLOR MAROON + 
|TITLE_FONT_COLOR MAROON + 
|TITLE_BACK_COLOR [R234,G234,B234] + 
|WINDOW_BACK_COLOR [R234,G234,B234] + 
|TITLE_FONT_SIZE 10 + 
|TITLE_FONT_NAME VERDANA + 
|LIST_BACK_COLOR [R234,G234,B234] + 
|BUTTONS_SHOW_GLYPH ON + 
|THEMENAME R:BASE Rocks! 

IF vTableName = '[Esc]' THEN 

http://www.razzak.com/fte
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GOTO Done 
ENDIF 
IF vTableName IS NULL THEN 

PAUSE 2 USING 'Table NOT Selected!' + 
CAPTION .vCaption ICON STOP + 
BUTTON 'Click here to select a table ...' + 
OPTION BACK_COLOR WHITE + 
|MESSAGE_COLOR WHITE + 
|MESSAGE_FONT_NAME Verdana + 
|MESSAGE_FONT_COLOR RED + 
|MESSAGE_FONT_SIZE 10 + 
|MESSAGE_FONT_BOLD ON + 
|MESSAGE_FONT_ITALIC OFF + 
|MESSAGE_FONT_STRIKEOUT OFF + 
|BUTTON_COLOR WHITE + 
|BUTTON_FONT_COLOR GREEN + 
|THEMENAME R:BASE Rocks! 

GOTO Start 
ENDIF 
SET VAR vString = ('vRowSize|TABLE_NAME'&.vTableName) 
PLUGIN RRowSize76.RBL &vString 
SET VAR vPauseMessage = + 
((CHAR(013))+'Table Name:'+(CHAR(009))&.vTableName+(CHAR(013))+ + 
'Row Size:'+(CHAR(009))&(CTXT(.vRowSize))) 

CLS 
PAUSE 2 USING .vPauseMessage + 
CAPTION 'Finding Row Size' + 
ICON APP + 
BUTTON 'Press any key to continue ...' + 
OPTION MESSAGE_FONT_NAME VERDANA + 
|MESSAGE_FONT_SIZE 10 + 
|MESSAGE_FONT_COLOR MAROON + 
|MESSAGE_FONT_BOLD OFF + 
|BUTTON_COLOR WHITE + 
|BUTTON_FONT_COLOR GREEN + 
|THEMENAME R:BASE Rocks! 

GOTO Start
LABEL Done 
CLEAR VAR vTableName,vRowSize,vString,vPauseMessage,vYesNo,vCaption,
vEndKey 
RETURN 
-- End

14.18 Listing Database Keys

Did you know that you can use the new LIST command to list PRIMARY, FOREIGN and UNIQUE Keys?

Here's how:

1. LIST PKEYS

Using LIST PKEYS will return a list of all PRIMARY KEYs and PRIMARY KEYs REFERENCED. 
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2. LIST PKEYS FOR tablename

Using LIST PKEYS FOR tablename will return the name of a PRIMARY KEY column for a given table
name and associated REFERENCED keys

3. LIST FKEYS

Using LIST FKEYS will return a list of all FOREIGN KEYs in the connected database.

4. LIST FKEYS FOR tablename

Using LIST FKEYS FOR tablename will return a list of all FOREIGN KEY columns for a given table.

5. LIST UKEYS

Using LIST UKEYS will return a list of all UNIQUE KEYs in the connected database.

6. LIST UKEYS FOR tablename

Using LIST UKEYS FOR tablename will return a list of all UNIQUE KEY columns for a given table.

14.19 Listing Tables with Cascade and Cascade Type

Did you know that you can list all tables with Cascade and Cascade Types, if defined, using the LIST
command?

LIST CASCADE

LIST CASCADE will display a list of all tables with a CASCADE and type of cascade (UPDATE, DELETE or
BOTH).

14.20 Programmatically Clean Scratch Files on Exit

Current versions of R:BASE 7.6, Turbo V-8 and R:BASE eXtreme allow you to "Clean Scratch Files on
Exit" by using an option within the R:BASE Settings; select "Settings" > "Clean Scratch Files on Exit"
from the main Menu Bar.

However, when using the R:Compiler executables or Runtime applications, this option is not available,
obviously for restricted access to all settings, designers, and the R> Prompt.

Did you know that you can programmatically clean the scratch files on exit, using the following
PROPERTY command in the application startup file, as an "On Before Start" Custom EEP in the main
application form, External Form File, or R:BASE Application (.RBA) file?

PROPERTY APPLICATION CLEANSCRATCHFILESONEXIT 'TRUE' 
RETURN

Using this option will automatically clean all scratch files upon exiting of your compiled or runtime
application.

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.5.31229 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.5.31229 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.19.31229 or higher) 
· R:BASE eXtreme (v9) for Windows (Build: 9.0.1.11229 or higher)
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14.21 RUN filespec vs. QUIT TO filespec

Creating complex applications with many command files and monitoring nesting levels has always been
an art with designing trouble-free applications. It is the programmer's responsibility to monitor the
nesting level, when using RUN filespec command from within a command or procedure file. 

When you use the RUN filespec command from within a command or procedure file, R:BASE adds one to
the nesting level for each nested command file. The RETURN command is the only way to exit and to
return control to the next line in the calling command file and to decrease the nesting counter by one.

You can nest command files, such as RUN filespec, IF structures, WHILE loops, and SWITCH structures.
The number of control structures that you can nest depends on the amount of memory available when
the command or procedure file executes.

You can have up to five levels of RUN execution, unless you use the SET FILES command to change the
number of command files that can be open simultaneously. In other words, command file 1 can execute
command file 2, command file 2 can execute command file 3, command file 3 can execute command file
4, and command file 4 can execute command file 5. Successive RETURN commands pass execution
control back up through the command files.

It all comes down to defining nesting levels and ... making sure to return control back to the originating
command file. 

Using the QUIT TO filespec command, there is no overhead, no nesting level, nor does R:BASE have to
keep track of nesting levels.

Using the QUIT TO filespec command, you can QUIT TO any command file at any level you wish and
never have to worry about returning to the last command to return control to the one command before
and so on ...

QUIT TO filespec command clears all nesting levels and resets the nesting level to 0. Thus, no
overhead. 

You can use QUIT TO in individual binary codelocked command file(s), however, QUIT TO filespec cannot
be used to execute a command block in a procedure file.

14.22 Selecting the Appropriate Tray Using PRNSETUP

Did you know that you can select the printer specific paper tray using the PRNSETUP command?

Syntax:

PRNSETUP TRAY_NAME <Printer Specific Tray name>

-- Example 01: (to select printer specific Tray1) 

PRNSETUP TRAY_NAME Tray1 
RETURN

-- Example 02: (to select printer specific Tray2) 

PRNSETUP TRAY_NAME Tray2 
RETURN

-- Example 03: (to select printer specific MP Tray) 

PRNSETUP TRAY_NAME MP Tray 
RETURN
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14.23 Understanding Dotted vs. Ampersand Variables

Dotted Variables

1. Variables used to hold values.
2. When you want R:BASE to use the "value" contained in the variable.
3. When you use a variable in a calculation or as a comparision value, you use "dot" variable.
4. A rule of thumb for when to "dot" a variable is to always "dot" the variable when it is on the right

side of the operator. 
5. Dotting a variable basically turns it into a constant value. R:BASE looks only at the value of the

variable when it is dotted. R:BASE doesn't look at the datatype, just at the value the variable
contains. That's why you can have a TEXT datatype variable (result of a CHOOSE or DIALOG
command, for example) containing a value that looks like a DATE and use that variable to compare
to a DATE datatype column or variable. 

6. In expressions, R:BASE checks the datatype of a dotted variable. An expression is anything
enclosed in parentheses. R:BASE verifies the datatype in expressions to make sure the expression
is valid. You can't add an INTEGER to a TEXT for example. 

7. Dotted variables are used in Form and Report expressions as they are in the SET VAR command.
On the right side of the operator, dot the variable.

8. Dotted variables are commonly used in WHERE clauses and in calculations with other variables. 

Example 01: 

SET VAR vDate DATE = 11/19/2001 
SELECT * FROM TransMaster WHERE TransDate <= .vDate 

The SELECT queries all of the records from the TransMaster table where the value in the TransDate
column is less than or equal to the value contained in the variable vdate.

Example 02:

SET VAR vOrder INTEGER = 20001 
SET VAR vAmount CURRENCY = NULL 
SET VAR vShip TEXT = NULL 
SET VAR vFreight CURRENCY = NULL 
SET VAR vTax CURRENCY = NULL 
SET VAR vState TEXT = NULL
SELECT NetAmount, ShipMethod, StateAbr INTO + 
vAmount INDIC IvAmount, + 
vShip INDIC IvShip, + 
vState INDIC IvState + 
FROM Orders WHERE OrderNum = .vOrder 

IF vShip = 'AIR' THEN 
SET VAR vFreight = $11.00 

ELSE 
SET VAR vFreight = $5.00 

ENDIF 
SET VAR vAmount = (.vAmount + .vFreight) 
SELECT TaxRate INTO vTax INDIC IvTax + 
FROM States WHERE StateAbr = .vState 

SET VAR vAmount = (.vAmount+(.vAmount*.vTax))

On the right side of the equals sign (the operator), the variable is dotted. On the left side of the
operator, in the IF and the SET VAR commands, the variable is referenced by its name only, it is not
dotted. 

Ampersand Variables

1. You can't dot a variable when it contains part of a command - a table or column name, or an ORDER
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BY or WHERE clause. 
2. When a variable contains part of a command, its name is prefaced with an ampersand, "&", and it is

called an ampersand variable. The "&" in front of the variable name tells R:BASE that the variable
contains part of the command, not a value, and the contents of the variable are used when parsing
the command. 

3. Don't confuse the ampersand that prefaces a variable name with the ampersand that is used to
concatenate TEXT values.

4. Because an ampersand variable is part of a command, it can't be used inside parentheses.
Parentheses indicate expressions, expressions are parsed separately from the rest of the command.
You need to include the parentheses as part of the variable value. Sub-selects and IN lists are
enclosed in parentheses and you can't use an ampersand variable inside them, you need to include
the entire sub-select or IN list, including parentheses, as the variable value. 

5. Ampersand variables are most often used to hold table and column names and WHERE and ORDER
BY clauses. By using ampersand variables to hold column and table names, you can use the same
command to select data from different tables. The CHOOSE command displays menus of available
tables and columns. 

Example 01:

SET VAR vTable TEXT = NULL 
SET VAR vColList TEXT = NULL 
CLS 
CHOOSE vTable FROM #TABLES AT CENTER,CENTER TITLE 'Choose Table' + 
CAPTION 'List of Tables' LINES 18 FORMATTED 

CLS 
CHOOSE vColList FROM #COLUMNS IN &vTable AT CENTER,CENTER + 
CHKBOX TITLE 'Choose Column(s)' CAPTION 'List of Columns' + 
LINES 18 FORMATTED

The values selected from the menus are placed into variables. 

The variables might look like this: 

vTable = Employee TEXT 
vColList = Empid,EmpLname,EmpPhone,EmpExt TEXT 

The variables are then used in any command that uses a table name or column list. Where you see
Column names or Table/View name you can substitute an ampersand variable that contains the
Column, Table or View name. The variables must be used as ampersand variables to tell R:BASE
they contain part of the command. 

Example 02: 

BROWSE &vColList FROM &vTable 

To prompt for an ORDER BY clause, use the CHKSORT option instead of CHKBOX on the CHOOSE...
FROM #COLUMNS. 

Example 03:

SET VAR vOrderBy TEXT = NULL 
CHOOSE vOrderBy FROM #COLUMNS IN &vTable AT CENTER,CENTER + 
CHKSORT TITLE 'Choose Column(s)' CAPTION 'Order By' + 
LINES 18 FORMATTED 

The CHKSORT option prompts for Ascending or Descending just like the R:BASE sort menus. The
variable contains ASC or DESC as well as the column names. It might look like this: 

vOrderBy = EmpLname ASC,EmpFname ASC TEXT 
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In the command, follow the keywords ORDER BY with the ampersand variable containing the
columns to order by. 

Example 04:

BROWSE &vColList FROM &vTable ORDER BY &vOrderBy 

14.24 Understanding WHILE Loop Optimization

Have you ever run into a situation where your command file/application is not working correctly by
variables not being calculated accurately or by experiencing unexpected closes within a WHILE..
ENDWHILE loop; and when you TRACE or RUN that routine with WHILEOPT set to off, R:BASE returns no
errors and everything works fine?

Well, those are the typical symptoms of WHILE loop optimization. There is likely a problem with an
optimized command and the problem is most likely with a variable that you may be clearing, redefining,
or not data typing.

WHILE loops have always been considered one of the faster ways to process code as R:BASE places the
WHILE loop code into memory and then parses it before beginning execution. R:BASE does not need to
perform line-by-line reading and parsing of the code for each iteration of the WHILE loop. As the code is
read into memory, the WHILE loop code was parsed into tokens (4-byte segments). But, R:BASE still
needed to figure out what was what -- parse the expressions, find variable names and values, etc. It was
faster than reading and parsing line-by-line, but not as fast as it could be. 

If you determine that the problem is with an optimized command, review the rules below:

1. Pre-define all variable(s) with NULL values at the beginning of a command file or before the WHILE
loop is executed.

2. Always use DROP CURSOR cursor before DECLARE CURSOR.
3. When using FETCH cursor INTO varname, always use INDICATOR variables for each defined

variable(s).
4. Use WHILE SQLCODE <> 100 THEN
5. Never CLEAR any variable(s) within the WHILE loop. The value can be reset to NULL, but not

cleared.
6. Never change variable data types within the WHILE loop.
7. Make sure to DROP CURSOR cursor after the WHILE loop.
8. Make sure to CLEAR unwanted and INDICATOR variables after the WHILE loop.

Keep in mind that TRACE does not use the WHILE loop optimization.

Example:

SET VAR vVarName ColType = NULL 
DROP CURSOR C#1 
DECLARE C#1 CURSOR FOR SELECT ColName FROM TableName + 
ORDER BY ColName 

OPEN C#1 
FETCH C#1 INTO vVarName INDIC IvVarName 
WHILE SQLCODE <> 100 THEN 
-- Do what you have to do here with that sorted record 

FETCH C#1 INTO vVarName INDIC IvVarName 
ENDWHILE 
DROP CURSOR C#1 
CLEAR VAR vVarName, IvVarName
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14.25 Upgrading an R:BASE Database to Turbo V-8

To convert your existing R:BASE database to R:BASE Turbo V-8, all you have to do is the following:

1. Start R:BASE Turbo V-8 (RBG8.exe)
2. Switch the default directory to your database directory
3. At the R> prompt, type the following command:

TURBO dbname

Watch the speedy database conversion process ...

This step makes a duplicate copy of your R:BASE database to be used exclusively by R:BASE Turbo V-
8. The new database files will have the following extensions:

· dbname.RX1 
· dbname.RX2 
· dbname.RX3 
· dbname.RX4

X = eXtended

The original R:BASE database will remain intactand without change.

You may also use the alternative method of building an R:BASE Turbo V-8 database using the file
structure and data from R:BASE for Windows using the traditional UNLOAD ALL command.

1. Start R:BASE at launch the R> Prompt window
2. Type in the following commands individually:

CONNect dbname 
SET NULL -0- 
OUTPUT filename.ALL 
UNLOAD ALL 
OUTPUT SCREEN 
DISCONNECT

This process will create two files (filename.ALL and filename.LOB)

4. Now, Start R:BASE Turbo V-8
5. Switch the default directory to the folder with filename.ALL and filename.LOB files.
6. At the R> prompt of R:BASE Turbo V-8:

RUN filename.ALL

This step will build a clean database to be used exclusively by R:BASE Turbo V-8. The new database
files will have the following extensions:

· dbname.RX1 
· dbname.RX2 
· dbname.RX3 
· dbname.RX4

X = eXtended

At the R> Prompt, the LIST DATABASE command will only list R:BASE Turbo V-8 database(s) in that
folder.

Once the database is converted, it can only be connected to using R:BASE Turbo V-8.

All R:BASE 7.x Forms, Reports, Labels that are converted to Turbo V-8, along with your existing R:BASE
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7.x compliant code and applications, should work accordingly.

Along with breaking the 2GB limit, enhanced input/output speed, and Turbo V-8 specific commands, you
also have the ability to increase the database, tables, columns, etc. naming conventions up 128
characters.

R:BASE Turbo V-8 for Windows is suitable for those who are reaching the file size limit of 2GB and for
Enterprise WEB/LAN/WAN Application Development Environments utilizing multiple high-end database
products.

Note:
All add-on products which connect to the database files, such as: R:Compiler, R:Charts, Oterro, R:
Synchronizer, R:Magellan, any Custom Plugins, RBAdmin, R:Scope, etc., will also need upgraded in
order to be compatible with your R:BASE Turbo V-8 database files.

14.26 Using an Enhanced Calculator in a Dialog Box

Did you know that you can bring up the enhanced R:BASE Calculator by simply double-clicking in a
DIALOG box?

This newly introduced enhancement also adapts the R:BASE Themes, if used as an option for the
DIALOG command.

-- Example 01: 
-- Dialog_With_Popup_As_Calculator_01.RMD 

CLS 
CLEAR VAR vValueTxt,vValue,vEndKey 
SET VAR vValueTxt TEXT = NULL 
SET VAR vValue DOUBLE = NULL 
DIALOG 'Enter Value or Double-Click for Calculator' + 
vValueTxt=26 vEndKey 1 + 
CAPTION 'DIALOG with Calculator Pop-up' ICON APP OPTION + 
POPUP_ENABLED TRUE + 
|POPUP_DIALOG_TYPE CALCULATOR 

SET VAR vValue = .vValueTxt 
CLEAR VARIABLE vValueTxt,vEndKey 
RETURN

-- Example 02: 
-- Dialog_With_Popup_As_Calculator_02.rmd 
-- Using THEMENAME as Razzmatazz 
-- Notice the dialog box and the matching calculator 

CLS 
CLEAR VAR vValueTxt,vValue,vEndKey 
SET VAR vValueTxt TEXT = NULL 
SET VAR vValue DOUBLE = NULL 
DIALOG 'Enter Value or Double-Click for Calculator' + 
vValueTxt=36 vEndKey 1 + 
CAPTION 'DIALOG with Calculator Pop-up' ICON APP OPTION + 
POPUP_ENABLED TRUE + 
|POPUP_DIALOG_TYPE CALCULATOR + 
|THEMENAME Razzmatazz 

SET VAR vValue = .vValueTxt 
CLEAR VARIABLE vValueTxt,vEndKey 
RETURN

-- Example 03: 
-- Dialog_With_Popup_As_Calculator_02.rmd 
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-- Using THEMENAME as R:BASE Rocks! 
-- Notice the dialog box and the matching calculator 

CLS 
CLEAR VAR vValueTxt,vValue,vEndKey 
SET VAR vValueTxt TEXT = NULL 
SET VAR vValue DOUBLE = NULL 
DIALOG 'Enter Value or Double-Click for Calculator' + 
vValueTxt=30 vEndKey 1 + 
CAPTION 'DIALOG with Calculator Pop-up' ICON APP OPTION + 
POPUP_ENABLED TRUE + 
|POPUP_DIALOG_TYPE CALCULATOR + 
|THEMENAME R:BASE Rocks! 

SET VAR vValue = .vValueTxt 
CLEAR VARIABLE vValueTxt,vEndKey 
RETURN

14.27 Using DROP ALL

Typically, the DROP ALL TABLES command can be used to DROP all tables with a warning dialog prompt
(Yes/No) to verify each table and DROP ALL VIEWS command can be used to DROP all views with a
warning dialog prompt (Yes/No) to verify each view.

However, if you wish to DROP ALL tables except a few, you may use the DROP ALL TABLES EXCEPT
tablename1, tablename2 command.
You may also use the *enhanced* DROP ALL VIEWS EXCEPT viewname1, viewname2 command using
the latest versions/updates of R:BASE.

Summary:

· Use DROP ALL or DROP ALL TABLES command to drop all TABLES
· Use DROP ALL VIEWS command to drop all VIEWS
· Use DROP ALL TABLES EXCEPT listoftables command to drop all tables except the ones listed,

separated by commas

Example: 

DROP ALL TABLES EXCEPT tablename1, tablename2

· Use DROP ALL VIEWS EXCEPT listofviews command to drop all views except the ones listed,
separated by commas

Example: 

DROP ALL VIEWS EXCEPT viewname1, viewname2

14.28 Using ON CONNECT

Did you know that you can use the ON CONNECT command to save and reset your ON CONNECT
parameters in R:BASE?

Syntax Sample 01:

ON CONNECT RUN commadfile SAVE

Where:

· CONNECT indicates the command file should be run when connecting a database.
· RUN specifies the name of the command file to run.
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· commandfile specifies the name of the command file to run.
· SAVE indicates the defined ON CONNECT parameters be saved.
· Any options without the SAVE parameters will only be active for a session.

Example 01:

CONNECT RRBYW10 IDENTIFIED BY NONE 
ON CONNECT RUN RRBYW10.DAT SAVE

To RESET the ON CONNECT parameters:

Syntax Sample 02.:

ON CONNECT RESET SAVE

Where:

· RESET turns the ON CONNECT procedure off.
· SAVE indicates the defined ON CONNECT parameters be saved.

Example 02:

CONNECT RRBYW10 IDENTIFIED BY NONE 
ON CONNECT RESET SAVE

14.29 Using PRNSETUP Help Options

Did you know that you can use the PRNSETUP HELP options to find available Fonts, Printers, Formats,
Sources and other details about your printer?

Here's how:

1. Start R:BASE

2. At the R> prompt, type:

PRNSETUP HELP

This will list all available options, such as:

FONTS - Available Fonts 

PRINTERS - Available Printers 

PAPERNAMES - Available Formats 

TRAYS - Available Sources 

INFO - Current Printer Information

PRNSETUP FONTS

This will list all available fonts.

PRNSETUP PRINTERS

This will list all available printers. Printer name preceded by "*" denotes the default printer.

PRNSETUP PAPERNAMES

This will list all available paper formats.
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PRNSETUP TRAYS

This will list all available paper sources.

PRNSETUP INFO

This will list all details about the default printer, including:

· Current Printer 
· Status 
· Paper Orientation 
· Paper Size 
· Paper Source 
· Print Quality (DPI) 
· Copies 
· Color Mode 
· Duplex Mode 
· Collation

14.30 Using the Enhanced DIR Command in R:BASE

Did you know that the traditional DIR command has been enhanced to display new Windows output
format? DIR command displays a list of a directory's files and sub-directories. Used without parameters,
DIR displays the disk's volume label and serial number, followed by a list of directories and files on the
disk, including their names and the date and time each was last modified.

Example 01: 

For files, DIR displays the long name, extension and the size in bytes. DIR also displays the total number
of files and directories listed, their cumulative size, and the free space (in bytes) remaining on the disk.



"Tip of the Day" Digest243

Copyright © 1982-2012 R:BASE Technologies, Inc.

If you wish to display the traditional output format, you can use the following new SET SHORTNAME ON
command. The default is set to OFF.

Example 02: 
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In addition, new SHOW SHORTNAME command will display the current setting and new (CVAL
('SHORTNAME')) function will retrieve the current setting when used in a command file.

The default RBENGINE76.CFG, RBENGINE8.CFG, or RBENGINE9.CFG files, when created from scratch,
will also include the new 
default setting as SHORTNAM OFF.

Supported Versions:
· R:BASE 7.6 for Windows (Build:7.6.5.31125 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build:7.6.5.31125 or higher) 
· R:BASE Turbo V-8 for Windows (Build:8.0.19.31125 or higher) 
· R:BASE eXtreme for Windows (Build:9.0.1.31125 or higher)

14.31 Using the GAUGE Options with PAUSE

If you are running a routine and don't know exactly how long it is going to take, now you may use the
new GAUGE options 
to display a cool gauge with custom theme and colors.

Here's how:

Example 01: 

CLS 
PAUSE 3 USING 'Calculating ... Please Stand By ...' + 
CAPTION ' Pause 3 with Gauge ' ICON APP + 
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OPTION GAUGE_VISIBLE ON + 
|GAUGE_COLOR [R218,G228,B246] + 
|GAUGE_INTERVAL 10 + 
|MESSAGE_FONT_NAME VERDANA + 
|MESSAGE_FONT_SIZE 10 + 
|MESSAGE_FONT_COLOR BLUE + 
|THEMENAME Razzmatazz 
-- Put your code, that takes a lot of time, here ... 
-- Use CLS command to clear the PAUSE 3 with gauge 
RETURN 

Example 02: 

CLS 
PAUSE 3 USING 'Calculating ... Please Stand By ...' + 
CAPTION ' Pause 3 with Gauge ' ICON APP + 
OPTION GAUGE_VISIBLE ON + 
|GAUGE_COLOR 2708091 + 
|GAUGE_INTERVAL 10 + 
|MESSAGE_FONT_NAME VERDANA + 
|MESSAGE_FONT_SIZE 10 + 
|MESSAGE_FONT_COLOR RED + 
|THEMENAME R:BASE Rocks! 
-- Put your code, that takes a lot of time, here ... 
-- Use CLS command to clear the PAUSE 3 with gauge 
RETURN 

Example 03: 

CLS 
PAUSE 3 USING 'Calculating ... Please Stand By ...' + 
CAPTION ' Pause 3 with Gauge ' + 
ICON WINDOWS + 
OPTION GAUGE_VISIBLE ON + 
|GAUGE_COLOR RED + 
|GAUGE_INTERVAL 10 + 
|MESSAGE_FONT_NAME VERDANA + 
|MESSAGE_FONT_SIZE 10 + 
|MESSAGE_FONT_COLOR WHITE + 
|THEMENAME Steel Blue 
-- Put your code, that takes a lot of time, here ... 
-- Use CLS command to clear the PAUSE 3 with gauge 
RETURN 

14.32 Using the R:AudioPlayer Plugin

The R:AudioPlayer Plugin is used to play audio files. The Plugin supports the following audio formats:

· AVI 
· MDI 
· MP3 
· WAV 
· WMA

Syntax:
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PLUGIN RAudioPlayer80.RBL vResult|option

Supported Options:

· FILENAME filespec 

· PLAY 

· PAUSE 

· RESUME 

· STOP

Where:

· vResult is the text variable to return the status, such as 'OK' or the exact -ERROR- message 

· FILENAME is the name and path of the audio file 

· PLAY is used to play the current file 

· PAUSE is used to pause the current file 

· RESUME is used to resume playing the current file

· STOP is used to stop playing the current file

Each option must be separated by a "|" pipe symbol.

-- Example 01: To load and play audio file 

PLUGIN RAudioPlayer80.RBL vResult|FILENAME DreamTheater_Octavarium.mp3 
PLUGIN RAudioPlayer80.RBL vResult|PLAY 
RETURN

-- Example 02: To pause the already playing audio 

PLUGIN RAudioPlayer80.RBL vResult|PAUSE 
RETURN

-- Example 03: To resume the paused audio 

PLUGIN RAudioPlayer80.RBL vResult|RESUME 
RETURN

-- Example 04: To stop the audio player 

PLUGIN RAudioPlayer80.RBL vResult|STOP 
RETURN

In order to use R:Audio Player Plugin with R:BASE Turbo V-8, you have to make sure that the version
specific "RBL" Plugin is installed in the R:BASE program folder (R:BASE Turbo V-8 default C:
\RBTI\RBG8), or in the compiled (.exe) application folder. R:AudioPlayer does not appear in the R:BASE
for Windows Plugins Menu.

Please Note:
There are 3 different versions of R:AudioPlayer Plugins available for each version of R:BASE for
Windows.

· RAudioPlayer.RBL (for R:BASE 7.5 for Windows) 
· RAudioPlayer76.RBL (for R:BASE 7.6 and 7.6 C/S:I for Windows) 
· RAudioPlayer80.RBL (for R:BASE Turbo V-8 for Windows)

These Plugins are only made available through the purchase of the R:BASE Plugin Power Pack. 
http://www.rbase.com/products/pluginpowerpack

http://www.rbase.com/products/pluginpowerpack
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14.33 Using the R:ID3Tag Plugin to extract MP3 file information

Syntax:

PLUGIN RID3Tag.RBL varname|FILE_NAME filename.mp3|INFO_TYPE value

Where:

FILE_NAME is the actual name of the mp3 file. 
INFO_TYPE is type of information you would like to receive in a variable. 

Supported values are: 

· TITLE 
· ARTIST 
· ALBUM 
· YEAR 
· GENRE 
· COMMENT

Example:

PLUGIN RID3Tag.RBL vTitle|FILE_NAME filename.mp3|INFO_TYPE TITLE 
PLUGIN RID3Tag.RBL vArtist|FILE_NAME filename.mp3|INFO_TYPE ARTIST 
PLUGIN RID3Tag.RBL vAlbum|FILE_NAME filename.mp3|INFO_TYPE ALBUM 
PLUGIN RID3Tag.RBL vYear|FILE_NAME filename.mp3|INFO_TYPE YEAR 
PLUGIN RID3Tag.RBL vGenre|FILE_NAME filename.mp3|INFO_TYPE GENRE 
PLUGIN RID3Tag.RBL vComment|FILE_NAME filename.mp3|INFO_TYPE COMMENT

Resulting Variables:

vTitle is the title of mp3 file 
vArtist is the name of artist 
vAlbum is the name of album 
vYear is the year of album 
vGenre is the category of music 
vComment is the additional comment about mp3 file

In addition to a library of other R:BASE Plugins, the RID3Tag.RBL Plugin is included with the latest
version of the R:BASE Plugin Power Pack. 

14.34 Using the TOP and LEFT coordinates for PRNSETUP

There are times when you wish you could display the PRNSETUP window at a particular position on the
desktop, instead of in the center of your screen.

Using the latest updates, now you can use the TOP and LEFT coordinates to achieve this goal.

Here's how:

PRNSETUP + 
OPTION CAPTION Select Printer + 
|TOP 10 + 
|LEFT 10 + 
|THEMENAME R:BASE Rocks! 

RETURN

The PRNSETUP windows will be displayed at your desktop's top 10 and left 10 screen pixels, with a
caption "Select Printer" and the theme of R:BASE Rocks!
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You may change the TOP and LEFT coordinates, as well as choose from over 30 supported Themes, to
suit your R:BASE application.

In addition to PRNSETUP, the OPTION for TOP and LEFT coordinates are also supported in the #WHERE,
CHOOSE, DIALOG and PAUSE commands.

14.35 Using the Zoom Level Percent for PRINT

If you need to PRINT any report/label on SCREEN with a pre-defined Zoom Level, such as
ZOOMPERCENT 55, you will need to precede the option with ZOOM_TYPE PERCENTAGE.

Example:

PRINT reportname WHERE whereclause ORDER BY orderbyclause + 
OPTION SCREEN + 
|WINDOW_STATE MAXIMIZED + 
|ZOOM_TYPE PERCENTAGE + 
|ZOOMPERCENT 55

14.36 Using Themes for the #WHERE Builder

Did you know that in addition to applying Themes to Forms, Pop-up Menus, CHOOSE, DIALOG and
PAUSE commands, now you can also apply R:Themes for #WHERE Builder window also?

When using #WHERE IN tableview option of CHOOSE command, it opens the WHERE builder for you to
enter conditions for the columns in the specified table or view; stores the entire WHERE clause in the
variable varname.

-- Example 01: (Traditional Command)

CONNECT RRBYW10 
CHOOSE vWhereClause FROM #WHERE IN Customer 
RETURN

-- Example 02: (Using Razzmatazz theme for #WHERE)

CONNECT RRBYW10 
CHOOSE vWhereClause FROM #WHERE IN Customer + 
OPTION THEMENAME Razzmatazz 
RETURN

-- Example 03: (Using R:BASE Rocks! theme for #WHERE)

CONNECT RRBYW10 
CHOOSE vWhereClause FROM #WHERE IN Customer + 
OPTION THEMENAME R:BASE Rocks! 
RETURN

14.37 Using SET FEEDBACK

With SET FEEDBACK set to ON, R:BASE displays the number of rows processed and the elapsed time to
completion in the new pause look-alike form at the center of the screen.

Syntax: SET FEEDBACK ON/OFF
Default: OFF
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This setting displays processing results when either calculating, sorting, inserting or editing more than
100 rows.

Supported commands:

· ALTER TABLE 
· COMPUTE 
· CREATE INDEX 
· CROSSTAB 
· DELETE 
· INSERT 
· The data transfer for the JOIN of two tables 
· LOAD 
· The data transfer for a PROJECT command 
· SELECT 
· SORTing a huge record set 
· the data transfer for a SUBTRACT of two tables 
· TALLY 
· The R:BASE UNION command

14.38 Using SET PROGRESS

With SET PROGRESS set to ON, did you know that you can display a cool progress bar display window to
show the process progression when building indexes, packing or reloading a database?

Syntax: SET PROGRESS ON/OFF
Default: OFF

Example 01:

CONNECT RRBYW14 
PACK INDEX

Example 02:

CONNECT RRBYW14 
PACK TABLE Customer 
PACK TABLE InvoiceHeader 
PACK TABLE InvoiceDetail

Example 03:

CONNECT RRBYW14 
RELOAD RRBYWNEW

Example 04:

DISCONNECT 
SET MULTI OFF 
PACK RRBYW14 
SET MULTI ON

Example 05:

DISCONNECT 
SET MULTI OFF 
CONNECT RRBYW14 
PACK 
SET MULTI ON
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14.39 Using Wild Cards with PROPERTY

Did you know that you can use the connected database wild card symbols (also known as MANY) to
change the PROPERTY of all controls with matching Component IDs at once?

-- Example 01:

PROPERTY FontControl% VISIBLE 'FALSE' 
RETURN

-- Example 02:

PROPERTY %ontControl VISIBLE 'FALSE' 
RETURN

-- Example 03:

PROPERTY %ontCon% VISIBLE 'FALSE' 
RETURN

Imagine the possibilities!

14.40 Validating An Internet Connection

When designing and deploying R:BASE eXtreme 9.1/9.5 applications, you might have a cool R:BASE
routine or Plugin to submit and/or retrieve data that requires an Internet connection.

When your R:BASE eXtreme 9.1/9.5 applications include tools to extract, transform and load data, they
are mainly responsible for data transfer from your R:BASE application and the Internet to data
warehouses.

However, not being connected to the Internet, or not having Internet access may result into -ERROR-
message(s) and so forth. It would be nice to confirm a valid Internet connection before submitting or
retrieving data or LAUNCHing a Web browser.

Did you know that now you can use a new GETPROPERTY command parameter to check whether or not
the computer is connected to the Internet?

Here's how:

SET VAR vResult TEXT = NULL 
GETPROPERTY APPLICATION IsInternetConnected vResult

Resulting "vResult" variable will return the value of YES or NO.

Using this approach, you can now build higher intelligence into your R:BASE eXtreme 9.1/9.5
applications.

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.5.11111  or higher)
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15 Functions

15.1 Checking the R:BASE Build in Your Applications

Here's the code you can use to check the current BUILD of R:BASE in your startup file prior to launching
your wonderful RBG application with the latest features implemented.

-- Start
-- CheckBuild.RMD 
-- Author: A. Razzak Memon 
-- Application: R:Docs
CLEAR VAR vCurrentBuild, vCaption, vPauseMsg 
SET VAR vCurrentBuild INTEGER = 73 
SET VAR vCaption TEXT = 'R:Docs!' 
SET VAR vPauseMsg TEXT = + 
('MUST have RBG7 Update'&(CTXT(.vCurrentBuild))&'or higher to use'&.
vCaption)

IF (INT(SGET(CVAL('BUILD'),2,5))) < .vCurrentBuild THEN 
CLS 
PAUSE 2 USING .vPauseMsg + 
CAPTION .vCaption + 
ICON STOP + 
BUTTON 'Click here to continue ...' + 
OPTION BACK_COLOR WHITE + 
|MESSAGE_COLOR WHITE + 
|MESSAGE_FONT_COLOR RED + 
|BUTTON_COLOR WHITE + 
|BUTTON_FONT_COLOR GREEN + 
|TRANSPARENCY 255 

EXIT 
ELSE 
CLEAR VAR vCurrentBuild, vCaption, vPauseMsg 
PROPERTY APPLICATION TITLE 'R:Docs' 
CONNECT RDOCS 
RUN GlobalVars.RMD 
QUIT TO RDocs.DAT 
ENDIF 
RETURN
-- End

15.2 Finding PORTS on Your Workstation

Did you know that you can find the available ports on your computer?

You can find all available ports using the *new* (CVAL('PORTS')) function.

Here's how:

1. Start R:BASE

2. At the R> prompt, type:

SET VAR vAvailablePorts TEXT = NULL 
SET VAR vAvailablePorts = (CVAL('PORTS')) 
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SHOW VAR vAvailablePorts

The variable vAvailablePorts will return a text string with a list of all ports that are available on that
workstation. Each item in the list will be separated by a comma (or the database character settings for
comma).

15.3 Finding Table/View Locks Programmatically

Did you know that you can find the table or view locks using the new (GETVAL
('GetLock','tableviewname')) function in R:BASE?

Here's how:

SET VARIABLE vCheckLock TEXT = NULL 
SET VARIABLE vCheckLock = (GETVAL('GetLock','tableviewname'))

Where:

GetLock is the first required parameter and the tableviewname is the name of table or view.

The variable vCheckLock will return the text value of ON or OFF.

15.4 Finding the Data Type for a given Column or Variable

Did you know that you can find the data type for a given column name or variable by using the
undocumented CVTYPE function?

Here's how:

Syntax:

(CVTYPE('colvarname',flag))

Returns the data type for a given column or variable name. To return the data type for a given column,
a zero "0" flag must be used. To return the data type for a given variable, the one "1" flag must be used.

1. Start R:BASE for DOS or Windows

2. After CONNecting to ConComp or RRBYW14, try the following two examples at the R> prompt:

Example 01.

SET VAR vCustIDType TEXT = (CVTYPE('CustID',0)) 
SET VAR vEmpCity TEXT = (CVTYPE('EmpCity',0))

SHOW VARIABLES

vCustIDType = INTEGER TEXT 
vEmpCity = TEXT,16 TEXT

Example 02.

SET VAR vCustIDType TEXT = (CVTYPE('CustID',0)) 
SET VAR vVarInquiry TEXT = (CVTYPE('vCustIDType',1))

SHOW VARIABLES

vCustIDType = INTEGER TEXT 
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vVarInquiry = TEXT,7 TEXT

NOTES:

· When using the zero flag to return column data types, you must be CONNected to a database.
· When returning a TEXT data type, the length is included and is separated with a comma. When

returning a NUMERIC data type, the precision and scale are separated with commas.

15.5 Finding the INTEGER value for a given TEXT String

Did you know that you can find the INTEGER value for a given TEXT string by using the undocumented
ISTR function of R:BASE?

Here's how:

Syntax:

(ISTR('textstring',position))

Returns the corresponding integer value.

This function converts a single character, which you specify within a string by position, returning its
corresponding ASCII Character Chart Decimal value.

In the following example, the INTEGER value of vDecimalValue is 65 for the capital letter A.

Example 01:

Start R:BASE for DOS or R:BASE for Windows at the R> Prompt:

SET VARIABLE vDecimalValue = (ISTR('R:BASE Rocks!',4))

SHOW VARIABLE

vDecimalValue = 65 INTEGER

15.6 Managing DLCALL Functions

Did you know that you can:

1. Declare up to 200 functions using the DLCALL function

2. Use CHKFUNC function to check DLL function that exists or not

Example:

SET VAR v1 = (CHKFUNC('function_name'))

Returns 1 if function exists or 0 if not.

3. Use DELFUNC function to delete DLL function declaration

Example:

SET VAR v1 = (DELFUNC('function_name'))

Returns 1 if function was deleted or 0 if not.
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4. Use new LIST FUNCTIONS command to list declared functions

LIST FUNCTIONS command will list all declared DLL functions

Supported Versions:
· R:BASE 7.6 for Windows (Build: 7.6.4.30611 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.4.30611 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.18.30611 or higher)

15.7 Using IFWINDOW

Did you know that you can use the IFWINDOW function to see if the form is open or not, WITHOUT
specifying the AS alias option of ENTER or EDIT USING formname?

(IFWINDOW(FormComponentID)) 

will return 1 when a form with the Component ID is open, 0 if not.

All you need to do is assign a Component ID to the form.

15.8 Using CHKCUR

If you need to know whether a CURSOR is already DECLAREd or DROPped, now you may use the
CHKCUR function to find the current status of a given cursor name.

Here's how:

SET VARIABLE vCheckCuror = (CHKCUR('cursorname'))

The CHKCUR Function checks to see if a cursor is declared and is not dropped. The function returns an
integer value of 1 
if the cursor exists and is not dropped, and 0 if it is not declared or dropped.

The variable vCheckCursor will return a value of 1 or 0.

15.9 Using CHKVAR

Have you ever had the need to find whether a required VARIABLE is declared before you use that
variable in an expression or routine to avoid code breaks or a sequence of -ERROR- messages?

Now you can avoid those moments by simply verifying the existence of a variable using the CHKVAR
function, which checks to see if a variable name exists.

Here's how:

SET VARIABLE vCheckVar = (CHKVAR('varname'))

The function returns an integer value of 1 if the variable name exists or is declared, and 0 if it is not
defined.

The variable vCheckVar will return a value of 1 or 0.

No more workarounds, suppressing error messages or even lengthy code to evaluate the existence of a
variable!
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15.10 Using SLOCP

The SLOCP Function is used to locate the exact position of a given string and occurrence in a TEXT, NOTE
or VARCHAR value, returning the position if the string is found or 0 if it is not found. Using -1 as the third
parameter will return the LAST occurrence.

Syntax:

(SLOCP(TextNoteVarcharValue,string,occurrence))

Example 01:

SET VARIABLE v1 VARCHAR = 'ABCDEABC_AB' 
SET VARIABLE vSLoc1 = (SLOCP(.v1,'AB',1)) 

The resulting variable vSloc1 will return the integer value of 1.

Example 02:

SET VARIABLE v1 VARCHAR = 'ABCDEABC_AB' 
SET VARIABLE vSLoc2 = (SLOCP(.v1,'AB',2)) 

Resulting variable vSloc2 will return the integer value of 6.

The above two examples will locate the exact position of a given string and occurrence. However, if you
wish to find the LAST occurrence in the value of your string, use the "-1" parameter. Here's how:

Example 03:

SET VARIABLE v1 VARCHAR = 'ABCDEABC_AB' 
SET VARIABLE vSLocLast = (SLOCP(.v1,'AB',-1)) 

Resulting variable vSlocLast will return the integer value of 10.

15.11 Using SLOCI Function to Locate the Number of String Instances

Did you know that you can locate the number of instances a string appears in a TEXT, NOTE, or
VARCHAR value using the new SLOCI Function?

Syntax: 

(SLOCI(TextNoteVarcharValue,string,arg))

New SLOCI function will return the INTEGER value for the number of instances a string appears in a
TEXT, NOTE, or VARCHAR value.

The argument parameter determines whether the search on the string is case sensitive, where "0" is not
case sensitive while "1" is case sensitive.

Example 01:

SET VAR vProduct1 TEXT = (SLOCI('R:BASE Single Seat: Upgrade',':',0)) 
SHOW VAR 
vProduct1 2 INTEGER

Example 02:

SET VAR vProduct2 TEXT = (SLOCI('Single Seat License','S',1)) 
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SHOW VAR 
vProduct2 2 INTEGER

Example 03:

SET VAR vProduct3 TEXT = (SLOCI('Single Seat License','S',0)) 
SHOW VAR 
vProduct3 3 INTEGER

Have fun implementing this new Function in your R:BASE eXtreme 9.1 applications!

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10414 or higher)

15.12 Using the Enhanced (GETDATE(' ')) Options

Traditionally, (GETDATE(' ')) will bring up the Windows GUI Calendar with today's date circled in red.
Either you can click on [OK] to accept the circled date or click on any other date on the calendar using
the current month or scrolling months.

-- Example 01 (Traditional Calendar): 
SET VAR vDate DATE = NULL 
SET VAR vDate = (GETDATE('Select Date')) 
RETURN 

-- Example 02 (Traditional Calendar with R:BASE Themes): 
SET VAR vDate DATE = NULL 
SET VAR vDate = (GETDATE('Select Date|THEMENAME Soft Blue')) 
RETURN 
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Did you know that now you can use the new "CALENDAR_TYPE ENHANCED" option to display an
enhanced calendar?

-- Example 03 (Enhanced Calendar with R:BASE Theme): 
SET VAR vDate DATE = NULL 
SET VAR vDate = + 
(GETDATE('Select Date|CALENDAR_TYPE ENHANCED|THEMENAME Vista CG')) 
RETURN 

Using the enhanced calendar, additional [Clear] button will clear the selection and use today's date as
default. Clicking on [OK] will populate the selected date into a variable, such as vDate.

Clicking on [Cancel] will ignore to populate any value into a variable, such as vDate. Pre-Defined value,
if used, will not be overwritten.

-- Example 04 (Dynamic Approach using Global Variables) 
SET VAR vDate DATE = NULL 
SET VAR vCaption TEXT = 'Select Date' 
SET VAR vCalendarType TEXT = 'ENHANCED' 
SET VAR vThemeName TEXT = 'XP Grey Scale' 
SET VAR vQuotes = (CVAL('QUOTES')) 
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SET VAR vString TEXT = + 
('SET VAR vDate = (GETDATE('+.vQuotes+.vCaption+ + 
'|CALENDAR_TYPE'+.vCalendarType+ + 
'|THEMENAME'&.vThemeName+.vQuotes+'))') 
&vString 
CLEAR VARIABLE vCaption,vCalendarType,vThemeName,vQuotes,vString 
RETURN 

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10428 or higher)

15.13 Using the FORMAT Function with .#NOW

Technically, you can use FORMAT anywhere that you can use a function. The result of the FORMAT
function is always text. In the syntax for this function, value is the value you want to be displayed in a
particular format; it can be a column, variable, or a constant value. 'Picture-format' is the picture format
you establish.

In a command file, the FORMAT function can be useful in several ways; such as, aligning decimals,
punctuating long 
numbers, formatting currency, and formatting text for CHOOSE, DIALOG, and PAUSE commands.

A beneficial example using FORMAT, for creating dynamic and unique file names based on the current
date and time, would be useful to any user/developer that requires the ability to make an unattended
timely backup of your live database. 

The following FORMAT function examples can be used to create a dynamic file name based on .#DATE, .
#TIME or .#NOW.

Let's say if you are already connected to the RRBYW16 database and would like to implement a routine
to backup the entire database (even in a multi-user environment) on demand. 

Here's a simple routine to create a unique file name:

-- Example 01: (Using .#DATE and .#TIME as two separate variables) 

CLS 
CLEAR VARIABLES vDateTxt,vTimeTxt,vFileName 
SET VAR vDateTxt TEXT = NULL 
SET VAR vTimeTxt TEXT = NULL 
SET VAR vFileName TEXT = NULL 
SET VAR vDateTxt = (FORMAT(.#DATE,'MMDDYYYY')) 
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SET VAR vTimeTxt = (FORMAT(.#TIME,'HHMM')) 
SET VAR vFileName = + 
((CVAL('DATABASE'))+'_'+.vDateTxt+'_'+.vTimeTxt+'.BKP') 
CLEAR VARIABLES vDateTxt,vTimeTxt 
RETURN
-- vFileName will return the text variable as: 
-- RRBYW16_12302008_1630.BKP 
-- Database Name, Date and Time will vary on your end

-- Example 02: (Using .#DATE and .#TIME as one variable in expression) 

CLS 
CLEAR VARIABLES vFileName 
SET VAR vFileName TEXT = NULL 
SET VAR vFileName = + 
((CVAL('DATABASE'))+'_'+(FORMAT(.#DATE,'MMDDYYYY'))+ + 
'_'+(FORMAT(.#TIME,'HHMM'))+'.BKP') 
RETURN 
-- vFileName will return the text variable as: 
-- RRBYW16_12302008_1630.BKP 
-- Database Name, Date and Time will vary on your end

-- Example 03: (Using .#NOW) - Short and Swift 

CLS 
CLEAR VARIABLES vFileName 
SET VAR vFileName TEXT = NULL 
SET VAR vFileName = + 
((CVAL('DATABASE'))+''-'+(FORMAT(.#NOW,'MMDDYYYY_HHNN'))+'.BKP') 
RETURN 
-- Notice the "NN" for minutes when using .#NOW (not a typo) 
-- vFileName will return the text variable as: 
-- RRBYW16_12302008_1630.BKP 
-- Database Name, Date and Time will vary on your end

Now that you have successfully created a unique file name, you may use the following routine to make a
backup of your live database, on demand!

Here's how:

OUTPUT .vFileName 
UNLOAD ALL 
OUTPUT SCREEN

The resulting two files will be created in the same folder, unless a different folder name is specified:

1. RRBYW16_12302008_1630.BKP 
2. RRBYW16_12302008_1630.LOB

Supported Versions: 
· R:BASE 7.6 for Windows (Build: 7.6.5.31229 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.5.31229 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.19.31229 or higher) 
· R:BASE eXtreme (v9) for Windows (Build: 9.0.1.11229 or higher)
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15.14 Using the LISTOF Function for Large Data

Did you know that you can use VARCHAR data type to retrieve large dataset when using the (LISTOF
(colname)) function?

Syntax:

SELECT (LISTOF(colname)) IN TableViewName

SELECT (LISTOF(colname)) INTO varname INDIC ivarname FROM tblviewname

Note: Use WHERE clause to limit the resulting data, if necessary.

The (LISTOF(colname)) function creates a text string of the matched values separated by the current
comma delimiter character.

The LISTOF function can be used with the "SELECT ... INTO ..." to populate a variable with a list of values
which can then be used in a CHOOSE command with the #LIST option. It can also be used in Forms,
Reports or Labels to look up values from multiple rows.

By default, the (LISTOF(colname)) function returns a NOTE data type and notes are limited to 4K.
However, if you need to retrieve a large data set to build a dynamic CHOOSE command, Dynamic
ListView, or even Dynamic ListBox, now you can use the VARCHAR data type to achieve your goal.

Example 01: 

CONNECT RRBYW15 
SET VARIABLE vResult VARCHAR = NULL 
SELECT (LISTOF(CompDesc)) IN Component

 Example 02: 

CONNECT RRBYW15 
SET VARIABLE vResult VARCHAR = NULL 
SELECT (LISTOF(CompDesc)) IN Component WHERE CompDesc CONTAINS 'Box'

Example 03: 

CONNECT RRBYW15 
SET VARIABLE vResult VARCHAR = NULL 
SELECT (LISTOF(CompDesc)) INTO vResult INDIC ivResult FROM Component 
SHOW VARIABLE vResult

Example 04: 

CONNECT RRBYW15 
SET VARIABLE vResult VARCHAR = NULL 
SELECT (LISTOF(CompDesc)) INTO vResult INDIC ivResult FROM + 

Component WHERE CompDesc CONTAINS 'Box' 
SHOW VARIABLE vResult

Supported Versions:
· R:BASE 7.6 for DOS (Build: 7.6.4.30819 or higher) 
· R:BASE 7.6 for Windows (Build: 7.6.4.30819 or higher) 
· R:BASE C/S:I 7.6 for Windows (Build: 7.6.4.30819 or higher) 
· R:BASE Turbo V-8 for Windows (Build: 8.0.18.30819 or higher) 
· R:BASE eXtreme for Windows (Build: 9.0.1.30819 or higher)



Part

XVI



"Tip of the Day" Digest263

Copyright © 1982-2012 R:BASE Technologies, Inc.

16 R:Compiler

16.1 Customizing the Load Window in Compiled Applications

When compiling your application, you have the option (check box) to "Show Loading Window" which
permits the ability to display a progress window while the program is loading. The available field is used
to enter a custom message for the progress dialog window. 

With this feature available to the compiled program, there are three additional PROPERTY command
parameters which you can use to display customized load window:

PROPERTY LOADWINDOW TITLE 'Your Message Here'
PROPERTY LOADWINDOW PROGRESS nnn (0-100)
PROPERTY LOADWINDOW CLOSE 'TRUE'
PROPERTY LOADWINDOW CAPTION 'Your Caption'

Did you know that you can use the new LOADWINDOW SHOWINDICATOR parameters to display moving
circle (indicator) along with your custom message?

Here's how:

01. While customizing your project using R:Compiler 9.1 (32/64), make sure to enable the option for
"Show Loading Windows"
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02. Customize the application DAT file to include the following PROPERTY command:

PROPERTY LOADWINDOW SHOWINDICATOR 'TRUE'
RETURN

03. Compile your application.

04. Once the application is compiled successfully, run the .exe file and notice the Load Window with
moving circle (Indicator).

05. Finally, use the following PROPERTY command as "On After Start" EEP for your main application form
to close the loading window.

-- On After Start Custom EEP
SET VARIABLE vCompiled TEXT = NULL
GETPROPERTY APPLICATION IsCompiled vCompiled
IF vCompiled = 'YES' THEN
PROPERTY LOADWINDOW CLOSE 'TRUE'
ENDIF
CLEAR VARIABLE vCompiled
RETURN
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Have fun implementing new features & enhancements of R:Compiler 9.1!

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.3.10414 or higher)

16.2 Displaying a Load Window

Did you know that you can display a "Load Window" with your own custom message, while your compiled
application is being loaded?

When compiling your cool R:BASE for Windows application, a check box is displayed for "Show Loading
Window". If the check box is checked, R:Compiler will display a progress window while the application is
loading.

The available field can be used to enter your own custom message for the progress dialog window. 

With this new enhancement, we now have 3 more property commands:

PROPERTY LOADWINDOW TITLE 'Your message here ...' 
PROPERTY LOADWINDOW PROGRESS nnn (0-100) 
PROPERTY LOADWINDOW CLOSE 'TRUE'

These PROPERTY commands are supported for R:Compiler ONLY.
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16.3 Distributing R:Compiler Applications

When re-compiling and distributing your application, you also have to make sure that you include the
*latest* R:BASE engine files, included with the R:Compiler update.

For a typical codeless application (when all your code is embedded as custom EEP in forms, reports, and
labels, nothing outside...), a compiled application should include the following files:

R:BASE 7.6:

1. YourCompiledApplication.EXE 
2. Four Database Files (.RB1-.RB4) 
3. RB76IO.DLL 
4. RBENGINE76.CFG 
5. RBENGINE76.DLL 
6. RBThemes.DLL 
7. Custom help file(s), if used in your application 
8. Moving GIFs, if referenced in your PAUSE/DIALOG 
9. * Custom Plugin(s), if used in your application 
10. * R:Chart files (.RBC)/Plugin, if used 
11. * R:Mail files, if used in your application 
12. * R:PDFMerge Plugin, if used in your application 
13. * R:FTPClient Plugin, if used in your application 
14. * R:Magellan Plugin, if used in your application 
15. * R:ReadyRoute Plugin, if used in your application

* = Subject to version and license purchased.

R:BASE V-8 Turbo:

1. YourCompiledApplication.EXE 
2. Four Database Files (.RX1-.RX4) 
3. RB80IO.DLL 
4. RBENGINE8.CFG 
5. RBENGINE8.DLL 
6. RBThemes.DLL 
7. Custom help file(s), if used in your application 
8. Moving GIFs, if referenced in your PAUSE/DIALOG 
9. * Custom Plugin(s), if used in your application 
10. * R:Chart files (.RBC)/Plugin, if used in your application 
11. * R:Mail files, if used in your application 
12. * R:PDFMerge Plugin, if used in your application 
13. * R:FTPClient Plugin, if used in your application 
14. * R:Magellan Plugin, if used in your application 
15. * R:ReadyRoute Plugin, if used in your application

* = Subject to version and license purchased.

16.4 Is the Running Application Compiled or Not?

When you design and then deploy totally automated R:BASE 7.6 or Turbo V-8 applications, there may be
an option for a few users, including yourself, to return to the R:BASE Database Explorer or R> Prompt
window. That's fine if your application was started using a full version of R:BASE for Windows.

What happens when you have distributed your cool application using R:Compiler?

You may wish to keep all menu options, and make the optional "Database Explorer, R> Prompt" invisible
if the application 
is using the compiled version of R:BASE. This feature can be achieved without creating separate menus
for development and distribution.

Within R:BASE, you may use the "ISCOMPILED" property parameter to capturing whether the application
"is compiled" or not. to take advantage the latest versions of R:BASE.
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Here's how:

1. Assign a <ComponentID> to a button or menu item of a tree or drop-down menu, such as
'DBExplorer'.

2. Use the following code as "On After Start" Custom EEP.

CLEAR VARIABLE vCompiled 
SET VARIABLE vCompiled TEXT = NULL 
GETPROPERTY APPLICATION ISCOMPILED vCompiled 
IF vCompiled = 'YES' THEN 
PROPERTY DBExplorer VISIBLE 'FALSE' 

ENDIF 
CLEAR VARIABLE vCompiled 
RETURN 

The GETPROPERTY APPLICATION ISCOMPILED varname will return the value of YES or NO.

16.5 Reloading Resource Files

File resources can be added to your R:Compiler for R:BASE compiled executable projects. 

File resources can include:

· External Forms (.rff) 
· R:BASE Plugins (.rbm) 
· R:BASE Command Files (.dat, .rmd, .cmd, .app, .eep, .vie, .frm, .rpt, .lbl, .str, .all, .lst, .tbl) 
· R:Charts chart files (.rbc) 
· R:BASE Gateway Import/Export Specification files (.rgw) 
· R:Mail Editor Templates (.rmt)

Did you know that you can simply reload, or update, file resources without having to delete and re-add
the resource?

As file resources will change over time, an option to update the file resource is now available. Here's how
for Plugins:

01. Open R:Compiler, and select the "Additional Resources" option. 
02. Choose the "Plugins" tab, select the appropriate Plugin that needs updated, and click on the "Update
Plugin" button.

Here's how for Miscellaneous Files:

01. Open R:Compiler, and select the "Additional Resources" option. 
02. Choose the "Misc. Files" tab, select the appropriate file that needs updated, and click on the "Update
File" button.

Here's how for External Forms:

01. Open R:Compiler, and select the "Additional Resources" option. 
02. Choose the "External Form Files" tab, select the appropriate external form file, and click on the
"Update External Form File" button.

As the resource file is listed within R:Compiler, it will assume that the stored location for the file has not
changed.

Supported Versions:
· R:BASE eXtreme 9.1 (32/64) (Build: 9.1.4.11012 or higher)
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16.6 Saving/Recycling R:Compiler Projects

Did you know that you can now "Save" all settings of your R:Compiler projects, such as, General
Properties, EXE-File Icon and Customized Version Information to a file?

The latest update of R:Compiler 7.5, 7.6, and Turbo V-8 includes the features: "Save Project", "Save
Project As..." and "Open Project...".

This will help manage different versions of compiled applications and recycle custom details, etc., for
your application updates.
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17 R:Charts

17.1 Dynamically Assigning R:Charts' Tables/Views

By design, each series used in R:Charts is associated with a table or view. The designated table or view
is stored with the resulting R:BASE Chart (.RBC) file.

In development, there can be instances where you would like to recycle that cool chart with the exact
same column names but with a different table or view, without copying or re-designing a whole new
chart. Did you know that you can dynamically change the assigned table or view name for a chart
already designed in R:Charts 7.6 and 8.0?

Using the latest versions and updates of R:BASE and R:Charts (7.6 and 8.0) for Windows, now you can
use the additional 
parameter of "SERIES_TABLE[n] tableviewname" to dynamically change the assigned table or view
name for any series used in R:Charts, where [n] represents the specific table or view listed in the series.

Example 01:
The R:Chart file (Quarterly_DonutChart.RBC) is based on a 
QuarterlySummary view in RRBYW14. To print this chart on a 
form, the following command is used as a "Before Start" EEP.

-- On Before Start EEP in Forms 
PLUGIN RCharts76.RBL + 
FILENAME Quarterly_DonutChart.RBC + 
|SAVE_TO_JPG Quarterly_DonutChart.jpg + 
|IMAGE_WIDTH 324 + 
|IMAGE_HEIGHT 244 
SET VAR vImage = 'Quarterly_DonutChart.jpg' 
RETURN

The results displayed is: 

Example 02:
To use that exact Quarterly_DonutChart.RBC chart with a different 
view QuarterlySummary07 in a different form in RRBYW14, use the 
following command as a "On Before Start" EEP.
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-- On Before Start EEP in Forms 
PLUGIN RCharts76.RBL + 
FILENAME Quarterly_DonutChart.RBC + 
|SAVE_TO_JPG Quarterly_DonutChart.jpg + 
|IMAGE_WIDTH 324 + 
|IMAGE_HEIGHT 244 + 
|SERIES_TABLE[0] QuarterlySummary07 
SET VAR vImage = 'Quarterly_DonutChart.jpg' 
RETURN

The results displayed is:  

Supported Versions: 
· R:BASE 7.6 (Build 7.6.2.30102 or higher) for Windows 
· R:BASE C/S:I 7.6 (Build 7.6.2.30102 or higher) for Windows 
· R:BASE Turbo (Build 8.0.16.30102 or higher) for Windows 
· R:Charts 7.6 (Build 7.6.2.30102 or higher) for Windows 
· R:Charts 8.0 (Build 8.0.16.30102 or higher) for Windows
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18 Oterro

18.1 Checking Version and Build of Oterro

With various versions of Oterro installed on your Network Server, Workstation, Notebook, or Tablet PC,
it may be helpful to know the exact version and build of installed version(s) of Oterro.

Did you know that you use the "CheckVer" utility installed in the default installation folder of Oterro?

After installing/updating the latest version of Oterro, you will find the enhanced "CheckVer" utility that
will illustrate all installed versions of Oterro ODBC drivers, including the file name, driver version and
build of Oterro.

Specific versions are installed in appropriate folders, such as:

\RBTI\Oterro40 
\RBTI\Oterro80 
\RBTI\Oterro90_32 
\RBTI\Oterro90_64

18.2 Configuring Oterro and R:BASE ODBC Drivers on 64-bit OS

If you are running any of the R:BASE products above on MS XP (64), Vista (64), Win 7 Professional (64),
or Windows Server 2003/2008 (64), you may need to tweak the registry settings to recognize installed
R:BASE and Oterro ODBC settings and installed drivers.
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Typically, using the full installer, after a successful installation of R:BASE/Oterro, you would expect the
R:BASE/Oterro ODBC drives to be listed under the Drivers for ODBC Data Source Administrator panel.
Well, by default, on all XP (64), Vista (64), Windows Server 2003 (64), and Windows Server 2008 R2 x
64 with Service Pack 2 machines, the installed ODBC Drivers list is empty. There are no drivers listed,
even for Microsoft's own default drivers.

The reason the installed drivers are not listed is the way Windowsx64 editions operate with the ODBC
drivers. On Windows x64 editions, all ODBC drivers are installed in the "%SystemRoot%\SysWOW64"
folder. 

However, the default ODBC Data Source Administrator that is available through the Administrative Tools
or Control Panel in Windows x64 Editions is located in the "%SystemRoot%\system32" folder, and only
searches this folder for ODBC drivers.

To alter this behavior on Windows x64 editions, you should update the target information for shortcut
properties of the ODBC Data Source Administrator tool to reflect "%SystemRoot%\SysWOW64
\odbcad32.exe". 

This will correctly locate and list all installed ODBC drivers as well as enable you to create a System DSN
or should be recognized when using the DSN-Less connection.

Default Properties for ODBC Data Source Administrator

Modified Properties for ODBC Data Source Administrator
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Installed ODBC Drivers on Server 2003 R2 x64 SP2 machines
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Have fun running R:BASE (7.6, V-8, 9.0) and Oterro (4.0, 8.0, 9.0) on Windows XP (64), Vista (64), Win
7 Professional (64), Win Server 2003 R2 x64, and Win Server 2008 (64) operating systems!

Supported Versions:
· R:BASE 7.6 for Windows 
· R:BASE Turbo V-8 for Windows 
· R:BASE eXtreme 9.0 (32) 
· R:BASE eXtreme 9.0 (64) 
· Oterro 4.0 
· Oterro 8.0 
· Oterro 9.0 (32) 
· Oterro 9.0 (64)
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19 Feedback

Suggestions and Enhancement Requests:

From time to time, everyone comes up with an idea for something they'd like their software to do
differently. This is true of all applications, no less R:BASE. 

If you come across an idea that you think might make a nice enhancement to R:BASE, your input is
always welcome. 

R:BASE eXtreme
Please submit your suggestion and/or enhancement request to the R:BASE eXtreme Developers' Corner
Crew (R:DCC) and describe what you think might make a nice enhancement. In R:BASE eXtreme, the
RBG9 R:DCC Client is fully integrated to communicate with the entire development team of R:BASE
eXtreme. From the main Menu Bar, choose "Help" > "RBG9 R:DCC Client".

Unless additional information is needed, you will not receive a direct response. You can periodically
check the status of your submitted enhancement request accordingly. 
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